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the display shows the map of the results..” 3Z8HE(L, mt L,WJ—_T HESFEEICETT 3.
F—0—FEANL. BERYERY CHROT —ST—RET -
150 3-2 (7) Users can register new sights on the map and store the date on the ToDo 8.0
) server by long dlick on the spot.Users will need their email and password to
Show Completed Sprints do this action $FETEROY—I0E 1 thew@iRT 25 (EHL) T #il

[CHSESEL. U/ (CRRTIEEFSD. OB BREOANFELIE
JRI-—FEEFT 3.

ZTUS My IOIDET UIESDR ~—U—RA > MERELET,
2TUS MW IO DET TERD S EDDRAR—U—RA> NEBEET,
[_E52 ]

50—=3.0(TUEDPDAR—U—RA>K)

RTTERNDIEDDR ~—U—RA> M 2.0

3.0 = 3.0(IRTET)

5.0 > 3.0(RT LESDI M—U—R1> )

RTTERNDIEDDR ~—U—RA> M 2.0

3.0 > 3.0(RTULESDA R—U—R1> )
2TUS MY IO DRT TERD S ZDE. ROZATUS NCEELET.,
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16.1 A b—
ST CERMDIER M=

Scrum Sample Project » Master Backlog

Overview Activity Roadmap QUFLNNTE Releases Issues N

U—R1> hDREL
U—Z R LET,

Jump to a project...

ew issue  Gantt uments Wiki Forums

Files

Settings

View options (2) + Enable Auto-refresh Refresh Multiline
~ | sprintl 2015-10-12 2015-10-23 Product Backlog Close completed Sprints 36
[T 1a3) 3-1(3) The language of the application depends on the settings of the ToDo 143] 3-1 (1) When the users start the application, the main menu ap, ars ToDo 1.0
smartphone.” 3 779 Uo—a3E, BRAETEEREERATEAT - on the sereen/ 77T -3 Y EERTBE A1 —HFonai,
T DESERECENETEESRL T s FOSEENER 5. == EVVEEERRTES.
[ 151 3-4 (1)Users can register and update their email address and ToD)| 3.0 [ 147 3-2 (4) Viewers can leave comments on the detail information page of ToDo 8.0
— password. /FTURESOA—LF FLAE)AD— FERR - TETEDS T the sight. /S OFNHIREETEE I T. BESSOAL MEERTIEE
HRERIFD. D,
[ 144| 3-1 (2) When the user start the application for the first time, the ToDj 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
registration page opens first” #1& CRIET 388, A7~ 74 2mA— current location on the map. ~REMAT LZHT & 27— 74 ORE
L7 ELAEIRD— FEERT SEMERTY 3. m hEhLE LI thEERET D,
[ 148| 3-2 (5) Users can use keywords and click on the “search” button for D} 3.0 | 145\ 3-2 (2) When a sight on the map is chosen, the application will list the ToDo 13.0
full-text search. The search results When the user dlicks the data on detail information of the sight” HiE F DT — 7EER LEEIC. TOMsS
the list, the display shows the map of the results.. &8, 2‘2& oREEREERCETI 3.
FELUBEECE—T— FEAL, BRe>5R T LHRaT— o5 — . -
e i (7450 3-2 (7) Users can register new sights on the map and store the date  ToDo 8.0
] on the server by long click on the spot.Users will need their email and
3 password to do this action HEZREROY—7HEL L HSFBRT S
Show Completed Sprints (EAL) T. SIRICHSZIEL. U—/ICEETSRETHD. COR
EREOANT FLALIRT- FEERTS.
| 183 3 1 (3) The language of the application depends on the settings of the ToDo 2.0
martphone.” %57 71) 3 JIS\ BEEPESHLERTBRT—F
170 3-1 (2) When the user start the application for the first time, the ToDo 2.0
~ registration page opens first.” A THAT SRS, AT—FIAZDA—
2 o £

IRDZ TV > N
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16.2 AU kL Ea—
2TU> ML ED—DfER%E.

Scrum Sample Project

Overview Activity Roadmap Backlogs Taskboard Releases

(FEERDECER)
WikilCFEERLE T

Jump to a project. _

Issues New issue Gantt Calendar News Document ; orums

Files Settings

wiki
Sprint1 Daily Scrum

Sprint1 Review

#" Edit +r Watch £ Lock @ Rename fij Delete - History Wiki

Start page
Index by title
Index by date

Sprint1 Retrospective Wild »

Sprint2 Daily Scrum
Sprint2 Review

LEI1—#R

Sprint2 Retrospective

Sprint1 Review -------—----——------o-

ZseikT B,

Sprint3 Daily Scrum

Sprint3 Review New file

Sprint2 Retrospective

New file

XENFFES (FREEARGET

Also available in: PDF | HTML | TXT

EEHLET
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17 #ixDR D (KPT)

RORDOHMIMIR (RIEEH. RERE) 277y FDSEELT
RDRDZTTV, FBERZEWKICFSCERLUE T,
IN=VUFDYFv»—tESBICLET

W

,1
52 @2 ey

Fl':ﬁ_ BRF—LA

W

LFIEDWTIRDIED Z1TWE T,
[K: keep=5&EHHITDT L]
[P : problem =S E/RXDT. °HDZ &
[T:try=5%&. sLUTHELT &

XNEBERELZBFZI T, ROXTV>Y CORBICIHIITET,
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17.1 #iRDIR D (KPT) (VEERSEIDECiIFEEIR)

Overview (#1E) DReport/ha> %2 w /9 3 ESpent time (YEZEBFRT)
DEFESBTETET,

Scrum Sample Project
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17.1 #{RD:ED (KPT) (YEERFREIDECERZER) 1
Spent time (fEZKffE) DEHFEZESRTEEI.

Scrum Sample Project S Jume to2 profect
Ouerview  Activity Roadeap  Bachlogs R T M i Gamti  Cabaidar  News  Decumwenbs  Wiki  Forumic  Files  Settings
Al Progects = Scrum Sample Project = (i Leg tira
Spent time
* FRteS
B Duba any | add fiker |
* Dpons
o boply f Cloar
elnds | Repor
Dietails; [Daps w] &dd | @ Clear
Tatal time: 12,00 hawrs
[ 20A5-00-10 Tetal tie:
sk 2135: Table design.” T — LB 5.00 5.00
task #156: Cofing processing Tor e first ime s TET AT 288 000TE TS 5.00 5.0
tazk 2180 Coding screen desipn. BT Rl oo oo
Total time 1200 12,00
n. Isbie i C5
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17.2 IR0 D (KPT) ($&ER%=5CEk)
IROERDODFHER%E, WIKICBIREEBUEY,

Scrum Sample Project 8 Jump to a project. .
Overview Activity Roadmap Backlogs Taskboard Releases Issues New issue Gantt Calendar News Document ; Files Settings
Wwiki # Edit ¢ Watch (3 Lock @ Rename [ Delete - History il

Sprint1 Daily Scrum Start page

Index by title

Sprint1 Review Index by date

Sprint1 Retrospective Wiki »
Sprint2 Daily Scrum Sprint1 Retrospective --------------------—-
Sprint2 Review 1. Keep

Sprint2 Retrospective 2. Problem
Sprint3 Daily Scrum 3. TryI

Sprint3 Review

Sprint2 Retrospective

New file New file

Also available in: PDF | HTML | TXT

XERNRAREE(FREBEAARECTEHLUETT
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1.Summary of Redmine

Redmine is a Web-based project management system.

In this article, it is a plug-in to support the Scrum development of the
"Backlogs"We'll explain how to use.

Scrum Sample Project

Owverview

& Mer muberojes: 5 dr Tpant time
T
hsus tracking Log B | Cetafy | Report
sy; Sapen | 1
+ by D oopen /0

Wiew 8l s | Calender | Gantt
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2.Function summary of Redmine

OverView Overview screen, a summary of the entire project information is displayed.
Activity Activities screen displays the recording by the time series of all the work in the project.
Roadmap Road map screen, a list of tickets that are separated by Sprint project, and the progress will be displayed.
Backlogs You can create and manage product backlog and sprint backlog.
Task board Generation of the task, assignment, you can update of progress.
Releases Do not use
Issues Search task, edit the task
Gantt Gantt chart displays the ticket associated with the sprint start and end dates.
Calender Ticket and Sprint will be displayed on the calendar
News Register the news to project members
Use the announcement of information sharing
Documents Register the files you want to share in the project
Wiki Add wiki page, and update?
We used to share a note of record within the team.
Forums It uses to discussion and QA in the project
Files It is used for storing the product to be released.

5
3. Project organization diagram
Project PO :Product owner
e A CSETUIT I
:’ User Sub Project \:
: User User :
r ] _____8 I P _’
@Ub Project Sub Project Sub Pfoject \ (Sub Project oject Sub Project )
(Scrunp teamA) (Scrunp teamB) (Scrum teamC) (Scrum teamD) (Scruph teamE). (Scrudn teamF).
ey by ey | (Sl e B - d | SRR = = =\

——————————————————%————————————————————————————————————
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4. Scrum teams and roles

User Teacher Teacher Teacher Teacher Teacher Leader
(Japan) (Japan) (Japan) (Japan) (Japan) (Japanese

& company)

Product owner Student Student Student Student Student Young
(Japan) (Japan) (Japan) (Japan) (Japan) (Japanese

company)

Scrum masterMain Teacher Teacher Teacher Teacher Teacher Leader
(Japan) (Japan) (Japan) (Japan) (Japan) (Japanese

company)

Sub Teacher Teacher Teacher Teacher Teacher Teacher
& (Philippines) | (Philippines) | (Philippines) | (Philippines) | (Philippines) | (Philippines)

Development Student Student Student Student Student Young
team (Japan) (Japan) (Japan) (Japan) (Japan) (Japanese
L i L company)

m Student Student Student Student Student Student
(=] (Philippines) | (Philippines) | (Philippines) | (Philippines) | (Philippines) | (Philippines)

7

5. Role in the project

The person who shows a user story (demand matter) of the
application.

User

Product owner

>
2

Scrum master Main

-
@

Sub

&

Development teanh

=)

@)

The person who decides specifications of the application

The person who checks whether sprint back log is updated.
consider it so that the efficiency of the team becomes
biggest Person

The person who efficiency of offshore side to help to

maximize

The person who updates the sprint back log

| have the ability of implementation and the test.
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6. Project Information

Mext2015 Master Project

Mext2015 Sub project A

Mext2015 Sub project B

Mext2015 Sub project C

Mext2015 Sub project D

Mext2015 Sub project E

Mext2015 Sub project F

Mext2015 Sub project Users
Mext2015 Sub project Scrum_Masters

Mext2015 Sub project Product_Owners

Mext2015 Sub project
Offshore_developers

Mext2015 Sample Project

Mext2015 Download Center

Master Project
TeamA Project
TeamB Project
TeamC Project
TeamD Project
TeamE Project

TeamF Project

Users project
Scrum Masters project
Product Owners project

Offshore developers project

Sample Project (Created function)

Document Download Site Project

Managers_Group
TeamA_Group
TeamB_Group
TeamC_Group
TeamD_Group
TeamE_Group
TeamF_Group
Users_Group
Scrum_Masters_Group
Product_Owners_Group

Offshore_developers_Group

Managers_Group
TeamA_Group~
TeamF_Group
Managers_Group
TeamA_Group~
TeamF_Group

9
7. Group information

e 7
TeamA_Group TeamA Group
TeamB_Group TeamB Group
TeamC_Group TeamC Group
TeamD_Group TeamD Group
TeamE_Group TeamE Group
TeamF_Group TeamF Group
Users_Group Users Group
Scrum_Masters_Group Scrum Masters Group
Product_Owners_Group Product Owners Group
Offshore_developers_Group Offshore developers Group
Managers_Group Managers Group

10
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8. User information

Teacher  team-X-Usrl  team-X-Usrl  team-X-Usrl team-X-Usri@xxxx.co.jp English ~ TeamX_Group
(Japan) Users_Group
Scrum_Masters_Group

Studentl  team-X-Usr2  team-X-Usr2  team-X-Usr2 team-X-Usr2@xxxx.co.jp English ~ TeamX_Group
(Japan) Product_Owners_Group

Student2  team-X-Usr3  team-X-Usr3  team-X-Usr3 team-X-Usr3@xxxx.co.jp English ~ TeamX_Group
5(3552:33 team-X-Usr4  team-X-Usr4  team-X-Usr4 team-X-Usr4@xxxx.co.jp English ~ TeamX_Group
5(3552:34 team-X-Usr5  team-X-Usr5 team-X-Usr5 team-X-Usr5@xxxx.co.jp English ~ TeamX_Group
‘E'Jeaaliz?wz)r team-X-Usr6  team-X-Usr6  team-X-Usr6 team-X-Usr6@xxxx.co.jp English ~ TeamX_Group
(Philippines) Scrum_Masters_Group

Studentl  team-X-Usr7  team-X-Usr7 team-X-Usr7 team-X-Usr7@xxxx.co.jp English ~TeamX_Group
(Philippines) Offshore_developers_Group

Student2  team-X-Usr8  team-X-Usr8 team-X-Usr8 team-X-Usr8@xxxx.co.jp English ~TeamX_Group
(Philippines) Offshore_developers_Group

%1 team-X team-b~f
%2 Team-X TeamB~F

X The first time you log, password, please change the display name

11
9 - - - - -
. User information modification method
Hupmy My page Pergechs Seewm wlslishios fadp Logged v o Wk My grveamt S sk
Mext2015 Project (Redmine+Backlogs) = N (YT
of Moot mas suoesshaly epdated My aconunt
Login: Lisers
My’ AcCount Chargs pensrap Craates: 00/ 10/ 2015 13:04
LideTnatisi kinm arcess key
First name * 'Lrgm:,.;r} Ff" any moem 0"_‘!'!"‘?]"-'['-""-': ": :H:_‘:;Il]-:oew kry oreated 12 sénuies ago
Ltk fasm ¥ |Sonm
= ] 1 dont want ko ke notfed of chanpes that 1 make mysef
Email * {IbserSfaasaa com
Language Eng._sh __v_: Py efaranoes
Hide ney emsdl address |
Hacklogs Time rone [ |
Tl color :r::csnra Dicplay comminis |l cheanclogical ordes |
£ Warn e vl loading a oF
Em:n paga with unsaved tac
« Display name, e-mail address, if you want to change the language, please change in the
Information screen of My account screen.
« If you want to change the e-mail notification, please change in the Email notifications
of My account screen
Email notifications
SHLTWSIOZH Mg A TOEH -
BIRLLEJOSTO M A TOEE. For any event on the selected projects only...
Ty F I ZEEEL TSRO Only for things | watch or I'm invelved in
= ﬁfJ‘iﬂ“:"ib'Cb{%$ﬁ®5‘i Only for things | am assigned to
B HYERLESiEnH Only for things | am the owner of
EHILEW No events
12
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10. Scrum framework

55@
& User story
Development team

Scrum master

Scrum master
Development team

User Product owner

Scrum master
Scrum master  Development team

Development team
399\ ¢ el A
k _ Y& =

13

11. Trackers
Story Product backlog, and sprint backlog of ticket
Task Ticket the sprint backlog was task division

Ticket Sprint impediment
Bug Failure in general. Such as a unit test impediment

3 used if necessary

14
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12. Flow of scrum

4 hours

2hours

1 day

-
13. Use tools and use function  o: e
A\t Advice Follow
[Sprint planning (Create Product Backlog
Redmine Backlogs O
[Sprint planning meeting ISkype IChat, conversation A A O O
ICreate Sprint Backlog Redmine Backlogs A A O @]
ISprint planning Redmine [Taskboard A A o @)
ICreate Task Redmine [Taskboard A A o [e]
Sprint
Update Task Redmine [Taskboard A A @] @]
Daily scrum ISkype IChat, conversation A A [e] O
Record of the Daily Scrum Redmine Wiki A A 0] 0]
[The recorded working time Redmine Issues A N e} e}
Register the task of artifacts Redmine Issues A A @] o]
Register the sprint impediment task Redmine [Taskboard A A O O
ISprint review
Registration of release product Redmine Files A @]
IChat, conversation
[Sprint review ISkype O o A A O O
Record of Sprint review Redmine Wiki A @]
ISprint retrospective
[Sprint retrospective Skype Chat, conversation A A @) O
Reference of the working time Redmine Overview A A @)
Burndown chart Redmine [Task board A A @)
Record of the Sprint retrospective |Redmine IWiki A O
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13. Use tools and use function

Role
User Product [Scrum master Developer
. owner | Japan |Offshore| Japan [Offshore
e Content Tool Function 3 E i P
QA and Sprint QA in the project, p N
impediment task Sprint failure task discussion Redmine Forums o ) S
discussion Skype Chat, conversation e} o ¢}
Information exchange Technica] inf_ormation exchange and Redmine Forums o o o o o
lcommunication
o o

Skype Chat, conversation o - ~ o o o
Information sharing News of the project o 5 o o o o

Redmine News

17

14. Sprint planning

Do sprint planning

User Product owner
( & t )@ @\ @

) . Scrum master

r 3 -. i Development team
ol

User story I’ Story ' Il Story ' =
= = =l

q I' Story ' |’ Story ' E> m-
—— '

Product backlog Sprint backlog

1. Create Product Backlog

Product Owner is to create a product backlog from user stories.
2. Create Sprint Backlog

Development team to create a sprint backlog from the product backlog
3.Create Tack

Development team to create a task from the sprint backlog

_64_
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14.1 Sprint planning (Create Product Backlog )

Product Owner is to create a product backlog from user stories.

® (& @R

Scrum master
Development team

User story I’ Story ' Il Story ' =
-] oD e

sy D | [ Sov P &) [ Task
\ kProduct backlog } Sprint backlog /
> 4

1 . Product Owner is to create a product backlog from user stories
Create a product backlog from user stories

2 . Sort in order of priority
Sort the story in the drag-and-drop

3 . Estimates
Development teams estimate the story points

19
14.1 Sprint planning (Create Product Backlog ) 1
Product Owner is to create a product backlog from user stories
1. Select the "Backlogs" from the Project menu
Scrum Sample Project » Master Backlog et
Ouerview  Activity Roadmag QESVIENTE Wi leases  Issues New issue  Gantt  Calendar  News Documents  Wiki  Files  Settings
View options (1) s || Enable Auto-refrash Refresh Muitiline
> mﬂadﬂw mmdsmu o
2.Select the "New Story" from the Product Backlog
Scrum Sample Project » Master Backlog
Overview  Acthiity  Roadmap EULIEGHE Releases Issues  New issae  Gantt  Calendar  News  Documents Wikl Fles  Setlngs
[ | Enable Auto-rafresh Refresh Mutiline
Cezw completad Spilits 0
New Sprink
20

_65_




14.1 Sprint planning (Create Product Backlog ) 2

3.Click Done to Save, enter the user stories in Story

Scrum Sample Project » Master Backlog : Jump 10 @ project .
Overview  Activity QEELULYI Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Settings
View options (1) B [ ] Enable Auto-refresh Refresh Multiline
Product Backlog Close completed Sprints o
([ 243] 3-1 (1) When the users start the application, the main menu appears on the screen./ 77— 3 2% EH§ 3 L= —MEREN. ETLEVERERIRTES. ToDo

[ 1aa) 3-1(2) When the user start the application for the first time, the registration page opens first” I THATHES. A7— FIADA—ILF ELAERD— FERFTEEEEZES  ToDo
: k-1

E— E— —
story M[31 (%g.e Ianguge of tile application depends on the settings of the smartphone/ 7 S —2 3 (3, BAEvEER CHEET BA7— M4 L OSEREcant (B 1 ToDo ¥
TEHFOEEED

I [5ave |l [Cancel|

X Registered in the Japanese / English
4.User story is set in the Story

Scrum Sample Project » Master Backlog i Jump to a project .
Overview  Activity Q:EW{UIEE Releases Issues Newissue Gantt Calendar News Documents Forums s Settings
view options (1) - [ ] Enable Auto-refresh Refresh Multiine
Product Backlog Close completed Sprints 1]
[ 1a3| 3-1 (1) When the users start the application, the main menu appears on the screen 77 Ua— %3 L 2RBMTE &A1 —EFR S, EFLEVEEZEERTES. ToDo

[ 1a4] 3-1 (2) When the user start the application for the first time, the registration page opens first” fl$h THRT238E. A7 FIA2DA—LF FL-RE) AT — FESRdsBREZET ToDo
T3

[ 1.5| 3-1 (3) The language of the application depends on the settings of the smartphone/ 57U -3, BEEPEEREERTERAT— M4 OSERELCSNETEESETISE ToDo
FOSEENERS.

X All product backlogs are registered

21

14.1 Sprint planning (Create Product Backlog ) 3

Sort the story in the drag-and-drop
1. Sort the story in the drag-and-drop

Scrum Sample Project » Master Backlog SearE Jump to @ project..

Overview Activity J:ELAGIEN Releases Issues Newissue Gantt Calendar News Documents Wiki Foi Files Settings
View options (1) = [ ] Enable Auto-refresh Refresh Multiline
Product Backlog Close completed Sprints o
[ 1a3) 3-1(1) when the users start the application, the main menu appears on the screen.” 77 Uo—3 3 22 EH T 5 A1 —FFREN. EFUEVEREERTES. ToDo

=) 21 (2) When the user start the application for the first time, the registration page opens first” fl& THATZ88, 27— FJ#4 YDA L7 FLAEL)AD— FERRT ZEEESRS ToDo

[ 1as) ;;)(3) Thegnguage of the application depends on the settings of the smartphone.” L 77U —3 33, BFFPESAEERTSAY— 74 > OSENECSDETEERTI X ToDo
ST

" 1ag) 3-2(2) When a sight on the map is chosen, the application will list the detail information of the sight.".

v —oEBZRUERC, TORSOFREEEERICRETT 5. ToDe
147| 3-2 (4) Viewers can leave comments on the detail information page of the sight./ thEOREESERER L T. BEEFIAS BT SREFITD. ToDo

[ 1aa) 3-2 (5) Users can use keywords and diick on the "search” button for full-text search. The search results When the user dicks the data on the list, the display shows the map of ~ ToDo
© the results JREMEE, 2RRC VEE FTF-U- FEANL. BREAYLERT LTS —BERENS.

[ 24s) 3-2 (6) Clicking "Current Location” button on the display shows the current location on the map./ RESAS 2 EMT & A7~ I+ S OREHFRDL E LEBRSTETS. ToDo

150 3 2 (7) Users can register new sights on the map and store the date on the server by long click on the spot.Users will need their email and Dasswnrd to do this action. iEEREE ToDo
N—UTEN 1 REEERTSE (BRL) T FRCRSESEL. -/ (CBST588ES0. COB. BRE0A-ILFFLAL) (A0- FEERTS,

[ 151) 3-4 (1)Users can register and update their email address and password. /7 UFIE SLP FLRENRT— FEER - EECEDRBERD. ToDo
i St h: j
Scrum Sample Project » Master Backlog are Jumplo a project
Overview Activity QRIS Releases Issues Newissue Gantt  Calendar News Documents Wiki  Forums iles  Settings
View options (1) + [ ] enable Auto-refresh Refresh Multiline
Product Backlog Close completed Sprints (1]
[ 1a3) 3-1 (1) When the users start the application, the main menu appears on the screen” 77/ U — 23 VB EHT 3 & A2 —IEREN. ETULMERERIRTES. ToDo

[T 1a4) 3-1(2) When the user start the application for the first time, the registration page opens first.” A0 THAT 288, A¥— FIA DA L7ELAE)RD— FEBHT sEEERE ToDo
gz

3-2 (5) Users can use keywords and dick on the "search” button for full-text search, Tha search results When the user dlicks the data on the list, the display shows the map of  ToDe l
the results. “BEHE 2 2Y@HC LEEECF—J—FEANL. B E@ T CHE0TF S0 SRR

s
([ 1as) 3-1(3) The ‘amjuaae of the application depends on the settings of the smartulmne/éﬁutff/s/[l BFETEFREERT AT NIAVOSERECESDETEESTI ZX ToDe
FOSEEER

(7248 3-2 (2) when a sight on the map is chosen, the application will list the detail information of the sight” ] F v — %@ R LB, EEICETE 5. TeDe
[ 147) 3-2 (4) Viewers can leave comments on the detail information page of the sight./ bR HESESTaE L T. BEEFIAS FMEFTIREFTD. TeDo
[ 143) 3-2 (6) Clicking "Current Location” button on the display shows the current location on the map./ B9 & HTERT— b T YOREGFALE LIz HEERET . TeDo

~ 150 3 2 (7) Users can register new sights on the map and store the date on the server by long click on the spot.Users will need their email and password to de this action hE&REE ToDo
N —UHEN 1 RERERTSE (BRL) T, HRICHSEREL, Y (CERTSERESD. (OB, BRSO L7 FLAL) RD- FEEETS.

| 151] 3-4 (1)Users can register and update their email address and passwerd. /77 URABEDA—LF FLAERT—FEER - TECEIRBERD. ToDa

22
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14.1 Sprint planning (Create Product Backlog ) 4

Development teams estimate the story points
1.Select the story points from Story

Scrum Sample Project » Master Backlog SesiEhs Jump 1o @ project..

Overview  Activity [t gl Releases Issues Newissue Ganit Calendar News Documents Wiki Forums Files Seftings

View options (1) + [ | Enable Autorefresh Refresh Multiline

Close completed Sprints,

story V| 3-1 (1) When the users start the application, the main menu appears on the screen/ 77U —2 3 SV ER#T & AT —FERSN. ETLLVERERRTES. ToDo
Save| |Cancel

144 3-1 (2) When the user start the application for the first time, the registration page opens first.” IO THATZEE. A7 I DAL FLRE/ 2D~ FEBRTIEAERT  Tol
EEN

148 3-2 (5) Users can use keywords and diick on the "search” button for full-text search. The search results When the user dlicks the data on the list, the display shows the map of ~ ToD
the results. BRHEL. TRERL VAL TF—7—- FEANL. BRI ERT EHROT—IT—E=FEN3.

145| 3-1 (3) The language of the application depends on the settings of the smartphone” 477U s —2 3 >3, BFEPEEREEATEAT— oA v OSEREICEHETERRTI X ToDo
FOSEENEIS.

14g) 3-2 (2) When a sight on the map is chosen, the application will list the detail information of the sight . #iE T — I ERRUALBIC. TOHEOMEEEEEEICETT 3. TobDo
147 3-2 (4) Viewers can leave comments on the detail information page of the sight..” iR EEHE AR L T. BESHIA ST SREFND. ToDo
1as) 3-2 (6) Clicking "Current Location” button on the display shows the current location on the map. /BIEMRS > &R T & A7~ T > OREHERLE LEHEETETS. ToDo

150) 3-2 (7) Users can register new sights on the map and store the date on the server by long chck on the spot.Users will need their email and password to do this action. #BE=EE ToDo
OX—INENBRERRTES (EAL) T RCHREREL, U (CRRTHBREERD. COE BREOA-LF FLAL) (AT~ FEEET 5.

3-4 (1)Users can register and update their email address and password. /77U HBEEDA—LF FLRENRD— FEEE  EETEMBEHD. ToDo

2 Story points are set to Stor

Scrum Sample Project » Master Backlog SearcE Jump lo @ project..

The sum of user story,
to use in the creation of
the sprint backlog

Overview Adtivity LEGINMEE Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Files Settings

View options (1) s Enable Auto-refresh Refresh Multiline

L

Product Backlog Close completed Sprints 48

143) 3-1 (1) When the users start the application, the main menu appears on the screen.” 777 —23 > RERT BEA—2—ETSN, EFLEVEEEERTES, ToDe

124 %é (2) When the user start the application for the first time, the registration page opens first/” I THETZ8E. 27— FIA4 VDA - L7 FLAE) X T— FEBHTIBEEETR  ToDo 5.0

48) 3-2 (5) Users can use keywrords and dlick on the “scarch button forfulltext search, The search results when the user dicks the data on the ls,the display shows the map of  ToDo 3.0
the results. /IBEREIE. 23Rk L UBEETF—0— FEANL. BEAS>ERT ERDT—In—Stme

143 3-1(3) Th;]gnguage of the application depends on the settings of the smartphone/ L7 FUs—2 323, BABPRBRSERT 3RV M4 OSEIECSNUTEBETRT 3% ToDo 5.0

148] 3-2 (2) When a sight on the map is chosen, the application will list the detail information of the sight” S FQY — P EERL ZHE, TOLSOEMESZERETT 3. ToDo 12.0

147 3-2 (4) Viewers can leave comments on the detail information page of the sight..” th=O¥@ERETER LT BRESFIAY MEESRTIRETFD. ToDo 8.0

143) 3-2 (6) Clicking "Current Location” button on the display shows the current location on the map. /BEMRS>ZH T £ 27— F T+ D OBREERLS LIthEERET 3. ToDo 2.0

150) 3-2 (7) Users can register new sights on the map and store the date on the server by long click on the spot.Users will need their email and password to do this action BEZFEE ToDo 8.0
OR—OFEVBIERRTEE (BFL) T, TRCASESEL. Y-/ (CERTSREERD. COB, SREOXILTFFLALI RO FE2ET3.

151) 3-4 (1)Users can register and update their email address and password. /77U BIBSOA -7 FLAE/(AD— FERGE - SETEZHEEND. ToDo 3.0

23

14.2 Sprint planning (Create Sprint Backlog )

Development team to create a sprint backlog from the product
backlog

User

Scrum master
Development team

User story ' I
: [ Story ' [~ Story

oduct backlog Sprint backlog

1 . Create a sprint
Development team to create a sprint
2 . Create Sprint Backlog
Development team to create a sprint backlog from the product backlog
3 . Sort in accordance with the priority Story
Development team is sort in order of priority the story
4 . Estimates

24
-67-




14.2 Sprint planning (Create Sprint Backlog ) 1

Development team to create a sprint from the Product Backlog

1. Select "Backlogs" from the Project menu, select the "New Sprint"

Jump to a project...

Scrum Sample Project » Master Backlog

Overview Activity JUEENGNEE Releases Issues Newissue Ganitt Calendar News Documents Wiki Forums Files  Settings

View options (1) : [ ] Enable Auto-refresh Refres

l ~  Product Backlog ! Close completed Sprints a8
New Story rs start the application, the main menu appears on the screen/ 77 4 — 23 LERET & A= 1 —TFER S, BTLEVEBETRRTES. ToDo 1.0
New Sprint iser start the application for the first time, the registration page opens first” I TRETBHES. AY— FIADA-INF FLAEL/ RT-FEERTSEEEER ToDo 5.0
Stories

se keywords and click on the "search” button for full-text search. The search results Wheﬂ the user clicks the data on the list, the display shows the map of TeDo 3.0
Product backlog cards E‘I}L SRES VR L TF U FEATL. BEAYL 20T CHR0T 20— ERnS

The Ianguage of the application depends on the settings of the smartphone L7 T U —3 VE, BAFCESREERATERAY - M4 Y OSESTICSNETERSAT 53X ToDo 5.0
SRR

\E| 3-2 (2) When a sight on the map is chosen, the application will list the detail information of the sight. 1 tOT—2FRR LB, TORSOFMESFERICETT 3. ToDo 13.0
[ 1a7] 3-2 (4) Viewers can leave comments on the detail information page of the sight../ ti=OHHERETEE L T. BEST A FEET 38EFED. ToDo 8.0
([1a3) 3-2 (6) Clicking "Current Location" button on the display shows the current location on the map./ REEMRS > EH T LT — T > ORENEHRLE U BEETET D, ToDo 2.0
[ 180 3-2 (7) Users can register new sights on the map and store the date on the server by long click on the spot.Users will need their email and password to do this action. $hEEEREE ToDo 8.0
T OF-7HBLIRSERRIESE (BAL) T FRCHSESEL. U/ (CEET38RERD. COB. BREDALFELAE/IRT-FEEET 3.

[[7353) 3-4 (1)Users can register and update their email address and password. // PFUFIREDA—ILT FLAL/ (R0 FEESR - EETESRERHD. ToDo 3.0

% When you click the Multiline, it can be displayed in multiple lines
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14.2 Sprint planning (Create Sprint Backlog ) 2

3.Click Done to Save, Sprint name, start date, it will enter the end date.

Jump to a project...

Scrum Sample Project » Master Backlog

Overview Activity QUERANEE Releases Issues New issue Gantt Calendar News Documents Wiki Forums Files  Settings

View options (1) * |:| Enable Auto-refresh Refresh Multiline

l\sprintl\ X ||015-1u-12‘|2015-1u—2‘ I v | Product Backlog Close completed Sprints 48
|save| |cancel| | 3] 3-1 (1) When the users start the application, the main menu appears on  ToDo 1.0
S T the sareen/ PFUS—3 3L EEHT B AT 1 —fERa, BT URLE

Show Completed Sprints HEBRTES.
(7" 124] 3-1 (2) When the user start the application for the first time, the ToDo 5.0

registration page opens first” ML THETSES, A7—FIAZDA—L
FELAE)RD— FERRT sEEERR Y 3.

[ 188] 3-2 (5) Users can use keywords and click on the “ssarch” button for full- ToDo 3.0
text search. The search results When the user dicks the data on the Inst,
the display shows the map of the results./ BFi8RE. 23R LEE
+—0— FEAL. #RoERT EHS0F -1 —ERnS3.

[ 1as) 3-1 (3) The language of the appllcatlun depends on the settings of the  ToDo 5.0
S artphone. BP0 e C
SRR it ame s e e

[ 148] 3-2 (2) When a sight on the map is chosen, the application will list the  ToDo 13.0
~ detail information of the sight” 1E F v —4%&&RLEZEC, Tofhmo
HESEEREICETT 3.

[ 1a7] 3-2 (4) Viewers can leave comments on the detail information page of _ ToDo 8.0
© thesight /R OREEEETER LT, RSN AS M EEGT SREER
=5

(7 1a3) 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
~ current location on the map.  BEMRARS > ER T LA 7 — FI A LOEER
Ehbe UEBEERRETD.

[T 150] 3-2 (7) Users can register new sights on the map and store the date on  ToDo 8.0
"~ the server by long dlick on the spot.Users will need their email and
password to do this action $hEETEROT —I7HEL L S EERT 58
(ERL) T. FBCESEREL, H—/(CERTIRREED. COB. 7
EQA-LFELALIAT-FEERT S,

[ 151 3-4 (1)Users can register and update their email address and password. ToDo 3.0
T /FIURREOA-LT FLAL/ AT -FERR - EECESERESD.

_68_
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14.2 Sprint planning (Create Sprint Backlog ) 3

4.Sprint is registered

Scrum Sample Project » Master Backlog : Jum o & project...

Overview  Activity [IYSUWEl Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Files Settings

View options (1) = Enable Auto-refresh Refresh Multiline

- | sprintl 2015-10-12 2015-10-23 ~ | Product Backlog Close completed Sprints

[ 143] 3-1 (1) When the users start the application, the main menu appears on

the screen 77U —2 3> 88T B &A1 —HERESN. ETLEVE

S #rERCES.

ToDo

(184 3-1(2) When the user start the application for the first time, the
~ registration page opens first” FIOTHETSES, 27— FIa DAL
FELREIRO—FEEHY sEREERY 3.

ToDo

__ 148] 3-2 (5) Users can use keywords and click on the "search” button for full-
text search. The search results When the user clicks the data on the list,

the display shows the map of the results. S385 (3, EXERSLERL

+—D—FEANL. BRI ERT EHROT ST —BRnE3.

ToDo

__145] 3-1(3) The language of the application depends on the settings of the
Sl plin =g L7TUs—Sa . BAErEEE CERTEAY-MIA
SRATICENETEERRT SXFOSEEEAD.

ToDo

3-2 (2) When a sight on the map is chosen, the application will st the
detail information of the sioht” 0 b7 SRR UG, TOBED
HERTEACETT 3.

ToDo

3-2 (4) Viewers can leave comments on the detail information page of
the sight../ =02 EEEEREE LT, RSN FMESRT oREwS
2.

ToDo

143) 3-2 (6) Clicking "Current Location” button on the display shows the
~ cumrent location on the map. ~IBFEAS SERT & 27— HI5 ORTED
Ehb & UEBESRTRETD.

ToDo

(350) 3-2 {7) Users can register new sights on the map and store the date on
the server by long click on the spot.Users will need their email and
password to do this action. iEEREEOY— 70 =) L S &SRS 55

(ERL) T, SRACHSEREL. U/ (CRRT 38N, 208, 25

BEOA-LF ELAENAD— FEERT 5.

ToDo

[ 151] 3-4 (1)Users can register and update their email address and password.
T SFIURAREOANT RLAE) D FEEE - EE TS SREETO.

ToDo
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14.2 Sprint planning (Create Sprint Backlog ) 4
Development team to create a sprint backlog

Drag-and-drop the story

Scrum Sample Project » Master Backlog : Jump to 3 project

Overview Activity Roadmap QLGILOIEE Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Files Settings

View options (2) [ ] Enable Auto-refresh Refresh Multiline

~ | sprint1 2015-10-12 2015-10-23 v ‘ Product Backlog Close completed Sprints a8
[(343) 3-1 (1) When the users start the application, them TEREEL R T 1.0 ation for the first time, th ToDe 5.0
on the screen. 77 U —2 3 SRR 5 A= B YRR AT hTamAl
VEEERRTES. Fasy
. (T 148) 3-2 (5) Users can use keywords and click on the “search” button for full- ToDo 3.0
Show Completed Sprints text search, The search results When the user dlicks the data on the list,
the display shows the map of the results.. #3853, 2xHHe VEELE
F—O—FEANL. BRAYLERT EHEOT—IN—BERES.
| 145\ 3-1(3) ]1|E language of the appllcatlon dEpEm‘ls on the settings of the ToDo 5.0
e/ L7 EACS FERTBAY— I
DE’EW%J’T XFOSHEENER B,
(T7348) 3-2 (2) When a sight on the map is chosen, the application will list the  TaDo 13.0
~ detail information of the sight/ .tiE t) v — &SR ULEZEC, TOHhED
HEEREEEICETT D,
[ 147] 3-2 (4) Viewers can leave comments on the detail information page of _ ToDo 8.0
T thesight. [hROFARKSTER LT, BREFIAL MEZRTSARERS
e
[ 149) 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
" current location on the map. RIERARS > & W T E 27— FI# S ORER
Zb & L REETRETD.
(T7350) 3-2 (7) Users can register new sights on the map and store the date on  ToDo 8.0
the server by long dick on the spot.Users w||| need thelr email and
uasswurd to do this acti e
) T. SRCHSERITL, Y- i(hﬁ?aﬂﬁ‘ﬁﬁ’). L@EA
%0))( Lk L/ZCJ RO - FE2RT 3.
([ 151) 3-4 (1)Users can register and update their email address and password. ToDo 3.0

7T IRBEDAT FLAE) (R0 — FEEE - BRTESREERD.

If you reselect the backlog in the project menu
Can drag-and-drop
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14.2 Sprint planning (Create Sprint Backlog ) 5

Sprint backlog is created

Search: Jump to a project...

Scrum Sample Project » Master Backlog

Overview Activity Roadmap [Q:Fl{(I[l Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Files Settings

View options (2) + Enable Auto-refresh Refresh Multiline

~ | sprintl 2015-10-12 2015-10-23 [ 16 ] v | Product Backlog Close completed Sprints 32
(77134 3-1 {2) When the user start the application for the first time, the ToDo 5.0 (7148 3-2 (2) When a sight on the map is chosen, the application will list the ToDo 13.0
© registration page opens first” IO THETE8S. A7 FIA @A ' detail information of the sight” . #E Fayv—J#ER L =HC. Eoths

7 ELAENRAD— FEERT SHEERRT Ba FREESFERICETT 5.
[ 148 3-2 (5) Users can use keywords and click on the “search” button for full- ToDo 3.0 [ 143 3-1 (1) When the users start the application, the main menu appears on ToDo 1.0
" text search. The search results When the user clicks the data on the list, : the screen.” 77 —2:3 kRS 58 A" 1 —FREA. BTLELE
the display shows the map of the results. /#85548#E(3, 2508 VR L HEBRTES.
TH—U—-FEANL. BERYERY LHROF ST —BRnci3. — - - 5
[ 1a7) 3-2 (4) Viewers can leave comments on the detail information page of  ToDo 8.0
I 145\ 3-1 (3) The language of the appllcatlon depends on the settmgs of the ToDo 5.0 the sight. /th-SNBRBEREFEE LT, BEST AL FESSTS8EFE
smartphone “H77 U T —=3 0, HZ?—‘\’-'B&.:—E&C{E@? — k2 Zh
Msﬁﬁ(LébmWﬁﬁémsﬁﬁﬂlﬁz — - 5 -
("71a3) 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
| 151 3-4 (1)Users can register and update their email address and password. ToDo 3.0 current location on the map.. BEHARY > ER T & A7 — 4 2 0EEH
= SFFUARSOA-LTF ELRE)RD- FERE - SETEDRREND. ErhiE L EERETS.
| 150 3-2 (7) Users can register new sights on the map and store the date on ~ ToDo 8.0
Show Completed Sprints ~ theserver by long dlick on the spot.Users will need their email and

password to do this action. thEEFRERD T — 8L 1 hEFEIRT 55
(ERL) T, SRICHSEREL, 9—/(CERT 28605, COE. 25
EOA-LFELRE)RD-FEERTS.

X Assume that we can complete the work in three sprint
The estimated value of the first sprint, set at one-third of the estimated total
The estimated value of the second sprint and later, to re-estimate taking into
account the velocity and improvement matters

Do not arbitrarily change the product backlog.
Or when you want to sort the story, to consult a Product Owner when you

want to spilit.
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14.2 Sprint planning (Create Sprint Backlog ) 6

Sort development team prioritize the sprint backlog

Sort the story drag-and-drop

Search: Jump to a project...

Scrum Sample Project » Master Backlog

Overview Activity Roadmap QLEWNIE Releases Issues New issue Gantt Calendar News Documents Wiki Forums Files  Settings

View options (2) [ ] Enable Auto-refresh Refresh Multiline

~ | sprintl 2015-10-12 2015-10-23 16 ~ | Product Backlog Close completed Sprints 32
([ 1a4) 3-1(2) When the user start the auphmuun for the first time, the ToDo 5.0 [ 148 3-2 (2) When a sight on the map js chosen, the application w||| listthe  ToDo 13.0
registration page opens first” MO TFIAT 388, A7— 72204l detail information of the sight” e Fa)~—2FERUIZEIC, TokS
FELRAE/RD— T‘EE?EWE&T?E SHEREERICETY 3.
(7148 3-2 () Users can use keywords and click on the search” button for full- ToDo 3.0 |[[/143] 3-1 (1) When the users start the application, the main menu appears on ToDo 1.0
text search. The search results When the user clicks the data on the list, the screens P U7 — oo W EEET B EA— 1 —HERafl, EhlLzLE
the display shows the map of the results. ./ B3ER(T. 2y@Rs LERL EEBRTEA.
TF-—D-FEANL. BRI ERT EREOT S —EERaNS. — - N
(7 247) 3-2 (4) Viewers can leave comments on the detail information page of _ ToDo 8.0
I 145\ 3-1(3) The Iangna 5 of the application depends on the settings of the ~ ToDo 5.0 the sight./thENZXBERETER L T. EESHNIAY FESRTIRERSF
smartphone % Uir—z3 & Hrﬁhs&%’atﬁﬁ?éx? 2 D
LOSERTICENE TEERET T 3XFOSHE TSR ——
(7 243) 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
[ 151) 3-4 (1)Users can register and update their email address and passwerd. ToDo 3.0 current location on the map SRS R T S AT — BT A SO
T SFIURBEOA LT FLAE) AT FERR - BE TS AREERD. ErhibE U hREREST
[ 150] 3-2 (7) Users can register new sights on the map and store the date on  ToDo 8.0
Show Completed Sprints the server by long dick on the spot.Users will need their email and

password to do this action HEEFREROY—ZHEL 1 S5 2RT 58
(ERL) T. sHCSEREL, —/(CRHT @i, COB. 26
EQR—)LF FLAE) RD— FEEFT 3.
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14.2 Sprint planning (Create Sprint Backlog ) 7

Sprint backlog is sorted

Scrum Sample Project » Master Backlog Sesrchs Jum to a project...

Overview Activity Roadmap [I:ESNWEN Releases Issues Newissue Gantt Calendar News Documents Wiki Forums Files Settings

View options (2) [ ] Enable Autorefresh Refresh Multiline

~ | sprintl 2015-10-12  2015-10-23 16 ~ ‘ Product Backlog Close completed Sprints 32
151| 3-4 (1)Users can register and update their email address and password. ToDo 3.0 138] 3-2 (2) When a sight on the map is chosen, the application will list the ~ ToDo 13.0
S PIURBEDA—ILF FL-RAE) ERD— FEEE - £ 380D, letail information of the sight” B Fyw—7ZBRUEEIC. Tothsn
FESETEECETT 3.
144) 3-1 (2) When the user start the application for the first time, the ToDo 5.0
registration page opens first” O THBATEE. A7—FIAOA—L 143| 3-1 (1) When the users start the application, the main menu appears on ToDo 1.0
FRLAE)RD - FEERT BEMEETT 3. the screen.” PS5 SRR BEA— T HEREAL BILELE
EERRTES.
148) 3-2 (5) Users can use keywords and dlick on the "search” button for full- ToDo 3.0
text search. The search results When the user clicks the data on the list, 147) 3-2 (4) Viewers can leave comments on the detail information page of  ToDo 8.0
the display shows the map of the results. &SR, SSrEFeVERLE the slght SHEOEEESETER LT, BREFIAL M EEET SRS
TH—D— FEANL. BERS &Y CHRDT - I —BERENS.
145| 3-1 (3) The language of the application depends on the settings of the  ToDe 5.0 14| 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
smartphone Y77 s —33%3. BARSOEELEEATBAY— M4 current location on the map..” BEMARY 2R T &R v — HT7 A SADETEH
DSERECENT TERST ¢ SXFOSEENEAS. ERLELEBERTETD.
) 150 3-2 (7) Users can register new sights on the map and store the date on ~ ToDo 8.0
Show Completed Sprints the server by long dick on the spot.Users will need their email and

Dassword tadnﬂus action EEZFEREOY— 7B L BEEERT S
FECBRESEL, Y- JE(LE?EHE‘EE%D O BR
%ﬂ)i JL?H/ZCJR’:I FEZET3
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14.3 Sprint planning (Create Task)

Development team to create a task from the sprint backlog

\\

User
Pr t owner

Scrum master
Development team

User story ' Story ' Il Story
q I’ Story I’

Product backlog \Spl’iht backlog
\

Story

1 . Create Task

Development team to create a task from the sprint backlog
2 Sets the person in charge

Development team sets the person in charge of the task
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14.3 Sprint planning (Create Task) 1

Development team to create a task

Select the Taskboard

Scrum Sample Project = Master Backlog Sl mE R 2 pruka

Boadeap @SN Eelesies Deuses New ssee Gamll | Calesalar Mews  Doooments Wikl Foroess Files Setings
Wiew aptin (1]

L “'?dnt]. HI!S-:I:H—‘]E Hrl!-m-\.'i'! gL =

ol pocmaid,  Tolie ET

el g Bte t el tiess TR 3-2(5) When e 1-m1;hmr- the rA-:n il Batithe
T -\.."_"ZJ—' IﬂE SETEMARETD, e plemahon gf L R — T D
L PETEENBTENTI.
- wtart tam spplicrta for tha firt s, e Talo L
o fret WS THAT AR, b Farian—i iy 31 -1] -Mn e -m-'. SLETT i BEOROtian, INE A e BRORET 08 TEDW ()
FERSTIMEEATTE the & BT 5 S — SIS AT, WYL
Srrle T ks } ﬁﬂzvz
i v emyarrsn anvd chck on the “seerc” button dor il Tallo anh
Wik farch resid u nh-\- e user okicks the dafs on the s AR, T2 (4] ieserin O legan oomimeain on the debad artsrmation oege of Telw &
Prveinad e RTEE m- el hRDEEMHEREL 7. BNeY I rr Rl IaEEn
e Bl 'S'.rﬁFTcPND— Pa
Rpoel a-eunl-r apoRcatian depaeds on the settrgs s the  Talin S0 [ITERE 32 (8] Dckenvg "Cuivent Locatisn” buttom, o the drtey shows the Talw 38
n i il Y AT~ F o corment lcaiion on the e, - MERT. P30T S A T— b7 WOER
ek rT-E‘I‘T!R%“iIIEMA‘.E EhL LSRN D,
i 32 (7] disere om segebel tew sihis o the mao a0d store the se o Telw ab
Show Compleated Sprints T the arvsr by B chok O Ue SP08 TASEIE Rl IIHI“'.'-‘I e E
pastasted To di g potien B BTG 7 -2 BE!EF!I
LEML MRS FEE Lt (T !II:RF"'J. —iE. B

woA— L EL R s T PR .

14.3 Sprint planning (Create Task) 2

Task board is displayed

Scrum Sample Project = sprint1

Ovnrdiow  Aclelly Roadmap Backlogs Roleates  Isdnes  Mew sue  Camtlt | Cabemdar Nows

Stary Tobao Dhieng Review Dane

W Tprivt Imoedrvants

o 8 by 151

:lqmuun £ i s

Lpely thai grras addvass ard

pm-ml )':'J ety o
L2

A3 - FEEm lIrra

A k| 558

14 (1) ikme The s winri tia
wpphastige b the frat tree. Tee
ragtrtration page cpws fint @OT
EM TSRS, TF—h0y-na
Fhltonizt - ke iy i

o 9 bl 1o
3-3 (3] wiemrn can ca pcndu and
d-nw-w k. button for full-
taat wnarck, The tearch. ety
Bhar the aser cha fa dite o
lak. the dazhy Bian the mep

9 0 bn] ban
34 (3] The nguags of ihe
dapardy 31
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14.3 Sprint planning (Create Task) 3

Click the "+", the "New Task" screen will be dlsplayed on the Story

Scrum Sample Project - sprint1

Chimriliw  Actiwity  Snadmap  Bsckings  Belesses Ssiiess  Niw beiss Gamtl Calenilar  News Oisouments Wikl Forges Files Seflings

Fty by uam Rumdown Cotumy) wafs| 2 ﬂﬂﬁl.w el
BLary T Mirimig Reviow Dane
3 Sprm Ingadians

:l i AmaloER i Task
378 L {Liars oo ey o wed -
sddrean arad
panmard, LS A - AT o S p—— Ty
LA AT M- ERTE e A T

R s | Subject Set Subject
(Research, design, Coding,

i
E
a
i

ol

r‘-if.m- =t testing, etc.)
Sppkcasion tortha Pt L, e Description Set Description

ingiriralian pags ssean et ST
WEY RS, TT- 4t
FRLIEATT- FEBHT AR

Assigned To  |Not set

,f',(,. u..,.,..,..:;.;.t:'.'.: @ wl Remaining Set the estimated time

dack aa Sha “mmarch” badmon for lal-

ot i T - s b (hours) % set in 12 hours or less
Whao the awe chiba e duts @ FEM—.d
bk, the dapley srawe He rmap

o 3 b |2 ok Cancel
nn::llmw;q.mh
s the

uh--mp'm\- TS
o EEETERLGERRTE
O ERET A T

14.3 Sprint planning (Create Task) 4

Task is created
Scrum Sample Project » sprint1

Tverdiess  Activity Rosdmap  Backisgs Helesses  Isspes Wewissoe  Ganft Calendar  Mews Docomepts . Wlkd Forums  Files  Settings
Fiftes b wmer . Barndcmn) Cahumss whith: | 3] Enaile Scts- el Natrash

Sty Tolx Dong Heview Ebeiar

o Sarrk [rpadirns

'+ 18 bt 124
34 {1fawrs cam sugubar eed
uadina thar smsd sddveis sid
AR, ST URNEO LR TR

ettt 5 i ‘?‘:ﬂn
[ Ll =N

a9 i b 144
31 1T Whwn te unar shart th
nmhlhnrbrluimm the
'Ntien pags cpsnd Arm” T T
i!’"!-lh"‘ AR A Al
FRELAEIAT - EE I aE

a3 [ ) 148
-2 { %) e cam uw bwrecedy wnd
chak o thas “sharch” Batizn Far Al
et peorch. The sesrch rowits
‘v s ar icks the dats o
barts th dhiyplay whosey 5

a [B b 142
31 | %) T bnguage o tha
apiacution m:_mm.-m

A3 Lﬂmtml’#
P AT T S T .
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14.3 Sprint planning (Create Task)

Create all the tasks

Serurn Sample Project « sprint1

Colapeles  Myws  Dwrweresis  Sls  Feses

Syuryw Aiiwity Wesdwen  Bsbben Selwees bmees Mewiess Geslt

5

Fiiss S

1 B B s ki Wi
ki o o Lt b

T
“2

FHLALIEE— |3

hr'm :F.l".l'r T
r 4_"!11’_9
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14.3 Sprint planning (Create Task)

6

Click the task to set the person in charge (sign up)

Scrum Sample Project » :prirlrl

------ e ASTa LS P B By s

_Llpl-uudﬂ- e

e "". -i

o A 1

:I-H.H P B -I'II
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Salidims laiess fés Sees  GIL Lol s Hems  [Haassasit il fiaues Pl —ye

Subject(@E%)

Description (5%8A)

/Assigned To

Set the person
in charge

Remaining (hours)
(5% D BFRA)
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14.3 Sprint planning (Create Task) 7

The color of the task changes when you set the person in charge

Scrum Sampde Project » sprint

Dusiwiie  Rutisly  Mosdmap  Hackiogs  Folmsss  (oiss S ssies  Cwifl  Dobesdir  eess  Doossscks Wikl fasssss  Ddes - Sailisgs
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15. Sprint

Development team do the sprint

L ~

Scrum master

b;

Development team

S5 Daily

AR
88~ MMM

1. Move a task in progress

2. Register the task of artifacts

3. Developers, records the work time

4., Daily scrum

5. Register the sprint impediment task

_75_
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15.1 Sprint (Update Task)

Move a task in progress

Serum Sample Project « sprintl

Crwwmss | fottety  Apsimsp  Neddegs  Nelwsss  (ssoms  Mewjwam  Gewl  Calweds)  Swws  Docowsss W1 Gwues Dl et

-.n..n-.n.-u |.-|

3
SEF A ST
R

215 Ly o o vt ol
T Dt o
ol
T
TR

ToDo Work before the ticket
Doing Ongoing ticket
Review Review Ticket
X Other than the personnel review.Move review after completion of the "Done"
Done Complete ticket

X Artifacts I registered in the "Task" ticket
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15.1 Sprint (Update Task) 1

Update the remaining time until the task is complete

Mext 2015 Bampla Project » sprint |

Evdrves  Aciaiy isless  Sechiegs  Selases  laess  fes bess el Coesle  Hess  laaesais Wi fauss  fls e

ShFy Taddge Evaiig L] s

I- I|h- e ]
e s e e

..n._ T T
s::nw—l-llh e
G ®

1] 7 e
1 LT o B v i
S

= ve Subject -
'rﬂlw“r'..ﬁ'.:".’u

Description -

Ill'.l_l-lll-lv-vl-l

Assigned To -

Remaining (hours) |Update
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15.2 Sprint (Register the task of artifacts)

Select the Issues, click the task ticket target

Scrum Sample Project Searck; Tumg 123 prcjact

Oyerview  Activity Roadmap  Backlogs Rduum_ﬂmlm Gardt  Calemalar  News  Documents Wiki Foruens  Files

Issues Irzurs
= Fiters View oll issues
A Seate s A | Sustmary
st open v e ' Caondar
RA Traccar ["E—— [y 7| @ i
* Dptona Sprnte
o Feply  Omar ] Sevn springl
< # = Tracher Status Priority Subjirct Assignad Te Updated Serum Sasple Project
1167 task  TeDo Mormal Test-TZi Hambart  00/10/2015 13:43 Product backiog
Sorum
1165  task TeDo  Mermal Test- 731 Hismard [ LT et P ]
I 165  task  Rewiew Mormal CodingW0E Hemberd 09710/ 201F 1342
1i64  task Doing  Mermal  Survey the lanpeape satbing methed -~ BREED S S R Hismdard [ LT Tt e
Sorum
Oz task TeDo  Mormal Test 73 Hembeard 09710/ 2001F 1340
Sorum
] 16 task  Aovdew Hormal CodingEH Harmdars [T Dbt} o e B
Sorum
] 180 tank Diping  Mormal  Coding F’“E" infrmnatien saarch procsssing(Searver prodessing LB THE Herkan 09/ 10/ 200F 1343
WEARTRE (4 Sorum
1160 task TeDo  Mormal Toding soreen design REITF < @@ Humbart 012015 13ned
Sorum
[Ji5%  task TeDo  Mormal Test"FE Huamdard 09/ 10/ 2015 13080
Sorum
1158 task  Review Mormal  Coding esar information registration [(Sensr professing) 2 — ARSI Hemkary 09/ 10y 2005 1343
BERS (H— /A Sarum
1158 task Doing  Mermal  Coding proces=ing for the first ime use B0 THRATSESTNEEER Hismdart 09/ 102015 1343
Sorum
1153 task  Doing  Mormal Coding S Hemberd  09/10/201% 13:42
Sorum

-1yl
s gwzilivte inl ] &am | G5V | FOF
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15.2 Sprint (Register the task of artifacts) 1
Click Edit on the task screen
Scrum Sample Project
Drvarview  Activity  Resdmap  Backlogs E JEETI Wiw fssue  Gantt  Calendar  Mews  Documents  Wiki  Forums  Files  Settings
task #165 Lrn: tima d Watch [ Copy @ Dalste gy
. iew all issuas
ey A et S e o e * Fredous el L5 Summany
nTE AT L& 2 Ak E B Calendar
Coding.” RE Gantt
Added by Akira Kureda about 1 heur ago. Updabed 25 minuies age. Sprinks
Stats: Rvian Start date: 08/ 102005 sprinty
Priority; Hormal D date: .
oading S
Bimsigned Too Pambars Sonsm B Done . . [ Sample Froject
Category: = Estimated time: 12,00 Faurs L
Target warsion: mprink] Spant thme: - Sprint “mrimti”
Remsining [hours) 12.0 ek board
Burmelomn
Suhtanks add wikd
Impediments
Related issuns tdd
Histery
Updatad by Akira Kureda 36 misistes ago Ll
+ Amsigned To sat to Membe? S
Updated by Akira Kurcda 30 misistes a0 Lr]
= Asgigiied To delated |Membord oo |
Updated by Akira Kurcds 37 misastes ago LE]
= Assigned To sat to Memberd Sour Watchers (&) A
Updated by Akira Kurcds 35 misastes ago LE]
= Statues charged from Todo to Deview
Edir {5} Log time o wWaech 1) Copy I Dsiete
44
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15 .2 Sprint (Register the task of artifacts) 2

Set a comment to “Note”. Attach to File. Click Submit

Edit
Changa prepatio
Project * [Scmm Saspk Frajecd | 1 Prhvate
Tracker * [lask |

Saihieet * |Codiag.WH-

Desscriplion
Santus * [Hodew | Parest insk | 145
Privrty * [Foma | start ddnte [T 60510 |
Assiguesd To [Mombi3 Scum | i st
Tl worshon [menfl | 0 -
w Doae |0 % o |
Remabning (hours) [17 0 |
Loy time
spent Hme | | Heurd Activity | — Pliasa sl — »|
o i |
ﬁ':-'.u
B iU E € mme == 3T o @

Frevmte motes
Files

== Maximum size: 97.7 MB)

eview | Cancel
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15.3 Sprint  (Daily scrum)

Development team to perform the Daily Scrum.

The results recorded in Wiki.

Daily Scrum is a meeting to check the progress at all.

[ What did I do yesterday 1 . [ What will I do today ] .
[ What Sprint impediment | Share.

Scrum Sample Project Jump t0 a project...

Overview Activity Roadmap Backlogs Taskboard Releases Issues New issue Gantt Calendar News Documents RV Forums Files Settings

Wiki " Edit ¢ Watch @ Lok * Rename [ Delete - History  wii

Sprint1 Daily Scrum Start page
Index by title
Sprintl Review e Index by date
ki »
Sprintl Retrospective Sprint1 Daily Scrum

Sprint2 Daily Scrum

yyyy/mm/dd
Sprint2 Review -

1. EEAELED?
Sprint2 Retrospective 2. SHEAETIH?

Sprint3 Daily Scrum _3_- AnEEES s 2

Sprint3 Review
" yyyy/mm/dd

Sprint3 Retrospective
,E P yyyy/mm/dd
New file yyyy/mm/dd
yyyy/mm/dd Also available in: PDF | HTML | TXT

yyyy/mm/dd

New file

X Domestic developers, it will record in English and Japanese

_78_

46




15.4 Sprint (Records the work time)

Select the Issues, click the task ticket target

Scrum Sample Project
Owerview  Activity  Eoodmap Dackiops  Relsases Cabemrdnr  News Docaments  Wiki
Issues feums
= Feters View wil bssues
R Suns Al A | Summiary
= Cahardat
A Targwt varoms Famt
B Baoeag o
A femgrad Tn
spindl
* Cpso . unk 1
Serum Sl Project
+F Foply T Cuar i3 Save
Product Sackeog
o @ Trecher Status Priociy Suhpect As=igned To Updated Pealtinn = _ T
[i% task Doing Morma  Coding grocessnp for the firsd Hme see SO THA T2 @S Hissbari OOFE0/ 1085 13:42 0158
Tack boand
[ e task Talo  Mormd  Cofing sorest Sadicn. WRT - ER Heskerd BI0EEET 13:40 L] :‘:'E'dm
1167 task Tedo  Momal Test- ¥ b HemBan OOFL030as 1342 ans

Foum

[+-373]

Alwy avvalaisls mr: [ S8em | £ | PP
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15.4 Sprint (Records the work time) 1

Click Edit on the task screen
Scrum Sample Project

Ouerview  Activily  Bombmap  Backings  Relosyes Mew vy Gamil Calemdar News  Docpments

task #1160 mtm:m—- ‘wiptch T Coay B

shory 314 Y BE K il i Tt Foges| Tor Agl-tarwt Awnrch T WY T » Provica |
dzie -t £atm 7w [ s, Eom herles whrrs o mar of Hie o EEm SrEn R AL 4
S

Coading screen design. TS 5 2R
Adrded By Aldrs Kgrods stout 4 hmes aps. Updated showt 4 hoars pgo

Saatus: TeDn Stari dals

3 Linniflng
Prikrity= Py | Do abe;
Axmigned Ta: Membort Soum % Dume; T
Catpgory: 4 Esimasted e 4.5 hows
Targeh virsin: prntl S i
Remaining {hoars} a0
Suhiasks
Helatn iswpes
Eockad by cage #1658 Sprint Tmpedimants. 230 2R Toim LT R ]
History

Upadsted by Alirs Eorods shout 4 hoors ags

o Adsigmad Ta et o Manbens Sonm
Upadastad By Abdra Baroda sbout 4 hows o

= Anmigned To dalebed | et S|
Updatind by Abfra Buroda sBoil 4 hinss ago

+ Aysigned To yei by Member] Scrum
Upddetied by Akdrs Karnda sboit 3 hoors sgo
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Gantt
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Bpring ]
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Froquct backiay
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15.4 Sprint (Records the work time) 2

Click Submit to set the Spent time and Activity in the Edit screen

Edir

Chasge propeies
Projoct ® S.fum .S.;rm:h:l I:‘ll:llel;r | "] Private
Vracker * (1wt ]

subect * [G.ading scruon dsign. IR 05

[ AT
Stats * [Toba v Parint tesk | o, (43
Prisrity * [Hormal ] Start dalo 26150910
Assigned To [Wamtdr Eoun W D date |
Taruet verson g o i
e Dona [§ % |
Remaining [hosry) (4 o
Lizg Tima
f Spent time |3 Hows || [astivity [Cmeicr ~ ]
Conmmeent N
PaLas
B LU SC m i =S @ E e g @
I-_' .ﬂ';..'.'illﬂ notE=
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15.5 Sprint ( Register the sprint failure task )
Registered the failure that occurred in the scrum
Click on the "+" in the Sprint Impediments
Subject Set Subject (English,/Japanese)
Blocks Set the impediment task number
Assigned To Set the person in charge
Remaining (hours) Set the Estimated time
50
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15.5 Sprint ( Register the sprint failure task ) 1

Sprint impediment task is registered
Scrum Sample Project « sprint1

Uwaiveew Aitwily  Roslesst  Bsckbeis  Gelisss  lmies  Mew ssss  sall

Calsrulas  Hews Duicssdis Wik

Sprint impediment task to follow towards the resolution scrum master

51

15.6 Sprint (Burndown chart)

Burn down chart is displayed when you click the Bourndown of
Task board

Scram Sample Froject « sprintd

i wilhihe b i [JEETT -

% Developers can check how much time is required to
complete the sprint

52
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16 Sprint review

Do a product review that has been developed in the sprint
Will be added to the user story, if necessary any additional request from

Product Owner

X Development team of personnel, to demonstrate to the Product Owner.

Review results recorded in Wiki.

( \ User

User Product owner

o & se = =
—

Scrum master Deve]opment team

g M

-

Development team to report the total value of the story points that

have been "completed" in sprint

53

16.1 Review of the story points

Set the story points that were completed in the sprint 1

Search:

Scrum Sample Project » Master Backlog

Jump to a project.

Overview Activity Roadmap [:FBNGIEE Releases Issues Newissue Ganitt Calendar News Documents Wiki Forums Files Seltings

View options (2) + I:l Enable Auto-refresh Refresh Multiline

~ | sprintl 2015-10-12 2015-10-23 16 Product Backlog Close completed Sprints 32
145] 3-1 (3) The language of the application depends on the settings of the ToDo 5.0 1a3| 3-1 (1) When the users start the application, the main menu appears on ~ ToDo 1.0
smartphone. L7 J s —2 320k, BAEOESHEERATBAT—FI4 0 the screen.” 7 J&r— 23 VRN BE A= 1 —NERaTL, Hi7LIEL S
_jﬂﬁluébﬁ‘(w%ﬂ'?'}xm;fiﬁmﬁz ERERTES.
151 3-4 (1)Users can register and update their email address and password. .~ ToDo 3.0 147| 3-2 (4) Viewers can leave comments on the detail information page of the ToDo 8.0
FFURABEDA—ILF FLRERD— FERE - EETESERERD. sight.fi=SsHAESETaE LT, BESHIAY FESETSEEFSD.
144) 3-1 (2) When the user start the application for the first time, the ToDo 5.0 143] 3-2 (6) Clicking "Current Location"” button on the display shows the current ToDo 2.0
registration page opens first” fI0 THIAT RS, A7— I 2DA—ILF location on the map.. SRS E R T E 27— b4 ORERERLEL
FLAE)RD— FEEET SEEFETY 3. FEMEERETD.
148] 3-2 (5) Users can use keywords and click on the "search” button for full- ToDo 3.0 146| 3-2 (2) When a sight on the map is chosen, the application will list the _ ToDo 13.0
text search. The search results When the user clicks the data on the list, detail information of the sight” . #hEd FD7—S%FRLIzEIC. TothSnss
the display shows the map of the results..” 3Z8HE(L, mt L,WJ—_T HESFEEICETT 3.
F—0—FEANL. BERYERY CHROT —ST—RET -
150 3-2 (7) Users can register new sights on the map and store the date on the ToDo 8.0

server by long dlick on the spot.Users will need their email and password to

Show Completed Sprints do this action HEETEROY—IOEL 1 thaxEiRe a5 (EFL) T, #i8

[CHISESEL., -/ (CRRT SEEFSD.

JRI-—FEEFT 3.

Set the story points that were completed in the sprint 1
It will determine the story points of unfinished sprint backlog
[The example above]
5.0 — 3.0(completed in the sprint)
[2.0] (the story points of unfinished sprint backlog)
3.0 — 3.0(All completion)
5.0 — 3.0(completed in the sprint)
[2.0] (the story points of unfinished sprint backlog)
3.0 — 3.0(completed in the sprint)
Story that can not be completed is performed by the following sprint

_82_
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16.1 Review of the story points 1

To create a story that could not be completed

Scrum Sample Project » Master Backlog

Overview Activity Roadmap QLRI Releases

Issues New issue

Gantt

Jump to a project...

Velocity

uments Wiki Forums Files Settings

View options (2) + Enable Auto-refresh Refresh Multiline
~ | sprintl 2015-10-12 2015-10-23 A | Product Backlog Close completed Sprints 36
[T 1a3) 3-1(3) The language of the application depends on the settings of the ToDo 143] 3-1 (1) When the users start the application, the main menu ap, ars ToDo 1.0
smartphone. & 779 Uo—a3E, BRAETEEREERATEAT - on the sereen/ 77T -3 Y EERTBE A1 —HFonai,
T DESERECENETEESRL T s FOSEENER 5. == EVVEEERRTES.
[ 151) 3-4 (1)Users can register and update their email address and ToD)| 3.0 147 3-2 (4) Viewers can leave comments on the detail information page of ToDo 8.0
— password. /FTURESOA—LF FLAE)AD— FERR - TETEDS the sight. = OHEEERTEE T, HESIIAY FEERT S8
HRERIFD. D,
[ 144| 3-1 (2) When the user start the application for the first time, the ToDj 3-2 (6) Clicking "Current Location” button on the display shows the ToDo 2.0
registration page opens first” #1& CRIET 388, A7~ 74 2mA— current location on the map. ~REMAT LZHT & 27— 74 ORE
L7 ELAEIRD— FEERT SEMERTY 3. m hEhLE LI thEERET D,
[ 148| 3-2 (5) Users can use keywords and click on the “search” button for D} 3.0 145\ 3-2 (2) When a sight on the map is chosen, the application will list the ToDo 13.0
full-text search. The search results When the user dlicks the data on detail information of the sight” HiE F DT — 7EER LEEIC. TOMsS
the list, the display shows the map of the results.. &8, g;zﬁ oREEREERCETI 3.
FELUBEECE—T— FEAL, BRe>5R T LHRaT— o5 . -
e i (7450 3-2 (7) Users can register new sights on the map and store the date  ToDo 8.0
] e on the server by long click on the spot.Users will need their email and
3 password to do this action HEZREROY—7HEL L HSFBRT S
Show Completed Sprints (EAL) T. SIRICHSZIEL. U—/ICEETSRETHD. COR
EREOANT FLALIRT- FEERTS.
| 183 3 1 (3) The language of the application depends on the settings of the ToDo 2.0
martphone.” %57 71) 3 JIE‘ BEEPESHLERTBRT—F
170 3-1 (2) When the user start the application for the first time, the ToDo 2.0
~ registration page opens first.” A THAT SRS, AT—FIAZDA—
2 o £

To the next sprint
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16.2 Sprint review (Record the results)

The Sprint Review results recorded in Wiki.

Jump to a project. _

Scrum Sample Project

Overview Activity Roadmap
wiki

Sprint1 Daily Scrum

Backlogs Task board Releases Issues New issue Ganitt Calendar News Documenl i orums Files Settings

#" Edit +r Watch £ Lock @ Rename fij Delete - History Wiki

Start page

Index by title

Sprint1 Review Index by date

Sprint1 Retrospective Wild »

Sprint1 Review

LE1—ERERikT 3,

Sprint2 Daily Scrum

Sprint2 Review

Sprint2 Retrospective

Sprint3 Daily Scrum

Sprint3 Review New file

Sprint2 Retrospective

New file

Also available in: PDF | HTML | TXT

X Domestic developers, it will record in English and Japanese
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17 Sprint retrospective

Development team to perform the Sprint retrospective.
The results recorded in Wiki.
Burn down chart also you want to reference

e

N Scru aster
& )
Fiﬂ:— ‘ Development team —_—

[K : keep= To continue in the future |
[P : problem = Quit because issues that |
[T : try= | want to try future |

X Improvements, help in estimating the next sprint
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17.1 Sprint retrospective ( View work time )

Click on the Report of the Overview

Scrum Sample Project
Bonidmap  Backings  Aelesses fwupes  New s Gamdi | Calesslar News Oosoments Wikl Foromes  Flles  Sefbings
Overview Qew borijer § Oime | gopg g
& Mo 3 102 hyur
bz tracking : . -
Log T | Dela i Feport
A Managar! Mamberl Scnam e = -
*. Shony: "1_"'"“' it Dstedlopiar: MmBark Sevim, Hisar] Sonm, Mambard Som,
Ry e e e HuambirrS Scrus, Mambord §omes

Wi &l Resues | Caléndar | St RFoporter: Manberd Sorum, MembeS Soum, Membes Soom

_84_
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17.1 Sprint retrospective ( View work time ) 1

Spent time is displayed

Scrum Sample Project S Jume to2 profect
Ouerview  Activity Roadeap  Bachlogs R T M i Gamti  Cabaidar  News  Decumwenbs  Wiki  Forumic  Files  Settings
Al Progects = Scrum Sample Project = (i Leg tira
Spent time
* FRteS
B Duba any | add fiker |
* Dpons
o boply f Cloar
elnds | Repor
Dietails; [Daps w] &dd | @ Clear
Tatal time: 12,00 hawrs
[ 20A5-00-10 Tetal tie:
sk 2135: Table design.” T — LB 5.00 5.00
task #156: Cofing processing Tor e first ime s TET AT 288 000TE TS 5.00 5.0
tazk 2180 Coding screen desipn. BT Rl oo oo
Total time 1200 12,00
tiso asdsble i CE
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17.2 Sprint retrospective (Record the results)

The Sprint retrospective results recorded in Wiki.

Scrum Sample Project Jump 10 a project...

Overview Activity Roadmap Backlogs Taskboard Releases Issues New issue Gantt Calendar News Daujmemm orums Files Settings

Wiki # Edit ¥r Watch & Lock @ Rename @ Delete - History ki

Sprint1 Daily Scrum Start page
Index by title

Sprint1 Review Index by date

Sprint1 Retrospective Wik »

Sprint2 Daily Scrum Sprint1 Retrospective ----------------------

Sprint2 Review 1. Keep

Sprint2 Retrospective 2. Problem

Sprint3 Daily Scrum 3. TryI

Sprint3 Review

Sprint2 Retrospective

New file New file

Also available in: PDF | HTML | TXT

% Domestic developers, it will record in English and Japanese
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BASEHERE 1 —EH

1. @E
BABZOHITOAN LA ZOHIBORAEZRLTRETITIIr—avx#Rm(ET S,
FAEX, BESAMEDHE EICEFIN-IBEREERTHENHKS, BIZLLKDOHD
EHEANLT, BFREROBRREITOIELHEKS,
FEHINTOSERICBRLE-FIAENRET HHEEZEE. EOBEHRNFIAFICE-T
AR HEIMER M5B,
BE.FAFXINSRNILVEHEEDEFZREAREEL, ZFREROBRREITOIENTES,

FIRE X, B/ NN—a D7 URAARER(RR—R I+ 0) EF->THT7 T r—aVE BT 5,
AX—hr 7420, LTERSGRUWIFIEE AU 3—R NI ERIRETH 7TV r—a v FAT 5,
27T r—aviE. FPORBESNI-FERADOWebY —/N\ET—FDREZEZTI,

AY—h I+ DE@EIZKTT HHEEFRIL. Googlett DMAPEFIAT S,
BARFELELTTZ7ONAILVHREZERT 5, TR IL—LT—UELTRIS L(scrum)ZFFHT 5,

3. EEFIE XTRIIEREEFHDHEE
31 7)) r—av KT HEE
(1) ZFVr—23 %8813 A1 —NRESN . FITLAEVVEEEZ BIRTES,
BREATIE. "ERRTOOWR) " "B X T Q2EEN S RIRT S,
F-3BEHDOHEEL L TIHR B FIBFR (A—ILTRLAENRRAT—R) DLEE#REEE T 5,

2) HHTHETBRIBEE AYX— b IAVDA—I)LFPELREINRT— h%’*ﬁﬁuﬁ%iqﬁén
A— )b?HzZ&/\X'? Hi 77°'J’7'—/5|/|7~1( EJJ 5 %(d

Q) BEROT I aVN—Dn5, TT)r—30DN—2a ERRREITA S,

3-2 "IRERER R ) "I A EE
(1) BEEERRLUERICAI— I+ QR AMFREY . BEMAE (FE1TkmLLR) D
WREZERRL, S—/ N EIZEENBEFIN TV RIII—IERTT D,
fHiE b DEFE(0.5Km, 1.0Km, 2.0KmAZE) BN TEDLIITLRDHEEIZRLY,
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User Requirements for Development

1. Outline
Develop an application, which enables local people and tourists to register and access information about sights in the area.

Users can find the information of registered sights on the maps near the current location.
Users can also search the registered information using suitable search terms.

Moreover, users can vote and evaluate the information offered to the locations.

Users can record as well as search for any registered sights on the "Travel Dictionary".

2. Environment
This application works on latest version Android devices.
For smartphones, this systems requires LTE, 3G or Wi-Fi internet access.
The application transmits data between the private web server of this project.
The applications uses the Google Map to register sights on smartphones.
Agile software and Scrum are used for the software development framework.

3. Regirements
3-1 Function Requirements of the application *The underlined information has already been implemented.
(1) When the users start the application, the main menu appears on the screen.
Users can choose the desired functions from the listing on the main menu.
The two main listed functions are: "Sight Information (Map)" and "Rankings".
The third function is for the users to update their registered information, such as e-mail address and password.

(2)When the user start the application for the first time, the registration page opens first to register an email address and password.
The registered information is stored automatically on the application, and it is not required to provide any details on any revisit later.
(The registration page will not be displayed on the second visit.)
The registered e-mail and password are required when the user wish to delete the registered information.

(3) The language of the application depends on the settings of the smartphone.
(The default setting is English)

(4) The version of the application can be listed from the action bar of the screen.

3-2 Function Requirements on the "sight information (Map)"
(1) Display the map within one-kilometer radius from the current location and display the mark the registered sights on the server.

Additional options to select the map scale(within 0.5 km, 1.0 km or 2.0 km) will be better.

(2) When a sight on the map is chosen, the application will list the detail information of the sight.
The detail information includes the name of the sight, address, phone number, notes and any other required information.
The name of the sight is written both in English and the local language.
Consider to add descriptions on other items in English besides the local language.

(3) Set up "Like" button on the detail information page. Users can vote for the sight by clicking the button.
For a specific sight, only one vote will be accepted from one unique email address, and only the latest vote from

the same address is valid.

(4) Viewers can leave comments on the detail information page of the sight.
Comments are listed by registered dates in descending order.
Comment can be deleted by the writer of the comment.
The user who register the sight can also delete the comments.

(5)Users can use keywords and click on the "search" button for full-text search. The search results are listed on the screen.
When the user clicks the data on the list, the display shows the map of the results.
(Pressing the "back" button on the list page, takes the page back to the map of the current location.)

(6) Clicking "Current Location" button on the display shows the current location on the map.

(7) Users can register new sights on the map and store the date on the server by long click on the spot.
Users will need their_email and password to do this action.
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3-3 Function Requirements on the "Rankings"
(1) Variation of rank order for detail information:
* Rank in order of a number of "Like" votes
* Rank in order of a number of comments
* Rank in order of dates and time

(2) Rank in order of a number of "Like" votes lists the information below:
Iltems: number of “Like”, sight name, address
Sorting order: number of "Like “ (descending order), sight names (alphabetical order)
* If possible, the list should be sorted by distance from the current location.

(3)Rank in order of a number of comments lists the information below:
Iltems: Number of comments, sight name, address
Sorting order: comments (descending order), sight names (alphabetical order)
* If possible, the list will be sorted by distance from the current location.

(4)Rank in order of dates and time
Iltems: Registered date and time, sight names and address
Sorting order: Registered date and time (descending order), sight names (ascending order)
* If possible, the list will be sorted by distance from the current location.

3-4 Function Requirements on ”"Registration of email address”
(1)Users can register and update their email address and password.
A user visits the page for the first time, the registration page appears automatically.
The registered e-mail address and password are stored on the application.

(2) We expect the appropriate implementation for the new function to update password.

3-5 Function Requirements on “Travel Dictionary”
(1)Users can use additional function called "Travel Dictionary "from the menu page to register words.

(2)Users can register words on the "Travel Dictionary".
The words ucan be registered under the following two categories: "Souvenirs" and " Visiting Sites."
Users can register words along with a picture and its description.

(3)Users can search on the Travel Dictionary.
Users can search by categories and keywords.
Search results include categories, pictures, descriptions.

3-6 Function Requirements on "User Evaluation”
(1)Users can register themselves on the manu page for User Evaluation.

(2)The user evaluation is done on five-point scale that is based on five functions, and leave comments
(for future improvements or spotting weak points).
The five functions are:

1. Information Display(through maps)

2. Rank in order of a number of "Like" votes

3. Rank in order of a number of comments

4. Rank in order of dates and time

5. Travel Dictionary

(3)Users can view evaluations of other users.
The comments will be listed in the order of registered dates and time.

(4)Users can view the total evaluations based on each function.
The average score of all user evaluations of each function will be listed.
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MySQL /3 05— & N 2 E 3L F ORI 2> T 5,
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1 mapdb W TNT 7)) EERERR
2 mapdb_a Team A il —# _X— A
3 mapdb_b Team B 7 — % X— =%
4 mapdb_c Team C i —# X— A
5 mapdb_d Team D 5 —# X— 2
6 mapdb_e Team E i —# X— =&
7 mapdb_f Team F 75— % X— 2

TIV =y a ryTT =7 NERRT 55813, T8 RX— A4 T =T VA DI
LTRSS,

1 T—7VEEK
K AT BDOT —H_XR—27—T VXX 1127”1,

t_place t_comment t_user

o placeid int(11) auto_increment o commentid int(11) auto_increment —|~ o userid int(11) auto_increment
placename varchar(60) o placeid int(11) (FK) 1 mailaddress varchar(60)
placename_en varchar(60) nuserid int(11) (FK) }()— 0 password varchar(30)

o latitude double createtime datetime

0 longitude double comment varchar(200)

likecount int(11)
address varchar(60) )
phonenumber varchar(60) t_like

remark varchar(120) puserid int(11) (FK)
projectcode varchar(5) i placeid int(11) (FK)

1 F—Z_— 27— 7 )L BEK
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22X hID commentid Int O | O | B&EHZHE TN
BIhb
s ID placeid Int O
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2 A2 FHK | commenttime datetime
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Database Specification

0 Databese Set

The database names on the MySQL server are as follows:

No. Database name Remarks

1 mapdb For checking the sample application.
2 mapdb_a For Team A

3 mapdb_b For Team B

4 mapdb_c For Team C

5 mapdb_d For Team D

6 mapdb_e For Team E

7 mapdb_f For Team F

i

When you use the tables on your applications, you set the table as “database name’

+7.” + "table name”.

1 Relationship diagram

The relationship diagram in database is shown in fig.1

t_place t_comment t_user

o placeid int(11) auto_increment o commentid int(11) auto_increment —|~ o userid int(11) auto_increment
placename varchar(60) o placeid int(11) (FK) 1 mailaddress varchar(60)
placename_en varchar(60) nuserid int(11) (FK) }()— 0 password varchar(30)

o latitude double createtime datetime

0 longitude double comment varchar(200)

likecount int(11)
address varchar(60) )
phonenumber varchar(60) t_like

remark varchar(120) puserid int(11) (FK)
projectcode varchar(5) i placeid int(11) (FK)

1 Relationship diagram
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2 Database table Specification

2.1

Place information table

This table stores information related to the place, e.g. the place name, latitude,

longitude, and etc.

Table name | t_place
Item Column name Data type PK | NOT Remarks
NULL
Place ID placeid Int O O Auto-increment
Place name placename Varchar(60)
Place name | placename_en | Varchar(60)
(English)
Latitude latitude Double O
Longitude longitude Double O
Like counts likecount Int Default sets ‘0’
Address address Varchar (60)
Phone number | phonenumber | Varchar (15) Do not have to
include Hyphen
Remark remark Varchar (120)
Project code projectcode Varchar (5) Sample program
uses “JPN00”
2.2 User table
This table stores user registration information.
Table name t_user
Item Column Data type PK | NOT Remarks
name NULL
User ID userid Int O O Auto-increment
Mail address mailaddress Varchar (60) O
Password password Varchar (30) O
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2.3 Comment table

This table stores the comment registered each place.

Table name | t_comment
Item Column Data type PK | NOT Remarks
name NULL
Comment ID commentid Int O O Auto-increment
Place ID placeid Int O
User ID userid Int O
Comment date | commenttime datetime
and time
Comment text comment Varchar(200)

2.4 Like count manage table

This table manages the Place ID and the user who made the vote by ‘Like’ button.

Table name | t_like
Item Column Data type PK | NOT Remarks
name NULL
Place ID placeid Int O O
User ID userid Int O O
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0. F—5L L7 72 URL OBEIZ- DWW T
M7l NClX, YU TAHEEGED TTHODOT 78R (F—L0) I TH
LA, T 72 URLIZLLTO®EY 705,

No. | F—24% FIHE A

1 sample (> 7 /L) | http://(IP 7 K L A) [sample/PHP 4 .php
2 Team A http://(IP 7 K L A) /team_a/PHP 4 .php
3 Team B http://IP 7 K L A) /team_b/PHP 4 .php
4 Team C http://IP 7 K L A) /team_c/PHP 4 .php
5 Team D http://IP 7 K L &) /team_d/PHP 4 .php
6 Team E http://(IP 7 K L R) /[team_e/PHP 4 .php
7 Team F http://(IP 7 KL A) /[team_{f/PHP 4 .php
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er
{4 remark
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Interface specifications between server and Android

0. Relation between the team name and accessing URI

No. | F—2% FI I

1 sample http://(IP address) /sample/PHP command.php
2 Team A http:/(IP address) /team_a/PHP command.php
3 Team B http:/(IP address) /team_b/PHP command.php
4 Team C http://(IP address) /team_c/PHP command.php
5 Team D http://(IP address) /team_d/PHP command.php
6 Team E http://(IP address) /team_e/PHP command.php
7 Team F http://(IP address) /team_f/PHP command.php

1. Messages

Messages between server and mobile phone are shown in Table.1.

Table 1. Messages between server and Android

Message Transfer Function
Protocol
Search place HTTP Search the registered place information by place
information name
Register place HTTP Register place information from client
information
Delete place HTTP Delete place information from client
information
Register user HTTP Register user information
information
Delete user HTTP Delete place information
information
Search comment HTTP Search comments of the particular place
information
Register HTTP Register a comment to the place information
comment
Delete comment HTTP Delete a comment of the particular place

information
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2. Message specifications

The function of request from an android device use HT'TP post method.

The response from the server is made of HT'TP response header and body with

JSON format.

2.1

Set keyword and throw the request to server. Then get the place information data

which are only matched data on the database field. If you set blank on keyword then

Search place information

you get all place information data.

ORequest of “Search place information”

Protocol HTTP POST request
URL http://mail.tym-bit.com/SearchPlace.php
Parameters Attr.ID Note

Keyword text keyword | The keyword to search from place name field
on the table.
If Keyword is blank then you get all data on
the table.

Project code pj_code | Set fixed project code for your project.

OResponse of “Search place information” (Normal)

Format HTTP response header + body with JSON object
Status code 200 (OK)
JSON object Attr.ID Note
Number of data count Number of result
Array of place data JSON object array of the place information
information as follows:
Place information Attr. ID Note
Place ID placeid Unique key of this data
Place Name placename | Place name in local language
Place Name placename_ | Place name in English
(English) en
Latitude latitude Latitude of this place

MEXT 2015 project Interface specifications
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Longitude longitude | Longitude of this place
Number of Like likecount | Number of Like that users clicked
Address address
Phone phonenumb
er
Remarks remark
Project code projectcode | The fixed unique value of each project

OResponse of “Search place information” (Error)

Format

HTTP response header + body with JSON object

Status code

500 (Internal Server Error)

JSON Object Attr. ID Note
Error code errcode Error code is occurred in MySQL
Error message message | Error message text from MySQL
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2.2  Register place information

Add a new place information to database

ORequest of “Register place information”

Protocol HTTP POST request
URL http://mail.tym-bit.com/AddPlace.php
Parameters Attr. ID Note

Place name

placename Place name in local language

Place name

placename_en | Place name in English

Latitude latitude (mandatory)
Longitude longitude (mandatory)
Address address (optionally)

Phone phonenumber | (optionally)
Remarks remark (optionally)

Project code

projectcode The fixed unique value of each project

OResponse of “Register place information” (Normal)

Format HTTP response header + body with JSON object
Status code 200 (OK)
JSON object Attr. ID Note

Place ID placeid Place ID is created automatically

OResponse of “Register place information” (Error)

Format

HTTP response header + body with JSON object

Status code

500 (Internal Server Error)

JSON object

Attr. ID

Note

Error code

errcode Error code is occurred in MySQL

Error message

message | Error message text from MySQL

MEXT 2015 project Interface specifications
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2.3 Delete place information

Delete a place information with Place ID parameter.

ORequest of “Delete place information”

Protocol HTTP POST request
URL http://mail.tym-bit.com/DeletePlace.php
Parameters Attr. ID Note
Place ID placeid Place ID of the target place information

OResponse of “Delete place information” (Normal)

Format

HTTP response header

Status code

200 (OK)

OResponse of “Delete place information” (Error)

Format

HTTP response header+JSON object

Status code

500 (Internal Server Error)

JSON object Attr. ID Note
Error code errcode Error code is occurred in MySQL
Error message message | Error message text from MySQL

MEXT 2015 project Interface specifications
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2.4 Register user information
Web Server checks duplicated mail address. If there are same mail addresses, web

server returns error.

ORequest of “Register user information”

Protocol HTTP POST request
URL http://mail.tym-bit.com/UserRegistration.php
Parameters Attr. ID Note
Mail address mailaddress
Password password

OResponse of “Register user information” (Normal)

Format HTTP response header+JSON object
Status code 200 (OK)
JSON object Attr. ID Note
User ID userid User ID is created automatically

OResponse of “Register user information” (Error)

Format HTTP response header+JSON object
Status code 500 (Internal Server Error)
JSON object Attr. ID Note
Error code errcode Error code is occurred in MySQL
Error message message | Error message text from MySQL

MEXT 2015 project Interface specifications
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2.5 Delete user information

Web server deletes user data from database.

ORequest of “Delete user information”

Protocol HTTP POST request
URL http://mail.tym-bit.com/DeleteUser.php
Parameters Attr. ID Note
User ID userid

OResponse of “Delete user information” (Normal)

Format

HTTP response header

Status code

200 (OK)

OResponse of “Delete user information” (Error)

Format

HTTP response header+JSON object

Status code

500 (Internal Server Error)

JSON object Attr. ID Note
Error code errcode Error code is occurred in MySQL
Error message message | Error message text from MySQL

MEXT 2015 project Interface specifications
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2.6 Search comment
" Get comments of the particular place information. Comment data sequence is sorted

by entry date in descending order.

ORequest of “Search comment”

Protocol HTTP POST request
URL http://mail.tym-bit.com/SearchComment.php
Parameters Attr. ID Note
Place ID placeid Place ID for getting comments

OResponse of “Search comment” (Normal)

Format HTTP response header+JSON object
Status code 200 (OK)
JSON object Attr. ID Note
Number of data count Number of result
Array of comment data JSON object array of the comment data as
data follows:
Comment data Attr. ID Note
Place ID placeid
User ID userid User ID of commented
Comment Date and | createtime
Time
Comment Text comment

OResponse of “Search comment” (Error)

Format HTTP response header+JSON object
Status code 500 (Internal Server Error)
JSON object Attr. ID JSON object
Error code errcode Error code
Error message message | Error message

MEXT 2015 project Interface specifications
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2.7 Register comment

Add a new comment to particular place information.

ORequest of “Register comment”

Protocol HTTP POST request
URL http://mail.tym-bit.com/AddComment.php
Parameters Attr. ID Note
Place ID placeid The place ID adding comment
User ID userid
Comment date createtime
and time
Comment text comment

OResponse of “Register comment” (Normal)

Format HTTP response header+JSON object
Status code 200 (OK)
JSON object Attr. ID Note

Comment ID

commentid | Comment ID is created automatically

OResponse of “Register comment” (Error)

Format

HTTP response header+JSON object

Status code

500 (Internal Server Error)

JSON object Attr. ID JSON object
Error code errcode Error code
Error message message Error message

MEXT 2015 project Interface specifications
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2.8 Delete comment

ORequest of “Delete comment”

Protocol HTTP POST request
URL http://mail.tym-bit.com/DeleteComment.php
Parameters Attr. ID Note
Comment ID commentid

OResponse of “Delete comment” (Normal)

Format

HTTP response header

Status code

200 (OK)

Oz A v MREISE (R

Format

HTTP response header+JSON object

Status code

500 (Internal Server Error)

JSON object

Attr. ID

JSON object

Error code

errcode Error code

Error message

message | Error message

MEXT 2015 project Interface specifications
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Target Android API Version

Android 4.4.2
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Google Maps Android API v2
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[3.Android Studio D1 > A h—J)V| TUERY T NI =2T %A A=V 1,

Yo INTa T T DA A=

(TR 5.
<FEE>

5. Android =X =2 L— X DOfERK] TY 7 b=
TOREEITI FI-A v A M—T5 Y7 k7= 7 (32bit il )z X, 64bit iR)iX. CD-R

VEET 4 L7 MY TC:¥Android Work] 1IH 50 UO/EMR L TR Z &,

-116-




Java Development Kit (JDK) ®A A f—/L
2.1 TE2® URL #f<,

http://www.oracle.com/technetwork/java/javase/downloads/index.html

2.2 VEEFRrORF/N— 3 v (KFIEETIX 8u60) TD . JDK » [DOWNLOAD |
Vw95,

e [ http://www.oracle.com/technetwork /javal @ + & H [=) Java SE - Downloads | ... x ‘ ‘
~
Sign In/Register Help Country ~ Communities ~ lama v lwantto_ ~ | Search Q
Products Solutions Downloads Store Support Training Partners About |[OTN]
Cracle Technology Network Java > JavaSE > Downloads
Java SE ‘ Overview | Downloads ‘ Documentation ” Community H Technologies H Training Java SDKs and Tools
Java EE L
Java ME Java SE Downloads # Java EE and Glassfish
Java SE Support # Java ME
Java SE Advanced & Suite p, % Java Card
§ =
Java Embedded <) - & NetBeans IDE
=’ Java 7 NetBeans A—
Java DB = & Java Mission Control
Web Tier
[ oomnuono | [ ooworns | dava Resurces
e Ji Platform (JDK) 8ug0 NetB: with JDK & # dava APls
lava Platform ut etBeans
Java TV & Technical Articles
Hew fo Java [ Java ’ Edition & Demos and Videos
‘Community Java SE 8ug0 & Forums
Java Magazine This releases includes support for ARMv3 processors, Nashorn enhancements, and _ .
improvements to Deployment Rule St functionality. ¥ Java Magazine
JOK for ARM releases are now available on the same page as the downloads for other platforms. 5 Javanet
Learn more + = -
& Developer Training
- Installation Instructions JOK & Tutorials
iz | ;
« Release Notes # Java.com
- Oracle License
- Java SE Products Server JRE > JavaOne
« Third Party Licenses
« Certified System Configurations
- Readme Files
+ JDK ReadMe JRE
[oowmicnn ] |
- JRE ReadMe
October 25 - 29, 2015 v
Qo Eenmmiern 1€
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2.3 [Accept License Agreement] #7 = v 27 L, [Windowsx86] £D~7 7 A
NHET Y v 7 LTH Y ya— RERGT 5,
(OS 78 64bit DA . [Windows x64] MH AU — K9 5)

=8 EeR =)
& @ [ ttp://wwvrw.oracle.com/techetwork java/, O ~ & |[ /) Java SE Development k... x ‘ ‘ AN
~
Sign In/Register Help Country v Communities v lama._ v lwantto . v | Search Q
Products Solutions Downloads Store Support Training Partners About |[OTN
Oracle Technology Network > Java > Java
Java SE [(Ovenview || Downloads || Documentation || Communtty || Technologies |[ Traiing gaxaspicsandiion’s
Java EE § Java SE
Java ME Java SE Development Kit 8 Downloads
Java SE Support Thank you for downloading this release of the Java™ Platform, Standard Edition Development Kit
Java SE Advanced & Suite (JDK™). The JOK is a i t for building applications, applets, and p & Java Card
using the Java pregramming language. _
Java Embedded & NetBeans IDE
Java DB The JDK includes t_uo\s useful for developing and testing programs written in the Java programming & Java Mission Control
g language and running on the Java platform
Wb Tier s 150t Java Resources
Java Card 88 also s
R « Java Developer Newsletter (fick the checkbox under Subscription Genter > Oracle Technology § Java APls
Java Ty News) Technical Articles
hew to J . v
ew to Java Java Developer Day hands-on workshops (free) and other events Demos and Videos
Ct it .
: wmlr:mtv Java Magazine & Forums
ava Magazine
9 JDK 8u60 Checksum & Java Magarine
= & Java.net
Java SE Development Kit 8u60 = _
You must accept the Oracle Binary Code License A it for Java SE to this & Developer Training
Tutorials
Accept nse Agreement Decline License Agreement
Proi Download
Linux ARM vEN7 Hard Float ABI 77.60 MB  jdk-8uE0-linux-arm32-vip-hfit tar. gz
Linux ARM v8 Hard Float ABI 7464 MB _ jdk-8uB0-linux-armB4-vip-hiit tar gz
Linux x86 154.66 MB  jdk-BuB0-linux-i586.rom
Linux x56 174.83MB  jdk-3uB0-linux-i536.1ar.gz
Linux x64 152.67 MB  jdk-8u60-linux-x64.rpm
Linux x64 172834 MB  jdk-8u60-linux-x64 tar.qz
Mac OS X x64 227.07 MB___ jdk-8uB0-macosx-x64.dmg
Solaris SPARC 64-bit (SVR4 package) 139.67 MB _ jdk-8uB0-solaris-sparcvd.tar.Z
Solaris SPARC 64-bit 99.02MB  jdk-3uS0-solaris-sparcvd.tar.gz
Solaris x64 (SVR4 package 140.18MB  jdk-Bu6D-solaris-x64.tar Z
o207 (SVRe package) . ; Octobar 25 - 29, 2015
Winoows %86 180.82 MB _ |ak-BUB0-WINCowS-I586 exe San Francisco, U.S. v
[Windows x64 186.16 MB _ jdk-8uB0-windows-x64.exe
Reaister Now b}
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14 1ava SE Development Kit 8 Update 60 (64-bit) - 7w 7w ==

Java SE Development Kit 8 Update 80004 22 b= )l-ryH —Ea b3l F

Zre o — BT, Java SE Development Kit 8 Update 6000 = A F—1- X0 A %E%E
<TERBALE S,

Java Mission Control 70774 V- A B LUSERRY =)L - 2 — HT, DKD—BBr LT AFTE
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14 1ava SE Development Kit 8 Update 60 (64-bit) - =T [
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3  Android Studio ®-f > A h—JL
3.1 T URLAZ7Z7vu¥TR<L,

http://developer.android.com/intl/ja/sdk/index.html

& ] http r.android.com/intl /ja/sdk/it © ~ & ” Download Android Studi... » ‘ |
~
Developers B% @ B Developer Console Q |
FL—=u%  APIHAL

Download A ;

/

Android

Installing the SDK N ~ 1 U
Adding SDK Packages

+ Android Studio IDE
Android Studio

+ Android SDK tools
Workflow + Android 6.0 (Marshmallow) Platform

+ Android 6.0 emulator system image
TooleHelp with Google APls
Build System
Peformance Tools
Testing Tools
Support Library
Data Binding Library

- g to Android Studio
Revisions 9
+ Take a Survey

NDK ™

3.2 Mm% A7 a—,L LT [android-studio-ide-141.2178183-windows.zip] %7 U v
7?‘60

( randroid.com/intl/ja/sdk/it O ~ & H Downlead Android Studi... ‘ ‘
. " ~
Developers B > W=l > D Q|
All Android Studio pﬂCkageS B Developer Console
Download
Select a specific Android Studio package for your platform. Also see the Android Studio release notes
Installing the SDK
N
Adding SDK Packages
Windows android-studio-bundle- 1136982712 ©7d39c529dd434489da9d086ff689d34dc791526
Android Studio o 141.2178183-windows.exe bytes
(Recommended)
Workflow N android-studio-ide- 321810248 b5d12aa000729c03a3¢f9B0add79d1b93121c56d
141.2178183-windows.exe bytes
Tools Helj v
eelener (No SDK tools included)
Build System ~ android-studic-ide- 344424713 31341226b5f3¢374d4fc2d9cff03a4458101d69
141.2178183-windows.zip bytes
Peformance Tools v
MacOSX  android-studio-ide- 368335367 75b67eb15a34a152a40e7189484ab0ebc375b877
Testing Tools B 141.2178183-mac.dmg bytes
Linux android-studio-ide- 352010593 cf780413f8c8223eb348bd27¢19a9c04b7 5eaeb?
Support Library > 141.2178183-inux.zip bytes
Data Binding Library
Revisians ~ | Getnews & tips Blog Support @ & W
NDK
Eclipse with ADT v | Beerta et sedunder Creative Aibution 25 Forde “
_ _ v
About A A e o 2
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3.3 WMELRHEAICF =y 7% LT IDOWNLOAD
ANDROID-STUDIO-IDE-141.2178183-WINDOWS.ZIP| #2 V v 7§ %,

E=N Eol ==
g@‘ http://developerandroid.com/intl/ja/sdk/in 2 + & H Download Android Studi... x ‘ ‘ AN
5 L ~
|'| Developers Wit M3 Em B> Developer Console Q,
bL—=4 AP HTE 7L A V= Google Services Samples Preview
== Download
Installing the SDK
Before installing Android Studio or the standalone SDK tools, you must agree to the following terms and conditions
Adding SDK Packages
of this License Agreement. This License Agreement forms a legally binding contract between you and Google in ~
Android Studio " relation to your use of the SDK
Workflow v 1.2 "Android" means the Android software stack for devices, as made available under the Android Open Source
Project, which is located at the following URL: http://source.android.com/, as updated from time to time.
Tools Help v
1.3 "Google” means Google Inc., a Delaware corporation with principal place of business at 1600 Amphitheatre
Build System v Parkway, Mountain View, CA 94043, United States
Peformance Tools v
Testing Tools . 2. Accepting this License Agreement
Support Library v 2.1 In order to use the SDK, you must first agree to this License Agreement. You may not use the SDK if you do not
accept this License Agreement.
Data Binding Libs
a Binding Library )
2 By nlinking t nt 1 harahv anraa tn tha tarme of thic | iran.
Revisions ~
| have read and agree with the above terms and conditions
NDK
DOWNLOAD ANDROID-STUDIO-IDE-141.2178183-WINDOWS.ZIP
Eclipse with ADT v v

34 zip 77 ANDE T a— RBBABIND DO TR L, fREEZ1TH,
BB T + v Z1% [TC:¥Android Work¥| &35,

Xzip 7 7 A NAP W E RIS &
Ty ANNRANEL RV TEC T —DRETHZOEETHZ &
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3.5  [C:¥Android Work¥android-studio¥bin¥studio.exe| % 3F{T L. Android
Studio Z #LE)9 5,
(OS 73 64bit D4 .  [studiobd.exe| & FEITT5)

=8 e =)
@Qv‘ « android-studio » bin » - ‘&,‘ ‘ binteR p|
EE v B< =i=snta) LI — b @
e BRICAD & ’ =Y
B g 0-F . lidb 2015/09/03 9:29 F7 AN TA .
SRSy [] appletviewer.policy 2015/08/16 0:36  POLICY J7-f)L
W SEEFUSR %) breakgen.dil 2015/08/19 0:36 ~ FFU&r—
%] breakgens4.dll 2015/08/19 0:36  FFUsr—
2] focuskillerdll 2015/08/19 0:36 7 U4 —
& F1I5Y 2 focuskallersa.dll 2015/08/19 0:36  FIUL—
(=)} Subversion 7] fenotifier.exe 2015/08/190:36  FTUL—
H FFaxyb || idea.properties 2015/08/19 0:36
Fl=rad %) TdeaWin32.dll 2015/08/19 0:36
B e %] TdeaWine4.dIl 2015/08/19 0:36
S Ea-zus %] jumplistbridge.dll 2015/08/19 0:36
%] jumplistbridges4.dll 2015/08/19 0:36
e ] log.xml 2015/08/19 0:36
= =] restarterexe 2015/08/19 0:36
& 0s(c) =7 runnerw.exe 2015/08/15 0:36
| = studio.exe 2015/08/19 10:37 FFU&—
€ 7y hO—2 |_| studio.exe.vmoptions 2015/08/19 0:36  VMOPTIONS ...
studio.ico 2015/08/190:36 P21
studiobd.exe 2015/08/19 10:42 FIFUF—232
|| studiob4.exe.vmoptions 2015/08/19 0:36 VMOPTIONS 7...
[ vistalauncher.exe 2015/08/19 0:36 FIUL—23
< . ] r

studio.exe EgERE: 2015/08/19 10:37  {EELEE: 2015/09/03 9:29
) TFIUL—3> SA:873KB

3.6 T do not have a previous version of Studio or I do not want to import my
settings| (Z®IRL., [OK| #7 Vv 775,
[ ® Complete Installation ﬁw

You can import wour settings from a previous version of Studio.

0 Tweant to import my settings from a custom location

Specify config falder ar installation home of the previous version of Studio:

@ {dn not have a previous version of Studio or Tdo not want to import my settines
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3.7 [Next] 27V v79%,

r
# Android Studio Setup Wizard o

Welcome

Android Studio

‘Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studic
or create a new Android application project.

3.8 [Standard] Z#ER L., [Next] 27V v 735,
) Android Studio Setup Wizarc T — | - A |

H Install Type

Choose the type of setup you want for Android Studio:

© standard
Android Studie will be installed with the most common settings and options.

Recommended for most users.

(O Custom
You can customize installation settings and components installed.
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3.9

[Finish] #27 Vv 735,

® Android Studio Setup Wizard - e

H Verify Settings

If you want to review or change any of your installation settings, click Previous.

Current Settings:

Setup type:
Standard

Destination Folder:
C:¥Users¥kuroda¥AppData¥l ocal¥Android¥Sdk

Total Download Size:
806 MB

Sdk Components to Download:

| Android SDK Build-tools, revision 23.0.1 36.8 MB
Android SDK Platform-tools, revision 23.0.1 2.29 MB
Android SDK Tools, revision 24.3.4 179 MB
(e [ ] [ (I
3.10 [Finish] #7 VU v 79 %,
'@ Android Studio Setup Wizard - e -

H Downloading Components

Installing Google Repository, revision 21
Installed Goozle Repository, revision 21
Installing Android SDK Platform-tools, revision 23.0.1
Stopping ADB server failed (code -1).
Installed Android SDE Platforn-tools, revision 23.0.1
Installing Sources for Android SDE, API 23, revision |
Installed Sources for Android SDK. AP 23, revision i
Installing Google APIs Intel =86 Alom System Imsge, Goozle Inc. API 23, revision 7
Installed Google APIs Intel xB6 Atom Svsiem Imaze, Goozle Inc. API 23, revision 7
Installing Android SDK Tools, rewision 24.3.4
Installed Android SDK Tools, revision 24.3.4
Updated ADB to support the USB devices declared in the 3DK add-ons.
Stopping ADB server succeeded.
Starting ADE server succeeded.
Done. 9 packages installed.
Android SDE is up to date.
Creatire Android wirtual device
Android wirtual device Mexus 5_APT_23% xBF was successful ly created

BTl =)

[Forer] [ ) [
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YN Ta ST ADA R — b
4.1 [C:¥Android Work¥| (V77 a7 T AEEEL TEL,

b

:Eg

@Ov| Loy j“/k:'l—&t » O5(C:) » Android_Work »

~ 4| [ androic_workotz= 2|

2B - SAJSUCEN v

SFAG FHLLWITAILS -

= 0 @

W BRICAN
g F0—F
W FAG by
] BEFRUISER

o SA75u
Subversion
ERC=eas
B EoFr
= Rz
’ 2 @mEs

£

ExEk = X

2015/09/10 16:23 _ J7 1) TA)L...

._android-studio
I |, MapApplication

2015/09/10 17:08  J7-)L Tl I

4.2  TOpen an existing Android Studio project] =72 U v 27 3%,

# Android Studio Setup Wnﬁh —

Recent Projects

¥

Welcome to Android Studio

Quick Start

Start a new Android Studio project

Open an existing Android Studio project

= ey
o &

D & & «

]

Import an Android code sample

Check out project from Version Control

Import project (Eclipse ADT, Gradle, etc.)

Configure

Docs and How-Tos

Android studio 1.3.2 Build 141.2178183. Check for updates now.
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4.3 [MapApplication] #i®EIRT 5,

1 3b1bdb370d3ad804e621c180
[ 4939e977b83147F2793
7 Android_Work
[ android-studio

I # MapApplication I
3 Apps
7 bat
[ Bit_sefiE
3 dell
[ Drivers
[ Intel
[ Legs
[1 necps

-
# Open File or Project A M
aCo® kX O 68 Hide path
‘C:¥U5er5 ‘
IC¥

Drag and drop a file into the space above to quickly locate it in the tree.

o JEE

4.4 BT 5 SDK O/S ANTEAE LR WL S 24 A8

OK] #7 VU v 795,

-
# Sync Android SDKs

S5

x)

The path

'Cr¥lsers¥ucm¥AppData¥local ¥Android¥Sdic

does not belong to a directory.
Android Studio will use this Android SDK instead:

'Cr¥Users¥kuroda¥AppData¥local¥Android¥Sdk’
and will modify the project's local.properties file.
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4.5  [Install Build Tools 23.0.0 and sync project] %7 U v 7 35,

File View Navigate Code Analyze Refactor Build Run Teools VCS Window Help
DEHO ¢4 6000 QRA & > | W[(Fapp- P ¥ B @ ¢RI w&

[ com ) B example ) B] MapApplication } (€) DisplayDetail Activity

smalold L2sep] 3

[4ii local.prope

31pein (3

@ Captures =l 7: Structure

Messages Gradle Sync
v Failed to sync Gradle project "MapApplication’

© O ol Buidl Tooks 23.0.0 and sync project

I« & i

¥+ 2: Favorites 4 Build Variants

5 TODO i &: Android Terminal _ " Eventlog  [S] Gradle Console
Gradle sync failed: failed to find Build Teols revision 23.0.0 // // Consult IDE log ... (moments ago) n/a | nfa |Context: <no context= w8

46 ENRY—=NLDA L AR=ANET LS [Finish] #27V v 7935,

SDK Quickdfix Inst:
A - — —— -~

Installing Requested Components

SDK Path: Ci¥Users¥kuroda¥AppData¥local¥Android¥Sdk

Loading SDK information...

Installing Archives:
Preparing to install archives
Installing &ndroid SDK Build-tools, revision 23.0.0 {Obsolete)
Unzipping Android SDK Build-tools, revision 23.0.0 (Obsolete) (28} Unzipping Android SDK Build-tools. revision 23.0.0 (Obsolete) (43) Unzipping Android SDK Build-tools
Done. 1 packaze installed.

Done

iPreviDusl[ Next II Cancel I

_— _— -—

12
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5 Android = I = L — % O1ERL

5.1

5.2

1
S oraarks) v rT5h,

[Launch Standalone SDK Manager| =7 U v 7 4%,

/# Default Settings

(a

) Appearance & Behavior > System Settings > Android SDK

Appearance & Behavior
Appearance
Menus and Toolbars

System Settings

Passwords Each Android SDK Platform package includes the Android platform and scurces pertaining to an API
HTTP Broxy level by default. Once installed, Android Studio will automatically check for updates. Check "show
package details" to display individual SDK components.
Updates
) | Name | API Level | Revision | Status
Usage Statistics Android 6.0 (Marshmallow) 23 1 Installed
[] Android 5.1 (Lollipop) 22 2 Not installed
Notifications [_] Android 5.0 (Lollipop) 21 2 Not installed
Quick Lists [] Android 4.4 (Kitkat Wear) 20 2 Mot installed
Keymap [C] Android 4.4 (KitKat) 19 4 Mot installed
X [C] Android 4.3 (Jelly Bean) 18 3 Not installed
Bl [C] Android 4.2 (Jelly Bean) 17 3 Not installed
Plugins [C] Android 4.1 (Jelly Bean) 16 5 Not installed
Build, Execution, Deployment [C] Android 4.0.3 (IceCreamSandwich) 15 5 Mot installed
Tools [ Android 2.3.3 (Gingerbread) 10 2 Not installed
[ Android 2.2 (Froyo) 8 3 Mot installed

Manager for the Android SDK and Tools used by Android Studio

Android SDK Location: |C:¥User5¥kuroda¥AppData¥Lcn:aI¥Android¥sdk | -

SDK Platforms ‘ SDK Tools | SDK Updata Sites |

[_] Show Package Details

I Launch Standalone SDK Manager I

I (o] (] [

13
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53 PBAWLED 4 FUO—RKNG FRLD 3 DICF = v 7 % LT nstall 3
packages...| &7 U v 735, KDBENDLTZ0, MIZTF = v 7B A>T
TeHaldiE LTk <,

- Android 4.4.2 (API 19) - Google APIs (x86 System Image)
+ Android 4.4.2(API 19) — Google APIs (ARM System Image)
- extra — Intel x86 Emulator Accelerator (HAXM installer)

| 3 Android SDK Manager — 0 O—— p— [Elﬂlg

Packages Tools

SDK Path: C:¥Users¥kuroda¥AppData¥Local¥Android¥Sdk

Packages
iE Name API Rev. Status -
4 [ 2 Android 4.4.2 (API 19)
[7] 'y SDK Platform ] 4 || Not installed
[ X Samples for SDK 19 6 [ | Not installed
[] m® ARM EABI v75 System Image 19 3 [l wot instafled
LB [0l 55 Al Susiem age 183 Notinsgled
1751 Google APIs (x86 System Image) 19 15 || Not installed =
751 Google APIs (ARM System Image) 19 15 [ Not installed |4
|1 55 Glass Development Kit Preview 19 11 || Not installed
[[] [[1] Sources for Android SDK 19 2 || Not instafled

> [[] Bz Android 4.3.1 (APT 18)
> [ Bz Android 4.2.2 (API 17)

Show: Updates/MNew Installed Select New or Updates Install 2 packages...

[7] Obsolete Deselect All Delete packages...

|
| Done loading packages.

[ oy Android SDK Manager —— 8 — — lﬂlﬂlg
Packages Tools
SDK Path: C:¥Users¥kuroda¥AppData¥Local¥Android¥Sdk
Packages
5 Name API Rev.  Status -
7] E3 Android Support Library 23.0.1 [ | Not installed
7] @ Android Auto Desktop Head Unit emulator 1 [|Notinstalled
7] &3 Google Play services 26 [ Not installed
[F] @ Google Repository 21 7 Installed
|| B3 Google Play APK Expansion Library 3 || Notinstalled
] 3 Google Play Billing Library 5 [ | Not installed
7] @@ Google Play Licensing Library 2 [|Not installed
] &5 Android Auto API Simulators 1 | Not installed
[] g Google USB Driver 11 [ | Not installed B
[ ﬁ Google Web Driver 2 | Not installed 2
I 3 Intel x86 Emulator Accelerator (HAXM instal 5.4 [ | Not installed I s
Show: [¥] Updates/New [¥]Installed Select Mew or Updates Install 3 packages...
[] Obsolete Deselect All Delete packages...
| o -
e ]
| Done loading packages.

14
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54 XA 7127 ® [Accept License] (ZF = v 7 & AL,

THEXA T a—REAL VA MDA EN D,

Choose Packages to Insta

Mnstall] 227V v 7

Packages

+" Android SDK License
«" SDK Platform Android 4.4.2, API
+" Google APIs (xB6 System Image
+" Google APIs (ARM System Imag
Intel Android Extra License
Y, Intel x86 Emulator Accelerator (1

[*] Sormething depends on this package

Package Description & License

Packages
- SDK Platform Android 4.4.2, API 19, revision 4

- Google APLs (xB6 System Image), Android APL 19, revision
15
- Google APIs (ARM System Image), Android API 19, revision
15

License
To get started with the Android SDK, you must agree to the
following terms and conditions.

This is the Android SDK License Agreement (the "License
Agreement”).

Accept Reject  Copy to clipboard | Prin]

Install l l Cancel

5.5 Status 7% [Installed) & 724U A > A h—/L5ETD7=%, Android SDK

Manager 7V 1 > K7 & Default Settings 7 1 > RUZFA L %,
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56 Spriarhkslosds.

5.7  [Create Virtual Device...] #Z7 VU v 794 %,

1 ancro il pevie ey e N

Your Virtual Devices !

Android Studio

Name |  Resolution | APL | | CPU/ABI|  Size on Disk | Actions |l

s

Target
Google APIs

Type |

@

Nexus 5 APT ... 1080 = 1920:... 23 %86 750 MB

-+ Create Virtual Device...

Next] #7 Vv 2735,
“ﬁ

5.8

[ * Virtual Device Configuration

[Galaxy Nexus] #iE{RL T,

T——
- o—— —

Select Hardware

definition

5.4" FWVGA

5.1" WVGA

5.4"

5.1"

MNew Hardware Profile ] [ Import Hardware Profiles

480x854

480x800

Category ‘ Mame ~ Size | Resolution | Density ‘
T Nexus S 4.0 480x800 hdpi
720px
Nexus One 37" 480x800 hdpi Size:  normal
Ratio:  long
Naxus 6 5.96" 1440x2560 560dpi Density. xhdpi
485" J1zs0px
Tablet Nexus 5 4.95" 1080x1920 xxhdpi
MNexus 4 4.7" 768x1280 xhdpi

mdpi

mdpi

Clone Device...
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5.9 [KitKat] ZERL T, [Next] 27V v 27925,
*Target 7% [Google APIs (x86 System Image) (Google Inc.)] ®H D

¥ Virtual Device COITﬁgIJEItIO-I'I'

System Image

A Select a system image

Release Name | APILevelv | ABL | Target ]
t Marshmallow 23 xB6 Google APIs (Google Inc.) - gocgle_api:

KitKat

KitKat 19 armeabi-v7a Google APIs (Google Inc.)
AFI Level

19

Android
44
Google Inc.

System Image
X86

Recommendation

Newer HAXM Version Available

Download and install HAXM

Questions on API level?

@ See the API level distribution chart

["] Show downloadable system images

5.10 [Show Advanced Settings] #7 UV v 735,

Android Virtual Device (AVD)

onfiguration
AVD Name Galaxy Nexus API 19 ] AVD Name
i
I Galaxy Nexus 4.65" 720x1280 xhdpi Cha
= . e The name of this AVD.
. Kitkat Google APIs (x86 System Image) (Google Inc.) x86
Startup size
and Scale: IAuto ‘
orientation
Orientation: D EI
Portrait Landscape
Emulated re (s @ Recommendation
performance MNewer HAXM Version Available
[ store a snapshot for faster startup Download and install HAXM
You can either use Host GPU or Snapshots
Show Advanced Settings
Lo [ | [ | (N

17
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511 BV XA 7 a ZJCUTORDBEVIZHREL, OKE 27V v o735,

FIZEPN TR WVEREHRBIZZEDOE LTI,

Use Host GPU

Checked

RAM

768

VM heap

256

SD Card

2 GB

Custom skin definition

HVGA

Enable keyboard input

Checked

# virtual Device Configuration

Android Virtual Device (AVD)

Verify Configuration

AVD Name Galaxy Nexus APT 19

AVD Td Galaxy_Nexus_API_19

[ Galexy Nexus 4.65" 720x1280 xhdpi
e

Google APIs (x86 System Image) (Google Inc.) x86

|| | Startup size
and Scale: |Autu n
i orientation
Orientation: D EI
Portrait Landscape

-
Hide Advanced Settings

# virtual Device Configuration

Android Virtual Device (AVD)

Verify Configuration

Emulated
Performance

Use Host GPU
[C] Store a snapshot for faster startup

You can either use Host GPU or Snapshots

and
R i

Internal Storage:

SD card:

Ceemine [ | ]
Device Frame Enable Device Frame
:Iﬁlt::ﬁnit\'on FvGA o D

How do I create a custom hardware skin?

Keyboard Enable keyboard input

Hide Advanced Settings

Mothing Selected

Recommendation
Newer HAXM Version Available

Download and install HAXM

‘ Pravious j | Next I l Cancel J

Nothing Selected

Recommendation
Newer HAXM Version Available

Download and install HAXM

‘ Previous j | Next I l Cancel J m
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5.12 Intel HAX O A1 > A h—)b
TFREO/SAIZEH 57 intelhaxm-android.exe”Z# F{TL TA A h—/L&Z1T 5,
BEROREHBIIETEDEE TR,

C:¥Users¥[—]¥AppData¥Local¥Android
¥Sdk¥extras¥intel¥ Hardware_Accelerated_Execution_Manager ¥

513 P 2200/ LTo I a LS RERICEDT S = & 2HRT 5.
M Android Virtual Device Manager E@g

Your Virtual Devices

Android Studio

T pe| Name | Resolution | API | Target |CPU,’ABI| Size on Disk | Actions

Mexus 5. 1080 x . 23 Google A.. x86 750 MB 7

=+ Create Virtual Device... @

& © 5554:Galaxy_Nexus_aPI_19 - e [

6 ( - o
A/~ \ 4

112 [3 4 |5 |6 |7 |s |9 [o |
o I [e & |7 [v julifo e
A ls [o e e [nly [k 1 |&
2z [xfe v e v m]. |e
ol ] ]

19
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514 > FN7va VT AEFITT H5EIE. A ==2—3—=)5 [Run -> Run ‘app’|
ZIRINT D,

DHO (¢  XBA QAR &> WP

3 MapApplication> napp> I:lsrc> (| ma|n> Bjava ) E

g Android -

(RN - A

» Caapp
(& Gradle Seripts

- (® build.gradle (Project: MapApplication)
v (3} build.gradle (Module: app)
1; (& settings.gradle (Project Settings)
@ [4it local.properties [SDK Location)
1
v
g
5
=
3
-]
2
c
5
3
| =
2
L]
4| android
E No Connected Devices n I Mo Debuggable Ap
il
*« ifi logcat | ADB logs +°| jll Memory -+*| il CPU + E
o
P 4: Run  ©® TODO [E Terminal =

Run selected configuration

un 'ap
& Debug ‘app’
¥% Run 'app’ with Coverage

[ Edit Configurations...
H Stop

Reload Changed Classes
Step Over

Force Step Over
Step Into

Force Step Into
Smart Step Into
Step Out

My Run to Cursor

My Force Run to Cursor
%s Drop Frame

Il Pause Program

[v e 2 e | |l

- Resume Program

B Evaluate Expression...
Quick Evaluate Expression
k= Show Execution Point

Toggle Line Breakpoint
Toggle Method Breakpoint
Toggle Temporary Line Breakpoint
Toggle Breakpoint Enabled
@: View Breakpoints...

-135-

Shift+F9

Alt+Shift+F10
Alt+Shift+F9

Ctri+F2

F8
Alt+Shift+F8
F7
Alt+Shift+F7
Shift+F7
Shift+Fg
Alt+F9
Ctrl+Alt+F9

Fo

Alt+F8
Ctrl+Alt+F8
Alt+F10 #- L

Ctrl+F8

| application H
Ctrl+Alt+Shift+F8

[Z] Gradle Console

Ctrl+Shift+Fg 10 CONEEXE> | @

20
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AT BDDFATEREIZOWNT

1.1 ZOVAT AL, T ReAf RmRkEo7 7V r—varvd f U0 ¥—Fy
k RlckEEE & 7= Web(PHP) + Database(MySQL) W — /N2 K- TIHEIT X
o, 770 —va b Web —3[liZ, HTTP BENMEH S5,

1.2 FIHEBEBOWHINZA—=ILT RV RAEMEHAT S, A—LT RLAIYST Y r—
Va rOPHIREIRICOREE L, B TEETAZ KRS, TR TU—F
B AT RLRE—HIEHT D,

1.3 UTRTLEZFIHTHT V FoaA RiERIL, ®ISA ¥ —F v MO R
AEEWIFIRLTEE) T U r— a v 52 E7TAE42FHE LT 5,

Application

Apache
Web
Server

# 6.3 — B

0S CentOS ver6.5 (64bit)
IP addresses Global IP: 114.179.41.91
Bit Datacenter P Port No: 80, 443, 22
Local IP: 192.168.200.150
System XAMPP for Linux ver 1.8.3
Database MySQL ver5.6.20
phpMyAdmin ver 4.2.7.1
Web Server Apache ver 2.4.10
Server side script PHP ver 5.5.15 & PEAR

21
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7. Google Maps Android API v2 & — D 5

WEAFIEZEmM L2 THLEW, 77U r—2 9 URNIEFICENEL TWDICH D

P HIKNETR SNRWIEEIZHMT 5,

7.1 Google Developer console (https:/console.developers.google.com/) % B & |

TRA—NLT RLRAEZASHLT, Wk~ 227U 735,
« A—)LT KL A mext2014001@gmail.com

e@‘ G https://accounts.googlec... O - @ ¢ H G 04> - Google ZA7... % ‘ ‘

[-=-|-&-] ]
AR

Google

Google A /TOS A

mext2014001@gmail com| X ‘

HEUVDEE

ThIUk1 DTERTD Google H—E R%,

7.2 TRANAU—REZEANLT TarAv) 270735,
+ Pass: Bit2014@mextproject

e@‘ G https://accounts.googlec... O - @ ¢ H G 04> - Google ZA... % ‘ ‘

[-=-|-&-] ]
) o £

Google

Google 777 TOS A7

MEXT Project
mext2014001@gmail.com

.-c.c--cc.o--co.-..‘ L)

EEYOES

ThIoUk 1 DTETRTD Google H—E X%,
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7.3 MmALD [APIs & auth] %#BiZ%, [Credentials] #7 U v 7 3%,
)

m}) © https://console.developers.google... O~ @& & ” {Q Home - My Project X ‘ ‘ {53 653
) Google Developers Console My Project ~ Sign up for a free trial. ) 9o O ‘
Home Project: My Project APIs Google Cloud Platform status 7 A
Permissions
ID: big-bliss-713 Requests (requests/sec) @ Al services narmal v
APls & auth
=2 (#755654803736) v
APls
1 News
Explore other services
Push 08
o e Push Google Cloud origin content
i API  Enable Google APl for your : out to your users with CON
Source Code app 04 Interconnect
Deploy & Manage 0.2 Google Cloud Platform - 18 hr
N blog ago
Bl 0eploy a prebuilt solution .
Compute Sep 10, 3:45 PMSep 10, 4:45 PM
Networking _ Compute Engine Preemptible VMs
Storage @+ Deploy a Hello World app [ Requests: 0 are now Generally Available
: Google Cloud Platform - 1 day
BigDatz {2F Take a VM quickstart blog ago
= Create a Cloud Storage Cloud Spin Part 1: 180-degree
bucket animations on Google Cloud

Platform

Google Cloud Platform - 2 days
blog ago v

7.4 TAdd Credentials] #7 VU > 27 L, T[APIkey| %i%{R7 %,

m}) © https://console.developers.google... O ~ & & H D Credentials - My Project % | | AN
Q Google Developers Console My Project + Signup for a free trial. ) 9o O ;
Home Credentials QAuth consent screen ~
Permissions
APls & auth Add credentials ~
APls APl key
Credentials Identifies your project using a simple AP key to check quota and access.
For APIs like Google Translate
Push
o OAuth 2.0 client ID
Monitoring Requests user consent so your app can access the user's data
Source Code For APls like Google Calendar.
Deploy & Manage Service account 313fhgiViZaQ-L3WIMMYI
Compute Enables server-to-server, app-level authentication using robot accounts.
For use with Google Cloud APls UUGVppxKySR-TALSZmICSe
Networking
Storage 'ty Jun 18, 2015 Browser AlzaSyB54bYUszu8QxdQIKHoeUVD1SW20ZNj_7U
BigD Browser
ig Data key 2
Android May 20, 2015 Android AlzaSyCCWck8FUrgwGwfJ0-pfOcénaY¥sQKP1ZHk
key 41
Android May 13, 2015 Android AlzaSyBbHQC2igVOEnI2icc90KT_jbuDYYXSFWg
key 40
Android  May 13,2015 Android AlzaSyBYEydYaERICFvC3TUiNgeySqLyL9mahk "
<« key 39
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7.5  TAndroid key] Zi®IRT 5,

ef\:_}j‘o https://console.developers.google... O ~ & & H { Credentials - My Project

(=8 Be =)
AR

p e o

APls & auth
- Create a new key

You need an APl key to call certain Google APls. The API key identifies your
project. Alsa, it is used to enforce quotas and handle billing, so keep it safe.

Serverkey | Browserkef] | Android key | JOSkey

Storage

Big Data

7.6 FEAEDT 4 VAT Y MEAEET DI, AX— P A=a—hbavr R

IarF L, TRoavy ReFEITT 5,
cd "c:¥Program Files¥Java¥jdk1.8.0_60¥bin"

keytool -list -v -keystore % USERPROFILE%¥.android¥debug.keystore
KFETHR, NAT—=REZROLNLN, BITF—DHZHT,
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77 avwr REFTLHASINTENED EREOZ 47V ko] LLF)
5. [SHAL: OIEE 25T 2 ar—T 5,

-+ el S m W S [=] ===

12:01:47 JST 20

7.8 7.5 CER/REINZHEE T IAdd package name and fingerprint] 27 VU v 7
T2

FRENTEZTIX ARy 7 AU TFTOEDEZFHE L., [Create] 7 U v
79 %,

Package name com.example.MapApplication

SHA-1 certificate fingerprint 7.7 Cabv— L7354

Q |O https://console.developers.google... 2~ & C ” O Create Android API key ... | ‘ S
'-) Google Developers Console My Project Sign up for a free tria 0 o 0 ;
Home -
Permissions
APls & auth Create Android API key
Akl Name

Android key 49
Push
Restrict usage to your Android apps
Monitoring
Source Code

Cloud Launcher

Deployments keytoal -list -v -keystore mystore keystore
Compute
Package name SHA-1 centificate fingerprint
Networking
com.example. MapApplicatiion 48:AA45:00:7B:72:15:51:09:-69.B2:B5:22:86:32-89:-E2:75:FB-C1
Storage
Big Data

Ganeel

25
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7.9 APIKEY FRahdlcdh, a'—42%,

e@|o https://console.developers.google... O ~ @ & ” ) Credentials - My Project % ‘ |

I AlzaSyAztfbgl _QSaVngTfmb7EjfnyykvviQvLe I

7.10 FHEE AVD % i#E) L Google ¥ v 7 NEREN DN EHERT 5,
EL L FRENZRNVEE . Android Studio HE /D [app > manifests| 7>

5 AndroidManifest.xml % B & .

7l =ae— L7z APIKEY

MapApplication - [C:¥Android

File Edit

ZRED AT 5,

View Mavigate Code Analyze Refactor Build Run Tools VCS Window Help

landroid:value="OOQ"] ®OOODHk

DHO #4 XO0 QR ¢ > W[Rap-] b ¥ L | F&E ¢
[or] MapAppIication.'_'-. (o} app“_"- (] src ] mal’n.':_- o Androl'dManifest.me::_'-

4 i Android - @ & | #- - | B AndroidManifest.xml x

9

o
=

Caapp
[ manifests
‘& AndroidManifest.xml

i Captures =l 7: Structure

@
@

4k Build Variants

1 java
Cares

& Gradle Scripts
# build.gradle (Project: MapApplication)
= build.gradle (Module: app)
 settings.gradle (Project Settings)

[4 local.properties (SDK Location)

<uses-permission android:nane="android.pernission. INTERRET" />

{uses-pernission android:name="android.permission. ACCESS_NETWORK_STATE™ />
<uses-pernission android:name="android.permission. WRITE_EXTERNAL_STORAGE™ />
<uses-permission android:name="com.zoogle.android.providers. gsf.pernission. REA
<uses-permission androidinane="android.pernission. ACCESS_COARSE_LOCATION™ />
<uses-permission androidinane="android.pernission.ACCESS_FINE_LOCATION" />

<uses-feature
android:glEsVersion="0x00020000"
android:required="true” />

<application
android:el lowBackup="true”
android: icon="Bdrawable/ic_launcher”
android: lebel="Hapfippl ication”
android: thene="8style/4ppThene” >

saloud uanep) 3

2lpeiD (5

<meta-data
android:name="con.goozle.android-maps.v2 _APT_KEY"
android:value="4lzaSyA24fbgl M9a¥n=Tfmb7Eifnyykyyi

<meta-data
android:neme="con.goozle.android.sms. version”
android:velue="7895000" />

Android

B L

¥ 2: Favorites

>

‘ Mo Connected Devices n | No Debuggable Applications n

if& logcat | ADB logs +| |l Memory —+°| jil CPU -+°

el: v (el ‘ Show only selected application n

>

4:Run S5 TODO & 6: Android Terminal

/= 0: Messages M1 Event Log  [Z] Gradle Console

[0 Gradle build finished in 2m 36s 869ms (55 minutes ago) 29:67 |CRLF: | UTF-
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Instruction of the quick Building

Android Application Development Environment

1. Development Environment
Table 1 shows the development environment on this instruction.

Table 1. Development Environment

0sS Windows7 (32bit or 64bit)

Working Directory C:¥Android_Work

Java Java SE JDK latest version (8u60)
Development Environment Android Studio latest version (141.2178183)
Target Android API Version Android 4.4.2

Google API Google Maps Android API v2

The procedure of the structure is:

1: Install the required software for the Java Development Kit (JDK)

2: Copy the Android_Work folder which include the Android Studio, Android SDK and

sample source code.

3: Copy the xampp folder which include the Xampp environment with PHP scripts and

database tables for sample application.

4: Build the Android emulator— Software Configuration

The software (32bit ver. And 64bit ver.) will be provided by 16GB USB memory stick.

<Note>

Most of all files are copied under “C:¥Android_Work”.

2. Install the Java Development Kit (JDK)
2.1 Open the URLin a browser

http://www.oracle.com/technetwork/java/javase/downloads/index.html

2.2 Click “DOWNLOAD” of the latest version of JDK (8u60 on this instruction manual)
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java/ P~ BG X
FR(V) BRCAD(A) Y—IUT) ALTH)

Downloads
Java SE [ overview ( | [ communty jes [ Training R AR A e ‘
Java EE *
Java ME Java SE Downloads & Java € and Glassfish
Java SE Support & Java ME
Java SE Advanced & Suite & Java Card
Java Embedded $ Nets
Java DB # Java Mission Control
YeoTls: DOWNLOAD DOWNLOA S Resouices
Java Card ——— e -
e Java Platform (JDK) 8u20 DK 8u20 & NetBeans 8.0 v ihe
Java TV & Technical Artick
New 1o Java Java Platform, Standard Edition s s
Community Java SE 8u20 o
X This release of the Java Platform continues to improve upon the significant advances made in the =
Jaia Magazine JDK 8 release with new features, security and performance optimizations. Included are the new MSI & Java Magazin
Enterprise JRE Installr, the new Advanced Management Console, and JHC 5.4,
Learn more » # Javanet
# Developer Training
= Instaliation Instructions JDK & Tugorighe
DOWNLOAD 2
* Oracle License
ey
+ Java SE Products Server JRE “,
* Third Party Licenses DOWNLOAD Getit now
+ Certified System Configurations for FREE!
* Readme Fies Subscribe Joday
+ JDK Readlte JRE S

DOWNLOAD &

* JRE Readlle ‘ Wobcast -

2.3 Check “Accept License Agreement” and download “Windows x86” by clicking the file
name on the right (In case of 64 bit OS, download the  “Windows x64” )

L SRIE Al =) heep://wwiw.oracle.com/tachn © ~ B & X | [=] Java SE Development Ki... x
D7 AUF) BEE) BA() SRCADR) YT ALTH) |

5 -

savaiagazing JDK MDS Checksum 3
Looking for JDK 8 on ARM? s

JDK 8 for ARM downloads have moved to the JOK 8 for ARM download page. & Develop

# Tutorials

Java SE Development Kit 8u20 & Javacoi
You must accept the Oracle Binary Code License for Java SE to this o

U software.

@) pt License Agreement © pecline License Agreement

Product / File Description | File Size | Download
Linux x86 135.24 MB 3 jdk-8u20-linux-i586.rpm
Linux x86 15487 MB  # jdk-Bu20-linux-i586 tar.gz
Linux x64 135.6 MB # jak-8u20-finux-x84.rpm
Linux x64 153.42MB  # jok-8u20-linux-x64.tar.gz
Mac 0S X x84 209.11MB  # jak-8u20-macosx-x64.dmg
Solaris SPARC 64-bit (SVR4 package) 137.02MB  # jdk-3u20-solaris-sparcva.tar.Z
Solaris SPARC 64-bit 97.09MB ¥ jdk-8u20-solaris-sparcv9.tar.gz
Solaris x64 (SVR4 package) 137.16 MB $ jdk-8u20-solaris-x64.tar.Z

Java SE Development Kit 83u20 Demos and Samples Downloads are released under the
Oracle BSD License.

< m ] >

2.4 For the installation, run the executable zip file. Use the default settings on the

installation process.
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Name Date modified Type Size

|y jdk-8u20-windows-x64.exe 9/11/2014 3:56 PM Application 177,232 KB

15 Java SE Development Kit 8 Update 20 (64-bit) - Setup

ORACLE

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 20

This wizard will guide you through the installation process for the Java SE Development
Kit 8 Update 20.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

ate moanied: 7
Size: 173 MB

ﬁ]vjava SE Development Kit 8 Update 20 (64-bit) - Complete

ORACLE"

Java SE Development Kit 8 Update 20 (64-bit) Successfully Installed

Click Next Steps to access tutorials, API documentation, developer guides, release notes
and more to help you get started with the JDK.

Next Steps

G
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3.

Install the Android Studio
3.1 Copy Android_Work folder in the USB memory stick to your “c:¥”.

3.2  Open “Control Panel” — “Sytem” — “Sytem Properties” — “Environment

Variables”.

System Properties

Computer Name | Hardware Advanced | System Protection | Remote

You must be logged on as an Administrator to make most of these changes

Performance

Visual effects, processor scheduling, memory usage, and virtual memory

Settings...
User Profiles
Desktop settings related to your sign+in

Settings...
Startup and Recovery
System startup, system failure, and debugging information

Settings...

Environment Variables...

OK Cancel

3.3 Add a new variable “ANDROID_SDK_HOME" to System variables.

Environment Variables

User variables for Gonso

Variable Value |
TEMP SRUISERPROFIL — i
™P YLUISERPROFIL New System Variable

Variable name: AMDROID_SDK_HOME

Mew...
Variable value: c:¥Android_Work
System variables
Variable Value Ok Cancel
ComSpec C:¥Windows¥sy
FP_NO_HOST C... NO
MUMBER_OF P... 2
05 Windows_MNT b
it | [ odes
oK Cancel
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4. |nstall the XAMPP environment

4.1 Copy xampp folder in the USB memory stick to your “c:¥”.

4.2  Run “xampp-control.exe” in “c:¥xampp” folder, and then start Apache server and

MySQL server from the Control Panel.

XAMPP Control Panel v3.2.1 [ Compiled: May 7th 2013 ] = =
XAMPP Control Panel v3.2.1 #* contg
Modules
Netstat
Service Module PID{s) Port(s) =Reoons | o
Apache g:gi 80 Stop Admin Config Logs & Shell
MySQL 1064 3306 Stop Config Logs | Explorer
FileZilla —— Admir Config Logs = Senices
Mercury Start Admir Config Logs & Help
Tomcat Start Admir Config Logs |l Quit
1350 Pr [main] The FileZilla module is disabled ~
12350 PM [main] The Mercury module is disabled
0 PR [main] The Tomcat module is disabled
50 P [main] Starting Check-Timer
50 PM [main] Control Panel Ready
57 P [Apache]  Attempting to start Apache app...
11:3357 P [Apache]l  Status chanze detected: running
11:34:04 Ph [mysqll Attempting to start MySGL app...
11:34:05 Ph [mysql] Status change detected: running
v

5. Install the Intel HAX

Execute "IntelHaxm.exe” from the path below and install.

C:¥Android_Work¥sdk¥extras¥intel¥Hardware_Acceleted_Execution_manager¥

Intel® Software Tools
for Android*

¥ Intel® Hardware Accelerated Execution Manager Setup — ©

Intel Hardware Accelerated Execution
Manager 1.1.4 (HAXM)

This Installer guides you through the steps necessary to install
Intel® HAXM on your system,

Intel HAXM is a hardware-assisted virtualization engine
(hypervisor) that uses Intel Virtualization Technology to speed
up Android development. Please note that Intel HAXM can only
be used with the Android 50K, and Android x86 emulator images
pravided by Intel,

Important: Intel HAXM requires an Intel processor with certain
hardware features, induding Intel Virtualization Technology
(VT). This installer will check whether your computer can run
Intel HAXM,

Please connect your computer to internet during installation.

Please refer to Intel® HAXM documentation for more
information.

Intel® HAXM Documentation Back Cancel
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## Intel® Hardware Accelerated Execution Manager Setup — =

Intel® Hardware Accelerated Execution Manager
Memary limit for Intel HAXM

Intel HAXM reserves a portion of RAM when running. Please set the maximum amount of
RAM available for Intel HAXM to use for all k86 emulator instances.

Mote: Setting a large memory reservation may cause other programs to run slowly when
using the x&86 Android emulator with HAXM.

() Default Value 1024 MB

(®) set manually |1[2|24 ME v

The value must be between 512 MB and 1.5 GE

Intel® HAXM Documentation Back Cancel

6. Configure the Android Studio
6.1 Execute “c:¥Android_Work¥android-studio¥bin¥studio64.exe”.
(If you have the 32bit OS, execute studio.exe. )

@G-l . = android-studic » bin » - |‘y|| bintEE p|

== - BE< SZ=AT FUNT A IS —

Sr BECAD e ] EEE
B FoO0—F ! lidb 2015/09/03 9:
R e ] appletviewer.policy 2015/08/19 0:
T SEEE USSR %] breakgen.dll 2015/08/19 0:
|| breakgené4.dll 2015/08/19 0:
[=] Focuskillerdll 2015/08/19 0:
- STTSY @] Focuskillers4.dil 2015/08/19 0:
=l Subversion [E] Fsnotifier.exe 2015/08/19 0:
FE FFax>t [ ] idea.properties 2015/08/19 0:
= EoFr %] Ideawin3z.dll 2015/08/19 0:
B e o || Ideawin64.dll 2015/08/19 0:
d =r—ws %] jumplistbridge.dll 2015/08/19 0:
|| jumplistbridge64.dil 2015/08/19 0:
PP [ log.xml 2015/08/19 0:
L 7] restarterexe 2015/08/19 0: by
& 0s () [ runnerw.exe 2015/08/19 0: >
| == studio.exe 2015/08/19 10:37 FFUL—=.3>
T RO —4 L_| studic.exe.vmoptions 2015/08/19 0:36 VMOPTIONS ...
- 2015/08/19 0:36 FAa
studiob4.exe 2015/08/19 10:42 FIFUHS—==>
studios4.exe noptions 2015/08/19 0:36 VMOPTIONS ...
[=71 vistalauncher.exe 2015/08/19 0:36 FFUr—=az
< i ] »
% studio.exe E=FTHET: 2015/08/12 10:37 {EEREIEF: 2015/09/03 9:29
FFuLr—a> HX: 873 KB
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6.2 Select “I do not have a previous version of Studio or | do not want to import my

settings” and click “OK” button.

il - —
#® Complete Installation u

You can import wour settings from a previous version of Studio.
0 Tweant to import my settings from a custom location
Specify config falder ar installation home of the previous version of Studio:
I[-]

@ {dn not have a previous version of Studio or Tdo not want to import my settines

6.3 Click “Next” button
V@ Android Studio Setup Wizard ] - o E@Q‘

Welcome

Android Studio

Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studic

or create a new Android application project.

6.4 Select “Standard” and Click “Next” button
B Ao Sl Sotu e —————————— | =

/"( Install Type

e -

© standard

Android Studio will be installed with the most common settings and options|

(O Custom

You can customize installation settings and components installed.

~148-



6.5 Click “Finish” button

. Android Studio Setup Wizard - O “-I

A Verify Settings

If you want to review or change any of your installation settings, click Previous.

Current Settings:

Setup type:
Standard

Destination Folder:
C:\Android_Work\SDK

IEIEViowII Next Ilw]

6.6 Click “Finish” button again

L

Android Studio Setup Wizard -0

A Downloading Components

Android SOK is up to date.
Creating Android virtual device
#ndroid virtual device Mexus_6_API_23_x86 was successfully crested

[ previous | [ Wext | [ concel ]m
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7. Import the sample program
7.1 Click “Open an existing Android Studio project” and open the sample

program in “c:¥Android_Work¥Projects¥”.
% Aot S Setup wiard T[] ]
m Welcome to Android Studio

-
Recent Projects Quick Start
@ Start a new Android Studio project
FD ‘Open an existing Android Studio project
Ne Project Open Yet E'“_I‘ Import an Android code sample

VES Check out project from Version Control

E?’ Import project (Eclipse ADT, Gradle, etc.)

,& Configure 3

rE. Docs and How-Tos P

Android Studic 1.3.2 Build 141 2178183, Check for updates now.

7.2 Select “MapApplication” on the list.

# Open File or Project A < g
ACenG &BX O Hide path
‘ Ci¥Users |
FC:¥
[1 3b1bdb370d3ad804e621c180
[ 4939e077b831427f2703
[ Android_Work
# MapApplication
3 Apps
[ bat
[ Bit_scfiE
[ dell
[ Drivers
[ Intel
[ Logs
[ neops
Drag and drop a file into the space abowve to quickly locate it in the tree.
o JEEETS
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8. Check the Android emulators.

8.1 Click on . icon.

8.2 Check to existing two android emulators, “Galaxy Nexus API 19” and “Nexus 5
API 23 x86".

Y

|
Android Virtual Device Manager o B

H Your Virtual Devices

Android Studic

Type | Name | Resolutien | APl | Target | CPU/ABI | SizeonDisk | Actions
[C] GalmyNexws.. 320x480:%hdpi 19 Google APls(x.. 86 268 A
[C] Mews5APIZ3. 1080x 192kxc. 23 Google APls 186 750 MB b 2~

=+ Create Virtual Device... @

8.3 Click > button on the “Galaxy Nexus APl 19” and check to run the emulator.

& © 5554:Galaxy_Nexus_aPI_19 - - [

AR
MmO D

10503 o Js Js [2.0a o Jo-
o/ e e [t Jv oo
s 1o [ Jo [n o [ic|1 [
2z e Lo lo v . Joo
IR P R P P

10
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8.4 After running the emulator, start the sample program on the Android Studio.
(Menu bar = Run = Run ‘app’)

File Edit View Navigate Code Analyze Refactor Buid [l
DHO «» %00 QR e8P

3 MapAppli('atiﬂ'l) napp> | 5rc> (| main> Bjava ) E § Debug ‘app ShIte
= ¥ Run 'app' with Coverage
1§ Android v| D = | 81

b Run... Alt+Shift+F10 m
a =
" L:‘ e ik Debug... Alt+Shift+F9 H
Gradle Scri
e ripts [E» Edit Configurations... -
- (& build.gradle (Project: MapApplication) B stor e El
v (& build.gradle (Module: app) 9(
= Reload Changed Classes
b (&) settings.gradle (Project Sattings) - @
5 ¥ Step Over F8 &
@ [t local.properties (SDK Location) - A o
i~ 3 Force Step Over Alt+Shift+F8 z
v M Step Into = g
) M Force Step Into Alt+5Shift+F7
2 W Smart Step Into Shift+F7
g A Step Out Shift+Fa
My Run to Cursor Alt+F9
My Force Run to Cursor Ctrl+Alt+F9
2 3 Drop Frame
=
§ Il Pause Program
| % 2 Resume Program Fg
l
W B8 Evaluate Expression... Alt+F8
Quick Evaluate Expression Ctrl+Alt+F8
4 | androia k= Show Execution Point Alt+F10 B L
g X
& No Connected Devices n I Mo Debuggable Af 7ol Line Breakpoint Ctrl+F8
=D Toggle Method Breakpoint
* ifii logcat | ADB logs —+*| i Memory +°| il CPU " E vogie Blethod Breakpoin | application n
e Toggle Temporary Line Breakpoint Ctrl+Alt+Shift+F8

P 4 Run & TODO
Run selected configuration

Terminal Bl Toggle Breakpoint Enabled =] Gradie Console
§: View Breakpoints... Ctri+Shift+Fg (2 Context> & §

11
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9. Execution Environment of the system.
9.1 This system is executed by the application on the Android devices and the
Web(PHP) + Database(MySQL) server constructed on the web site.

The connection between the application and web server uses HTTP connection.

9.2 Using e-mail address for the user identifications. E-mail address will be registered
on the set-up the applications and can be changed later on. And the user password

must be controlled together.

9.3 This system runs on the Android devices requires internet access (WiFi, LTE and

etc. ).

Application

Table 6.3) Server SPECs

OS CentOS ver6.5 (64bit)
IP addresses Global IP: 114.179.41.91
Bit Datacenter N Port No: 80, 22
Local IP: 192.168.200.150
System XAMPP for Linux ver 1.8.3
Database MySQL ver5.6.20
phpMyAdmin ver 4.2.7.1
Web Server Apache ver 2.4.10
Server side script PHP ver 5.5.15 & PEAR

12
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10. Create and use the client ID for Google Maps Android API v2
If you can open the Google map correctly on your AVD, you don’t need to do as
follows.
10.1 Access the Google Developer console web site and login.
(https‘//console.developers.google.com/)

+ User: mext2014001@gmail.com

® 0 e Sign in — Google Accounts o)

One account. All of Google.

Sign in with your Google Account

‘ mext2014001@gmail.com| |

Need help?

Create account

10.2 Input password as below.

+ Pass: Bit2014@mextproject

Sign in - Google Accounts

One account. All of Google.

Sign in with your Google Account

&

MEXT Project
mext2014001@gmail.com

v/ Stay signed in Forgot password?

~154~
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10.3 Click “APIs & auth” = ”"Credentials”.

m}) © https://console.developers.google... O ~ & & H O Home - My Project x | | {af 5.7 593
) Google Developers Console My Project ~ Signup for a free trial. ) 9o O ;
Home Project: My Project APls Google Cloud Platform status 7 A
Permissions
1D big-bliss-713 Requests [requests/sec) @  All services normal v
APIs & auth
S5 (#755654803736) ™
APls
1 News
Explore other services
Push 08
o 0 Push Google Cloud origin content
Monitoring APL  Enable Google APIs for your out to your users with CON
Source Code app 04 Interconnect
Deploy & Manage 0 Google Cloud Platform - 18 hr
N blog ago
Bl Deploy a prebuilt solution .
Compute Sep 10, 3:45 PMSep 10, 4:45 PM
Networking i Compute Engine Preemptible VMs
Storage “®: Deploy a Hello World app [/ Requests: 0 are now Generally Available
: Google Cloud Platform - 1 day
EigDatz {3F Take a VM quickstart blog ago
= Create a Cloud Storage Cloud Spin Part 1: 180-degree
bucket animations on Google Cloud

Platform

Google Cloud Platform - 2 days
blog ago v

10.4 Click “Add Credentials” and select “API key”.
(5 e = -

m})‘o https://console.developers.google... 0 ~ @& & H D Credentials - My Project % | | AN
Q Google Developers Console My Project + Signup for a free trial. ) 9o O ;

Home Credentials QAuth consent screen ~

Permissions

APIs & auth Add credentials ~

APls APl key
Credentials Identifies your project using a simple AP key to check quota and access.
Push For APIs like Google Translate

'us

OAuth 2.0 client ID

Monitoring Requests user consent so your app can access the user's data
Source Code For APls like Google Calendar.
Deploy & Manage Service account 313fhgiViZaQ-L3WIMMYI
Compute Enables server-to-server, app-level authentication using robot accounts.
For use with Google Cloud APls UUGVppxKySR-TALSZmICSe
Networking
Storage 'ty Jun 18, 2015 Browser AlzaSyB54bYUszu8QxdQIKHoeUVD1SW20ZNj_7U
BigD Browser
ig Data key 2
Android May 20, 2015 Android AlzaSyCCWck8FUrgwGwfJ0-pfOcénaY¥sQKP1ZHk
key 41
Android May 13, 2015 Android AlzaSyBbHQC2igVOEnI2icc90KT_jbuDYYXSFWg
key 40
Android  May 13,2015 Android AlzaSyBYEydYaERICFvC3TUiNgeySqLyL9mahk "
<« key 39

14
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10.5 And click “ Android key” button.

e\\l‘o https://console.developers.google... O ~ & & H { Credentials - My Project | |

(=8 Be =)

APls & auth

Monitoring
Source Code
Deploy & Manage
Compute
Networking
Storage

Big Data

Create a new key

You need an APl key to call certain Google APls. The API key identifies your
project. Alsa, it is used to enforce quotas and handle billing, so keep it safe.

Server key

Browser kefl | Android key

0S key

p e o

10.6 Start command prompt on your windows PC and type the below command

for creating the fingerprint of your PC’s certification.

cd "c:¥Program Files¥Java¥jdk1.8.0_60¥bin"
keytool -list -v -keystore ¢:¥Android_Work¥.android¥debug.keystore

**When the entering password screen is displayed, you just press enter

key.

-156-

15



10.7 Copy the fingerprint that is next to “SHA1:” to the clipboard.

| C:¥Windows¥system32¥cmid.gxe L=

HERRS 50 Mo 01 9 JST 20144278 1

10.8 Paste the fingerprint on the field that on the Google web site and go on to

type “;com.example.MapApplication”. Then click “Create” button to make
an API KEY.

Package name com.example.MapApplication
SHA-1 certificate fingerprint Copied fingerprint in chapter 10.7
(E=5(E=R ==
a |O https://conscle.developers.google... 0 ~ @ G”OCreateAndruldAPI key ... ‘ | 9.5 io)
'-) Google Developers Console My Project Sign up for a free trial 1] QO - =
Home -
Permissions
APIs & auth Create Android AP key
APls Name

Android key 49

Push

Restrict usage to your Android apps
Monitoring

Source Code
Cloud Launcher

Deployments keytool -list -v -keystore mystore.keystore

Compute
IPackage name SHA-1 certificate fingerprint
Networking
com.example.MapApplicatiion 48:AA:45:D0:7B:72:15:51:00:69:82:85:22:86:32:80:E2:75:FB:C1
Storage
Big Data

Cancel

16
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10.9 Make a copy of API KEY.

e@|° hittps://console.developers.google... © ~ @& ¢ ” {Q Credentials - My Project %

APl key
Here is your APl key
I AlzaSyA2tfbql_QSaVngTfmb7EjfnyykvyjQvLe I

10.100pen “MapApplication/AndroidManifest.xml” on the Android Studio.
And replace the variable of “android:value” to your API KEY.

MapAplecatlon - [C:¥Android

File Edit View MNavigate Code Analyze Refactor

Build Run Tools VCS Window Help

ODHG ¢4 X000 QR & > 1(Fap- > ¥ ¥ L | Fm R E& ? Q
Ca MapAppIication..:':- I:'.'app..:':- (| srt._:':- B mal’n.._::- o ArdmidManifest.xml.._:'-

H e Lodoid '.u o . e o AndroidMamfest.xm.\ %

2 | Caapp

& [ manifests <uses-permission android:zneme="android.pernission. INTERKET" />

<uses-permission

android.permission. ACCESS_NETYORKE_STATE™ />
android.pernission. WRITE_EXTERNAL _STORAGE™ />

‘& AndroidManifest.xml

<uses-permission

spmaloud U2ABRK 3

w [ | ]ﬁ <uses-permnission con. goog le.android. providers. gsf.pernission. REA

-E Pares <{uses-permission android:name="android.permission. ACCESS_COARSE_LOCATION" />

2 B <uses-pernission android:name="android.permission. ACCESS_FINE_LOCATION" /> O]

[l & Gradle Scripts [}

.. =

o < build.gradle (Project: MapApplication) <uses-feature =
® build.gradle (Modula: app) android:glEsVersion="0x00020000

. android:required="true” />
 settings.gradle (Project Settings)

[4it local.properties (SDK Location) <application
android:al lowBackup="true”

i Captures =J

I’
@

android: icon="8drawablefic_launcher”
android: label="Hapéppl ication”
android: theme="8stylefippThene” >

<meta-data

“meta-data
android:name="con.goog le.android.gns. version”
android:value="7335000" />

& Build Variants

B | android o L
E ‘ Mo Connected Devices n | MNo Debuggable Applications
ol
* ifis logcat | ADB logs +°| il Memory +°| [ CPU -+|el: _ ‘ Show only selected application n
- 4:Run S TODO | 4 B Android Terminal |=| 0: Messages M1 Event Log [E] Gradle Console
[0 Gradle build finished in 2m 36s 869ms (55 minutes ago) 29:67 |CRLF: | UTF-8 |Context: <no co = w8

17
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Appendix1. How to set the GPS location data on the Android emulator.
1. Start MapAplication (Sample program) on Android Studio
2. Click “Menu” - “Tools” = Android Device Monitor

] Android Device Monitor
File Edit Run Window Help

Quick Access I =1 |

B Devices 52 = 8 || % Threa... @ Heap @ Alloca... = Netw...

2 Telephony Status
4 B emulator-5554 agy_ Voice: |home v Speed: |Ful v

com.android.systemui 1342 8601 Data: |home v Latency: None  w

com.goegle.andreid.inputmethoc 1376 8602

com.google.android.gms. persiste 1392 8603 TR MRS

android.process. media 1405 8604 Incoming number:

com.android.phone 1423 8605 ®) oice

com.android.launcher 1429 8606 SMs

com.google.process.gapps 1467 8607

android.process.acore 1476 8608

com.android.printspocler 1502 8609

com.android.externalstorage 1534 8610

com.google.android.gms.wearab 1629 8611

com.android.settings 1648 8612 Call | Hang Up

com.android.music 1673 8613

com.google.android.gms 1706 8614 3)Locat|0m Controls

com.android.dialer 1744 8615 Manual | GeX | kML

com.android.providers.calendar 1765 8616 .

com.android.mms 1791 8617 ® Decimal

com.android.calendar 1879 8618 () Sexagesimal

com.android.deskclock 1902 8619 Longitude | 137.096817

com.android.email 1919 8620

com.android.exchange 1939 8621 Latitude |36.725310

com.qoogle.android.gms.unstabl 2005 8622

< > v
0 LogCat 2 = 08
Saved Filters o Search for messages. Accepts Java regexes. Prefix with pid:, app:, tag: or text: to limit scope. verbose v H B
All messages (no filters X X o
L... Time PID TID Application Tag Text -

< < >

6sMof sazM [

1) Click and select your running device from the Device view.

2) Click “Emulator Control” tab.

3) Go to “Location Controls” and click “Manual” tab, then set the numbers to
Longitude and Latitude, and click “Send” button.

4) Send the GPS location to your running device.
i.e. The GPS location of Toyama college of Business and Information Technology

latitude : 137.096817
longitude : 36.72531

END

18
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7o ROA FRRREEBEFIEE (54 X F—ILER)

1 BASEEREE
AFNEECHEET HHBREIIR 1 OB Th D,
# 1 BAFSEREE

0S Windows7 (32bit or 64bit)

BET 4L 7 MY C:¥Android_Work

Java Java SE JDK H#HThi (8u60)

B ER IR Android Studio F#HThK (20140702)
Target Android API Version Android 4.4.2

Google API Google Maps Android API v2

BHFSERBE DOAEZETNE & LTI, 2. Java Development Kit (JDK) @1 > A s —/1 | Android
Studio 7 4 /L4 & Xampp 7 4 /L4 O a2t —_ Android = I = L — & OfERK & BRERE Z1T
Vo FlAAI—=NT %Y 7 7 =7 (32bit LT, 64bit fOI, HlE AT 17 (K 10GB
DEBNZTRET 5,

2 Java Development Kit (JDK) ®A > A h—/b
21 AV PF=AAT 4T XV KE7R JavaSDK(B2bit il F721%, 64bit )% A >~ A k
=T %,
WHOREHAITETEDEFE TR,

{4 1ava SE Development Kit & Update 60 (64-bit) - Ty R 7w ==

Java SE Development Kit 8 Update 80004 22 b= )l-ryH —Ea b3l F

Zre o — BT, Java SE Development Kit 8 Update 6000 = A F—1- X0 A %E%E
<TERBALE S,

Java Mission Control 70774 V- A B LUSERRY =)L - 2 — HT, DKD—BBr LT AFTE
BLICHENFELE.

[ k9> | mEmE | 1
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4 Java SE Development Kit 8 Update 60 (64-bit) - =T

Java SE Development Kit 8 Update 60 (a4-bit) INE (-4 A =)L ENELE

CR@AT T RO 9 OLTF1— M., AT PR A -, RREEE A B U= =}
RECPHEAFRE. DRI TER TR RTSET.

ARDAT )
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3 Android Studio @1 A b—/V
3.1 AV A= AT 4T D Android Work 7 + /L X % c¥lZa bt —14 5%,
3.2 IV =R AT A-BREERAR L,

System Properties
Computer Name | Hardware Advanced | System Protection | Remote

You must be logged on as an Administrator to make most of these changes
Performance

Visual effects. processor scheduling, memory usage, and virtual memory

Settings...

User Profiles
Desktop settings related to your sign+n

Settings...

Startup and Recovery
System startup, system failure, and debugging information

Settings...

Environment Variables...

OK Cancel Apply

3.3 A% ANDROID _SDK HOME = c:¥Android Work B4 %,

Environment Variables

IUser variables for Gonso

Variable Value
TEMP %USERPROFILE %¥AppData¥Local¥Temp
TMP SLUSERPROI ;
New System Variable
Mew... Variable name: AMDROID_SDK_HOME
System variables Variable value: c:¥android_Work
Variable Value
: QK Cancel
ComSpec C:¥Windows
FP_NO_HOST_C... NO
MUMBER_OF P... 2
05 Windows_MNT b
cat.. | | Dekte
oK Cancel
3
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4

5

XAMPP Bt D7 54 7 F P CO~DEA,

41 AVAPR—NVAT 4T Oxampp 7 ANE—% c¥llatr—F 5,
4.2 Copy L7z ci¥xampp 7 4 /¥ —ND “xampp-control.exe” % FEFT L.

— k. MySQL #— %283 5.

113350 PM
1132
1133
1134
1134:05 PM

P

XAMPP Control Panel v3.2.1 [ Compiled: May Tth 2013 ] - o lEl
XAMPP Control Panel v3.2.1 #” Config
Sr:on‘ilunlzs Module PID{s) Port(s) Actions ittt
Apache 304 80 | Stop Config Logs B Shell
MySQL 1064 3306 Stop Config Logs Explorer
FileZilla Start Config Logs £ Senvices
Mercury Start \dmin Config Logs @ Help
Tomcat Start Admin Config Logs [ Quit
The FileZilla module is disabled ~

The Mercury rodule is disabled

The Tormcat moduls is dissbled

Starting Gheck-Timer

rain] Control Pane| Ready

Pl [Apache]  Attemptine to start Apache app..
[Apache]  Status change detected: running

04 P [mysql] Atterpting to start MySGL app.
[rmy=al] Status change detectsd: running

Intel HAXM DA > A h—)b

Apache

TFREDO/XAITEH 57 intelhaxm-android.exe”#FAT L TA > A h—/LZ1T 9,
WHORTCHEBIIETEDOEE TR,
C:¥Android_Work¥Sdk¥extras¥intel¥ Hardware Accelerated_Execution Man

ager ¥

Intel® Software Tools
for Android*

## Intel® Hardware Accelerated Execution Manager Setup - ©

Intel Hardware Accelerated Execution
Manager 1.1.4 (HAXM)

This Installer guides you through the steps necessary to install
Intel@® HAXM on your system,

Intel HAXM is a hardware-assisted virtualization engine
(hypervisor) that uses Intel Virtualization Technology to speed
up Android development. Please note that Intel HAXM can only
be used with the Android SDK and Android x86 emulator images
provided by Intel,

Important: Intel HAXM requires an Intel processor with certain
hardware features, induding Intel Virtualization Technology
(VT). This installer will chedk whether your computer can run
Intel HAXM,

Please connect your computer to internet during installation.

Please refer to Intel® HAXM documentation for more
information.

Intel® HAXM Documentation Back Cancel
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# Intel® Hardware Accelerated Execution Manager Setup — ©

Intel® Hardware Accelerated Execution Manager
Memory limit for Intel HAXM

Intel HAXM reserves a portion of RAM when running. Please set the maximum amount of
RAM available for Intel HAXM to use for all x36 emulator instances.

Mote: Setting a large memory reservation may cause other programs to run slowly when
using the x86 Android emulator with HAXM,

(") Default Value 1024 MB

(®) Set manually |1024 MB ™

The value must be between 512 MB and 1.5 GB

Intel® HAXM Documentation Back Cancel

6  Android Studio DX E
6.1 [C:¥Android Work¥android-studio¥bin¥studio.exe | % 3247 L . Android Studio
ZiELEh 45, (OS2 64bit O, [studiobd.exe] ZEITTH)

(=8 Eom =
& )=[ ) « android-studio » bin » ~ 42| [ pinome= 3
== . B< BERAG  FHLWTAILS—
e BRIEAD =L
B FO>O— K L lidb
| e G g L1 appletviewer.policy
i BEER LIS 18| breakgen.dil

[#] breakgens4.dil
%] focuskillerdil
] focuskillersa.dil
[ fsnotifierexe

=R ]
=i Subwersion

B rFax>b || idea.properties
= EoFv (=] 1deawinz2.dil
B et ] 1deawins4.dll
H=ai—sus [%] jumplistbridge.dil
[%] jumplistbridges4.dl 2015/08/19 0:36
) = [ leg.xml 2015/08/19 0:36
E— [=1 restarter.exe 2015/08/19 0:36 >
& 08 () 571 runnerw.exe 2015/08/10 0:36 I UL >
| == studio.exe 2015/08/19 10:37 FF U4 =
G Ry ND—2 __| studio.exe.vmoptions 2015/08/19 0:36
studio.ico 2015/08/19 0:36
studiot4.exe 2015/08/19 10:42
[[] studios4.exe.vmoptions 2015/08/19 0:36
[=77 vistalauncher.exe 2015/08/19 0:36
< i 1 »
Q studio.exe =#EEF: 2015/08/19 10:37 FREEET: 2015/09/03 9:29
FTUL—=> B 873KB
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6.2 [T do not have a previous version of Studio or I do not want to import my

settings| (2L, [OK| 27V v 795,
rE} Complete Installation — M

You can import wour settings from a previous version of Studio.
() Twant to import my settings from a custom location

Specify config falder ar installation home of the previous version of Studio:

L]
@ {dn not have a previous version of Studio or Tdo not want to import my settines

6.3 [Next] 7V v79 %5,
V@ Android Studio Setup Wizard 3 ’ Ld EIMI

Welcome

Android Studio

Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studio

or create a new Android application project.

-
0] ¢ Dol

6.4 [Standard] #EIR L., [Next] #7 VU v 775,
B i S e T ——— | = ]|

M Install Type

Choose the type of setup you want for Android Studio:

© standard
i ol e il i D T T D ST e T T

Recommended for most users.

(O Custom

You can customize installation settings and compoenents installed.
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6.5

6.6

[Finish] #27 Vv 735,

L.d

. Android Studio Setup Wizard - O “-I

A Verify Settings

If you want to review or change any of your installation settings, click Previous.

Current Settings:

Setup type:
Standard

Destination Folder:
C:\Android_Work\SDK

IEIEViowII Next Ilw]

[Finish] #7 VY v 735,

Android Studio Setup Wizard -0

A Downloading Components

Android SOK is up to date.
Creating Android virtual device
#ndroid virtual device Mexus_6_API_23_x86 was successfully crested

[ previous | [ Wext | [ concel ]m
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T BTN TRTTLADA U R— b
7.1  TOpen an existing Android Studio project] #7 U v 27 LT,
[C:¥Android_Work¥Projects¥] [ZEE SN TWAY 7 a s T A&,

% it swole saap Wes T ]
m Welcome to Android Studio

-
Recent Projects Quick Start
@ Start a new Android Studio project
% Open an existing Android Studio project
No Project Open Yet

Y Import an Android code sample

VES Check out project from Version Control
R Import project (Eclipse ADT, Gradle, etc.)

,& Configure 3

rE. Docs and How-Tos 3

Android Studic 1.3.2 Build 141.2178183. Check for updates now.

7.2  [MapApplication] % iEiRd 25,

(==

# Open File or Project - T
AL BX O Hide path
‘ Ci¥Users |
v BOC¥

» [ 3blbdb370d3adB04e621c180

b [£149392077b831427f2793

v [ Android_Work
.. e

# Mapapplication

3 Apps

[ bat

[ Bit_szRiE

[ dell

[ Drivers

[ Intel

[ Logs

[ neops

Drag and drop a file into the space abowve to quickly locate it in the tree.

B (| [ ]

b

¥ ¥ ¥ ¥ ¥y ¥v.¥7y ¥
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8 Android — I = L — ¥ DR

81 EpriavrsyysTa,

8.2  [Galaxy Nexus API19] & [Nexus 5 API 23 x86] 23 EEk STV D F A& MRS
Do

|
Android Virtual Device Manager - &

®

H Your Virtual Devices

Android Studio

Type | Name | Resolution | APl | Target | CPU/ABI | SizeonDisk | Actions |
[[] GalaeyMNexus.. 320xd480:xhdpi 19 GoogleAPls(x. 86 268 P 2~
m Mexus 3API 23, 1080 19200, 23 Google APIs ] 7350 MB b 2~

=+ Create Virtual Device... @
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g3 P %271 w7 LT [Galaxy Nexus AP1 19] =3 = L— 4 BNIEWIZEET5 2 &

Z R T %
M Android Virtual Device Manager E@g

Your Virtual Devices

, ( Android Studio

Type | Name | Resolution | API | Target |CPU,’ABI| Size on Disk | Actions
Mexus 5. 1080 x . 23 Google A.. X8 750 MB 7w

=+ Create Virtual Device... @

15 * 5554:Galaxy_Nexus_API_19 - e [

’3“—; ()

VAV
A®O6

10203 o Js-Js [2.0a o Jo-
o e s [x v s oo
15 1o e Jo Ju |y [ic]1 [
%o b e v lo v o . [
PP P O P P Y

10
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84 Y1 INT0TTAEFTTLHHEEIX. A==2—3—5 [Run->Run ‘app’) %
BT 5,

DHO (¢  XBA QAR &> WP

3 MapApplication> napp> I:lsrc> (| ma|n> Bjava ) E

g Android -

(RN - A

» Caapp
(& Gradle Seripts

- (® build.gradle (Project: MapApplication)
v (3} build.gradle (Module: app)
1; (& settings.gradle (Project Settings)
@ [4it local.properties [SDK Location)
1
v
g
5
=
3
-]
2
c
5
3
| =
2
L]
4| android
E No Connected Devices n I Mo Debuggable Ap
il
*« ifi logcat | ADB logs +°| jll Memory -+*| il CPU + E
o
P 4: Run  ©® TODO [E Terminal =

Run selected configuration

un 'ap
& Debug ‘app’
¥% Run 'app’ with Coverage

[ Edit Configurations...
H Stop

Reload Changed Classes
Step Over

Force Step Over
Step Into

Force Step Into
Smart Step Into
Step Out

My Run to Cursor

My Force Run to Cursor
%s Drop Frame

Il Pause Program

[v e 2 e | |l

- Resume Program

B Evaluate Expression...
Quick Evaluate Expression
k= Show Execution Point

Toggle Line Breakpoint
Toggle Method Breakpoint
Toggle Temporary Line Breakpoint
Toggle Breakpoint Enabled
@: View Breakpoints...
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Shift+F9

Alt+Shift+F10
Alt+Shift+F9

Ctri+F2

F8
Alt+Shift+F8
F7
Alt+Shift+F7
Shift+F7
Shift+Fg
Alt+F9
Ctrl+Alt+F9

Fg
Alt+F8
Ctrl+Alt+F8
Alt+F10 #- L

Ctrl+F8

| application H
Ctrl+Alt+Shift+F8

[Z] Gradle Console

Ctrl+Shift+Fg 10 CONEEXE> | @

sE=loud Uaep 3

3P (o)

11



VAT ADFEITEREIZ DN T

91 ZOVATAIX, Ty RueA Rk EOT7T 7V r—varvd, A4 —%v b EIC
5L X7 Web(PHP) + Database(MySQL)H— N2 k-~ T3Eir&shsd, 77V
fr—ya vk Web — 3ik, HTTP @EXMMEH S5,

9.2 FIAFEDOINCA—NLT RLAZFEHTH, A—=LT RLAFYST T r—va v
OB CBREE L, B TERETAHAZEHHRD, FT2/XATU—FRHE A —LT R
VAL —HEICERT D,

9.3 YT RATAEFHATILIT v RuaA RERIZ, BIZA v X —F v MOk 2 BRED
Wi-FiRR LTEZ) 7 7V r—3 a U2 F(TT 55 2RHE LT 5,

Application

Apache
Web
Server

# 6.3 — B

0S CentOS ver6.5 (64bit)
IP addresses Global IP: 114.179.41.91
Bit Datacenter P Port No: 80, 22
Local IP: 192.168.200.150
System XAMPP for Linux ver 1.8.3
Database MySQL ver5.6.20
phpMyAdmin ver 4.2.7.1
Web Server Apache ver 2.4.10
Server side script PHP ver 5.5.15 & PEAR

12
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10 Google Maps Android API v2 % —® 5

HWEAFIEZE/ L2 THLEW, 77V r—2a UNRIEFICEEL TWAIZHLED S

FTHIX TR SR WG EICE T D,

10.1 Google Developer console (https://console.developers.google.com/) %#BH&. Tid

A—=T RLAZANLT, Wk~ 2270735,
A—)L 7 KL A mext2014001@gmail.com

(=0 =R )
e@‘ G https://accounts.googlec... O - @ ¢ H G 04> - Google ZA7... % ‘ ‘ {1} 5.9 £o3
Google :
ThIUk1 DTERTD Google H—E R%,
Google P HTOS A
mexi2014001 @gmail.com)| X ‘
HEVDES
10.2 TRNRAU—FRKZANLT TarAy) 220 v 7935,
Password: Bit2014@mextproject
(=0 =R )
e@‘ G https://accounts.googlec... O - @ ¢ H G 04> - Google ZA... % ‘ ‘ {1} 5.9 £o3
Google :
ThIoUk 1 DTETRTD Google H—E X%,
Google 777 TOS A7

MEXT Project
mext2014001@gmail.com

o-con-.uco--o-o.-..‘ L)

EEYOES
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10.3 MEim/AAD TAPIs & auth] %#BdZ. [Credentials|] #7 Vv 735,

m}) © https://console.developers.google... O~ @& & ” {Q Home - My Project X ‘ ‘ {53 653
) Google Developers Console My Project ~ Sign up for a free trial. ) 9o O ‘
Home Project: My Project APIs Google Cloud Platform status 7 A
Permissions
ID: big-bliss-713 Requests (requests/sec) @ Al services narmal v
APls & auth
=2 (#755654803736) v
APls
1 News
Explore other services
Push 08
o e Push Google Cloud origin content
i API  Enable Google APl for your : out to your users with CON
Source Code app 04 Interconnect
Deploy & Manage 0.2 Google Cloud Platform - 18 hr
N blog ago
Bl 0eploy a prebuilt solution .
Compute Sep 10, 3:45 PMSep 10, 4:45 PM
Networking _ Compute Engine Preemptible VMs
Storage @+ Deploy a Hello World app [ Requests: 0 are now Generally Available
: Google Cloud Platform - 1 day
BigDatz {2F Take a VM quickstart blog ago
= Create a Cloud Storage Cloud Spin Part 1: 180-degree
bucket animations on Google Cloud

Platform

Google Cloud Platform - 2 days
blog ago v

10.4 [Add Credentials|] #7 VU > 2 L, T[APIkey] %i%{R7 %,

m}) © https://console.developers.google... O ~ & & H D Credentials - My Project % | | AN
Q Google Developers Console My Project + Signup for a free trial. ) 9o O ;
Home Credentials QAuth consent screen ~
Permissions
APls & auth Add credentials ~
APls APl key
Credentials Identifies your project using a simple AP key to check quota and access.
For APIs like Google Translate
Push
o OAuth 2.0 client ID
Monitoring Requests user consent so your app can access the user's data
Source Code For APls like Google Calendar.
Deploy & Manage Service account 313fhgiViZaQ-L3WIMMYI
Compute Enables server-to-server, app-level authentication using robot accounts.
For use with Google Cloud APls UUGVppxKySR-TALSZmICSe
Networking
Storage 'ty Jun 18, 2015 Browser AlzaSyB54bYUszu8QxdQIKHoeUVD1SW20ZNj_7U
BigD Browser
ig Data key 2
Android May 20, 2015 Android AlzaSyCCWck8FUrgwGwfJ0-pfOcénaY¥sQKP1ZHk
key 41
Android May 13, 2015 Android AlzaSyBbHQC2igVOEnI2icc90KT_jbuDYYXSFWg
key 40
Android  May 13,2015 Android AlzaSyBYEydYaERICFvC3TUiNgeySqLyL9mahk "
<« key 39

-173-



10.5 [Android key] %i&{R7 %,

ef\:_}j‘o https://console.developers.google... O ~ & & H { Credentials - My Project

(=8 Be =)
AR

APls & auth
APls

Monitoring
Source Code
Deploy & Manage
Compute
Networking
Storage

Big Data

Create a new key

You need an APl key to call certain Google APls. The API key identifies your
project. Alsa, it is used to enforce quotas and handle billing, so keep it safe.

Serverkey | Browserkef| | Android key

Android

key 48

0S key

p e o

10.6 FEFAED 7 4 VTV o FEERT D720, AX— M A=ma—hbavr K
FrEEEL, Tioa~vy REETT5,

cd "c'¥Program Files¥Java¥jdk1.8.0_60¥bin¥keytool.exe”
-keystore

KETR, NAT—FEROLNDLD, SATHF—DH T,

list  -v

c¢:¥Android_Work¥.android¥debug.keystore

174~
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107 2~ RE3 T LA SNIENED RERED T 4 7V b o) BIFh6,
[SHAL:] »HInE 2 EBFIN %= —T 2,

10.8

- i) S 7w

(o]l & ]ms]

2:07:47 JST 20

10.5 TFE/R S 7-Hf C [Add package name and fingerprint] %7 V v 7 45,
RRENTETHFARR Y 7 AU TOROEEZHE L, [Createl 27 U v 73 2%,

Package name

com.example.MapApplication

SHA-1 certificate fingerprint

10.7 T2 B — L7354

Q |Ohttp5: console. de

velopers.google... 2~ @ C ” {O Create Android API key ... | ‘

B3 H=N )

Home

Permissions

APls & auth
APls

Push
Monitoring
Source Code
Cloud Launcher
Deployments
Compute
Networking
Storage
Big Data

) Google Developers Cansole

My Project

Lol

Create Android APl key

Name

Android key 49

Restrict usage to your Android apps

keytoel -list -v -keystere mystore

keystore

Package name
com example MapApplicatiion

SHA-1 centificate fingerprint
48:AA45:00:7B:72:15:51:09:-69.B2:B5:22:86:32-89:-E2:75:FB-C1

Ganeel
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10.9 APIKEY "FERESNLH720H, a8 —F 5,

e@|o https://console.developers.google... O~ @ & ” ) Credentials - My Project % ‘ | 0} g iod

I AlzaSyAztfbgl _QSaVngTfmb7EjfnyykvviQvLe I

10.10 7 AVD % E&L#E) L Google ¥ v 7N FE R EN DI ETRT 5,
1IE L EFRENZ2WEGA . Android Studio WA lapp -> manifests] 75
AndroidManifest.xml Z B %, [landroid:ivalue="OOQO"] DOOODHIFIZa ¥
— L72 API KEY Z 40 {+1F %,
Thep

File Edit View MNavigate Code Analyze Refactor Build Run

MapApplication - [C:¥Android

Tools VCS Window Help

ODEHS ¢4 XO0 QRK ¢ D |4 (Fap-) P ¥ FLE® ? Q
[z MapApplication ' "2 app ' [1src [ main & AndroidManifest.xml
B e lodoid - il &1 AndroidManifest.xml x m
& | Ceapep g
i 1 manifests <uses-permission androidinane="android.pernission. INTERNET" /> §
- S AndroidManifest.<ml <uses-pernission androidinane="android.pernission. ACCESS_NETWORK_STATE™ /> g
| Mt et N endT <uses-permission android:name="android.pernission.WRITE_FXTERNAL_STORAGE” /> —| %
u =] ]% <uses-pernission android:nane="con.google.android. providers. gsf.pernission. REA ﬁ
ﬁ Fares <uses-permission android:nane="android.pernission. ACCESS_CGOARSE_LOGATION™ />
£ i ) <uses-permission android:name="android.permission. ACCESS_FINE_LOCATION” /> 2
o  Gradle Scripts o
I ™ (Project: ManAnplication) - =
< > build.gradle (Project: MapApplication) ‘{uses fea.ture o ; =
3 build.gradle (Module: app) andrnfd:glEs‘:’ers_lgn— l]fl]l]l]?l]l]l]ll
android:required="true” />
2 & settings.gradle (Project Settings)
5‘5‘ [4it local.properties (SDK Location) <application
- android:al lowBackup="true”
- android: icon="@drawsble/ic_launcher”
android: label="Hapfipplication”
o android:theme="8styleféppThene” >
5 <meta-data
E . apdi-oid e LD -
o L - i
F] <meta-data
& android:name="con.goog le.android.gns. version”
android:velue="7895000" />
B | android - L
E ‘ Mo Connacted Devices n | No Debuggable Applications n
ol
=® ifi logcat | ADB logs +°| il Memory +*| jl CPU -+|el: | Verbose n (=X ) ‘ Show only selected application n
- 4:Run S TODO | 4 B Android Terminal |=| 0: Messages M1 Event Log [E] Gradle Console
[0 Gradle build finished in 2m 36s 869ms (55 minutes ago) 29:67 |CRLF: | UTF-8 B F

17
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BARAEE R 1 Android studio D= I = L — &% TO GPS {HF#E(E 1k

1. MapAplication % %47 L £,
2.  [Android Studio ® A = = — >Tools > Android Device Monitor] % &R L £,

(-] Android Device Monitor - O
File Edit Run Window Help

Quick Access I ﬁ| ’
B Devices 52 = 8 || % Threa... @ Heap @ Alloca... = Netw...
| | |® e @jmy ~
2 ~ Telephony Status ~
4 [ emulator-5554 online Galafly_ ez | o v| Speed: | Full o
com.android.systemui 1342 8601 Data: |home v Latency: None  w
com.goegle.andreid.inputmethoc 1376 8602 Telenh .
com.google.android.gms. persiste 1392 8603 elephony Actions
android.process. media 1405 8604 Incoming number:
com.android.phone 1423 8605 ®) \ioice
com.android.launcher 1429 8606 SMs
com.google.process.gapps 1467 8607
android.process.acore 1476 8608
com.android.printspocler 1502 8609
com.android.externalstorage 1534 8610
com.google.android.gms.wearab 1629 8611
com.android.settings 1648 8612 Call | Hang Up
com.android.music 1673 8613
com.google.android.gms 1706 8614 Location Controls
com.android.dialer 1744 8615 Manual | GeX | kML
com.android.providers.calendar 1765 8616 . _
com.android.mms 1791 8617 ® Decimal
com.android.calendar 1879 8618 () Sexagesimal
com.android.deskclock 1902 8619 Longitude | 137.096817
com.android.email 1919 8620
com.android.exchange 1939 8621 Latitude |36.725310
com.qoogle.android.gms.unstabl 2005 8622
< > v
0 LogCat 2 = 08
Saved Filters o Search for messages. Accepts Java regexes. Prefix with pid:, app:, tag: or text: to limit scope. verbose v H B
All messages (no filters X X
L... Time PID TID Application Tag Text -
< < >

6sMof sazM [

DZEMID Device] ©a—DOHIZEWER DT NA 2% 27 ) v 7 L TERIVREIZLET,
24D E = —7 5 [Emulator Control] % 7 Zi&IR L £9°,
3) [Location Controls| @ [Manual] # 7 %R L. Longitude (f&FE) &
Latitude (f#E) (TTEOEZ AILT Send RNZ U ZH#TF L ET,
DBRT DT /NA 2T GPS MO EFMAEF-L T LR LT mEATHERPEONET,

%) Bit O &

latitude : 137.096817
longitude : 36.72531

Uk

18
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Instruction of the quick Building

Android Application Development Environment

1. Development Environment
Table 1 shows the development environment on this instruction.

Table 1. Development Environment

0sS Windows7 (32bit or 64bit)

Working Directory C:¥Android_Work

Java Java SE JDK latest version (8u60)
Development Environment Android Studio latest version (141.2178183)
Target Android API Version Android 4.4.2

Google API Google Maps Android API v2

The procedure of the structure is:

1: Install the required software for the Java Development Kit (JDK)

2: Copy the Android_Work folder which include the Android Studio, Android SDK and

sample source code.

3: Copy the xampp folder which include the Xampp environment with PHP scripts and

database tables for sample application.

4: Build the Android emulator— Software Configuration

The software (32bit ver. And 64bit ver.) will be provided by 16GB USB memory stick.

<Note>

Most of all files are copied under “C:¥Android_Work”.

2. Install the Java Development Kit (JDK)
2.1 Open the URLin a browser

http://www.oracle.com/technetwork/java/javase/downloads/index.html

2.2 Click “DOWNLOAD” of the latest version of JDK (8u60 on this instruction manual)
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java/ P~ BG X
FR(V) BRCAD(A) Y—IUT) ALTH)

Downloads
Java SE [ overview ( | [ communty jes [ Training R AR A e ‘
Java EE *
Java ME Java SE Downloads & Java € and Glassfish
Java SE Support & Java ME
Java SE Advanced & Suite & Java Card
Java Embedded $ Nets
Java DB # Java Mission Control
YeoTls: DOWNLOAD DOWNLOA S Resouices
Java Card ——— e -
e Java Platform (JDK) 8u20 DK 8u20 & NetBeans 8.0 v ihe
Java TV & Technical Artick
New 1o Java Java Platform, Standard Edition s s
Community Java SE 8u20 o
X This release of the Java Platform continues to improve upon the significant advances made in the =
Jaia Magazine JDK 8 release with new features, security and performance optimizations. Included are the new MSI & Java Magazin
Enterprise JRE Installr, the new Advanced Management Console, and JHC 5.4,
Learn more » # Javanet
# Developer Training
= Instaliation Instructions JDK & Tugorighe
DOWNLOAD 2
* Oracle License
ey
+ Java SE Products Server JRE “,
* Third Party Licenses DOWNLOAD Getit now
+ Certified System Configurations for FREE!
* Readme Fies Subscribe Joday
+ JDK Readlte JRE S

DOWNLOAD &

* JRE Readlle ‘ Wobcast -

2.3 Check “Accept License Agreement” and download “Windows x86” by clicking the file
name on the right (In case of 64 bit OS, download the  “Windows x64” )

L SRIE Al =) heep://wwiw.oracle.com/tachn © ~ B & X | [=] Java SE Development Ki... x
D7 AUF) BEE) BA() SRCADR) YT ALTH) |

5 -

savaiagazing JDK MDS Checksum 3
Looking for JDK 8 on ARM? s

JDK 8 for ARM downloads have moved to the JOK 8 for ARM download page. & Develop

# Tutorials

Java SE Development Kit 8u20 & Javacoi
You must accept the Oracle Binary Code License for Java SE to this o

U software.

@) pt License Agreement © pecline License Agreement

Product / File Description | File Size | Download
Linux x86 135.24 MB 3 jdk-8u20-linux-i586.rpm
Linux x86 15487 MB  # jdk-Bu20-linux-i586 tar.gz
Linux x64 135.6 MB # jak-8u20-finux-x84.rpm
Linux x64 153.42MB  # jok-8u20-linux-x64.tar.gz
Mac 0S X x84 209.11MB  # jak-8u20-macosx-x64.dmg
Solaris SPARC 64-bit (SVR4 package) 137.02MB  # jdk-3u20-solaris-sparcva.tar.Z
Solaris SPARC 64-bit 97.09MB ¥ jdk-8u20-solaris-sparcv9.tar.gz
Solaris x64 (SVR4 package) 137.16 MB $ jdk-8u20-solaris-x64.tar.Z

Java SE Development Kit 83u20 Demos and Samples Downloads are released under the
Oracle BSD License.

< m ] >

2.4 For the installation, run the executable zip file. Use the default settings on the

installation process.
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Name Date modified Type Size

|y jdk-8u20-windows-x64.exe 9/11/2014 3:56 PM Application 177,232 KB

15 Java SE Development Kit 8 Update 20 (64-bit) - Setup

ORACLE

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 20

This wizard will guide you through the installation process for the Java SE Development
Kit 8 Update 20.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

ate moanied: 7
Size: 173 MB

ﬁ]vjava SE Development Kit 8 Update 20 (64-bit) - Complete

ORACLE"

Java SE Development Kit 8 Update 20 (64-bit) Successfully Installed

Click Next Steps to access tutorials, API documentation, developer guides, release notes
and more to help you get started with the JDK.

Next Steps

G
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3.

Install the Android Studio
3.1 Copy Android_Work folder in the USB memory stick to your “c:¥”.

3.2  Open “Control Panel” — “Sytem” — “Sytem Properties” — “Environment

Variables”.

System Properties

Computer Name | Hardware Advanced | System Protection | Remote

You must be logged on as an Administrator to make most of these changes

Performance

Visual effects, processor scheduling, memory usage, and virtual memory

Settings...
User Profiles
Desktop settings related to your sign+in

Settings...
Startup and Recovery
System startup, system failure, and debugging information

Settings...

Environment Variables...

OK Cancel

3.3 Add a new variable “ANDROID_SDK_HOME" to System variables.

Environment Variables

User variables for Gonso

Variable Value |
TEMP SRUISERPROFIL — i
™P YLUISERPROFIL New System Variable

Variable name: AMDROID_SDK_HOME

Mew...
Variable value: c:¥Android_Work
System variables
Variable Value Ok Cancel
ComSpec C:¥Windows¥sy
FP_NO_HOST C... NO
MUMBER_OF P... 2
05 Windows_MNT b
it | [ odes
oK Cancel
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4. |nstall the XAMPP environment

4.1 Copy xampp folder in the USB memory stick to your “c:¥”.

4.2  Run “xampp-control.exe” in “c:¥xampp” folder, and then start Apache server and

MySQL server from the Control Panel.

XAMPP Control Panel v3.2.1 [ Compiled: May 7th 2013 ] = =
XAMPP Control Panel v3.2.1 #* contg
Modules
Netstat
Service Module PID{s) Port(s) =Reoons | o
Apache g:gi 80 Stop Admin Config Logs & Shell
MySQL 1064 3306 Stop Config Logs | Explorer
FileZilla —— Admir Config Logs = Senices
Mercury Start Admir Config Logs & Help
Tomcat Start Admir Config Logs |l Quit
1350 Pr [main] The FileZilla module is disabled ~
12350 PM [main] The Mercury module is disabled
0 PR [main] The Tomcat module is disabled
50 P [main] Starting Check-Timer
50 PM [main] Control Panel Ready
57 P [Apache]  Attempting to start Apache app...
11:3357 P [Apache]l  Status chanze detected: running
11:34:04 Ph [mysqll Attempting to start MySGL app...
11:34:05 Ph [mysql] Status change detected: running
v

5. Install the Intel HAX

Execute "IntelHaxm.exe” from the path below and install.

C:¥Android_Work¥sdk¥extras¥intel¥Hardware_Acceleted_Execution_manager¥

Intel® Software Tools
for Android*

¥ Intel® Hardware Accelerated Execution Manager Setup — ©

Intel Hardware Accelerated Execution
Manager 1.1.4 (HAXM)

This Installer guides you through the steps necessary to install
Intel® HAXM on your system,

Intel HAXM is a hardware-assisted virtualization engine
(hypervisor) that uses Intel Virtualization Technology to speed
up Android development. Please note that Intel HAXM can only
be used with the Android 50K, and Android x86 emulator images
pravided by Intel,

Important: Intel HAXM requires an Intel processor with certain
hardware features, induding Intel Virtualization Technology
(VT). This installer will check whether your computer can run
Intel HAXM,

Please connect your computer to internet during installation.

Please refer to Intel® HAXM documentation for more
information.

Intel® HAXM Documentation Back Cancel
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## Intel® Hardware Accelerated Execution Manager Setup — =

Intel® Hardware Accelerated Execution Manager
Memary limit for Intel HAXM

Intel HAXM reserves a portion of RAM when running. Please set the maximum amount of
RAM available for Intel HAXM to use for all k86 emulator instances.

Mote: Setting a large memory reservation may cause other programs to run slowly when
using the x&86 Android emulator with HAXM.

() Default Value 1024 MB

(®) set manually |1[2|24 ME v

The value must be between 512 MB and 1.5 GE

Intel® HAXM Documentation Back Cancel

6. Configure the Android Studio
6.1 Execute “c:¥Android_Work¥android-studio¥bin¥studio64.exe”.
(If you have the 32bit OS, execute studio.exe. )

@G-l . = android-studic » bin » - |‘y|| bintEE p|

== - BE< SZ=AT FUNT A IS —

Sr BECAD e ] EEE
B FoO0—F ! lidb 2015/09/03 9:
R e ] appletviewer.policy 2015/08/19 0:
T SEEE USSR %] breakgen.dll 2015/08/19 0:
|| breakgené4.dll 2015/08/19 0:
[=] Focuskillerdll 2015/08/19 0:
- STTSY @] Focuskillers4.dil 2015/08/19 0:
=l Subversion [E] Fsnotifier.exe 2015/08/19 0:
FE FFax>t [ ] idea.properties 2015/08/19 0:
= EoFr %] Ideawin3z.dll 2015/08/19 0:
B e o || Ideawin64.dll 2015/08/19 0:
d =r—ws %] jumplistbridge.dll 2015/08/19 0:
|| jumplistbridge64.dil 2015/08/19 0:
PP [ log.xml 2015/08/19 0:
L 7] restarterexe 2015/08/19 0: by
& 0s () [ runnerw.exe 2015/08/19 0: >
| == studio.exe 2015/08/19 10:37 FFUL—=.3>
T RO —4 L_| studic.exe.vmoptions 2015/08/19 0:36 VMOPTIONS ...
- 2015/08/19 0:36 FAa
studiob4.exe 2015/08/19 10:42 FIFUHS—==>
studios4.exe noptions 2015/08/19 0:36 VMOPTIONS ...
[=71 vistalauncher.exe 2015/08/19 0:36 FFUr—=az
< i ] »
% studio.exe E=FTHET: 2015/08/12 10:37 {EEREIEF: 2015/09/03 9:29
FFuLr—a> HX: 873 KB
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6.2 Select “I do not have a previous version of Studio or | do not want to import my

settings” and click “OK” button.

il - —
#® Complete Installation u

You can import wour settings from a previous version of Studio.
0 Tweant to import my settings from a custom location
Specify config falder ar installation home of the previous version of Studio:
I[-]

@ {dn not have a previous version of Studio or Tdo not want to import my settines

6.3 Click “Next” button
V@ Android Studio Setup Wizard ] - o E@Q‘

Welcome

Android Studio

Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studic

or create a new Android application project.

6.4 Select “Standard” and Click “Next” button
B Ao Sl Sotu e —————————— | =

/"( Install Type

e -

© standard

Android Studio will be installed with the most common settings and options|

(O Custom

You can customize installation settings and components installed.
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6.5 Click “Finish” button

. Android Studio Setup Wizard - O “-I

A Verify Settings

If you want to review or change any of your installation settings, click Previous.

Current Settings:

Setup type:
Standard

Destination Folder:
C:\Android_Work\SDK

IEIEViowII Next Ilw]

6.6 Click “Finish” button again

L

Android Studio Setup Wizard -0

A Downloading Components

Android SOK is up to date.
Creating Android virtual device
#ndroid virtual device Mexus_6_API_23_x86 was successfully crested

[ previous | [ Wext | [ concel ]m
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7. Import the sample program
7.1 Click “Open an existing Android Studio project” and open the sample

program in “c:¥Android_Work¥Projects¥”.
# Android Studio EE
a Welcome to Android Studio

-
Recent Projects Quick Start
@ Start a new Android Studio project
FD ‘Open an existing Android Studio project
Ne Project Open Yet Ele Import an Android code sample

VES Check out project from Version Control

E?’ Import project (Eclipse ADT, Gradle, etc.)

# Configure 3

rE. Docs and How-Tos P

Android Studic 1.3.2 Build 141 2178183, Check for updates now.

7.2 Select “MapApplication” on the list.

# Open File or Project A 4 u
ACenG &BX O Hide path
‘ Ci¥Users |
FC:¥
[1 3b1bdb370d3ad804e621c180
[ 4939e077b831427f2703
[ Android_Work
# MapApplication
3 Apps
[ bat
[ Bit_scfiE
[ dell
[ Drivers
[ Intel
[ Logs
[ neops
Drag and drop a file into the space abowve to quickly locate it in the tree.
o JEEETS
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8. Check the Android emulators.

8.1 Click on . icon.

8.2 Check to existing two android emulators, “Galaxy Nexus API 19” and “Nexus 5
API 23 x86".

Y

|
Android Virtual Device Manager o B

H Your Virtual Devices

Android Studic

Type | Name | Resolutien | APl | Target | CPU/ABI | SizeonDisk | Actions
[C] GalmyNexws.. 320x480:%hdpi 19 Google APls(x.. 86 268 A
[C] Mews5APIZ3. 1080x 192kxc. 23 Google APls 186 750 MB b 2~

=+ Create Virtual Device... @

8.3 Click > button on the “Galaxy Nexus APl 19” and check to run the emulator.

& © 5554:Galaxy_Nexus_aPI_19 - - [

AR
MmO D

10503 o Js Js [2.0a o Jo-
o/ e e [t Jv oo
s 1o [ Jo [n o [ic|1 [
2z e Lo lo v . Joo
IR P R P P

10
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8.4 After running the emulator, start the sample program on the Android Studio.
(Menu bar = Run = Run ‘app’)

File Edit View Navigate Code Analyze Refactor Buid [l
DHO «» %00 QR e8P

3 MapAppli('atiﬂ'l) napp> | 5rc> (| main> Bjava ) E § Debug ‘app ShIte
= ¥ Run 'app' with Coverage
1§ Android v| D = | 81

b Run... Alt+Shift+F10 m
a =
" L:‘ e ik Debug... Alt+Shift+F9 H
Gradle Scri
e ripts [E» Edit Configurations... -
- (& build.gradle (Project: MapApplication) B stor e El
v (& build.gradle (Module: app) 9(
= Reload Changed Classes
b (&) settings.gradle (Project Sattings) - @
5 ¥ Step Over F8 &
@ [t local.properties (SDK Location) - A o
i~ 3 Force Step Over Alt+Shift+F8 z
v M Step Into = g
) M Force Step Into Alt+5Shift+F7
2 W Smart Step Into Shift+F7
g A Step Out Shift+Fa
My Run to Cursor Alt+F9
My Force Run to Cursor Ctrl+Alt+F9
2 3 Drop Frame
=
§ Il Pause Program
| % 2 Resume Program Fg
l
W B8 Evaluate Expression... Alt+F8
Quick Evaluate Expression Ctrl+Alt+F8
4 | androia k= Show Execution Point Alt+F10 B L
g X
& No Connected Devices n I Mo Debuggable Af 7ol Line Breakpoint Ctrl+F8
=D Toggle Method Breakpoint
* ifii logcat | ADB logs —+*| i Memory +°| il CPU " E vogie Blethod Breakpoin | application n
e Toggle Temporary Line Breakpoint Ctrl+Alt+Shift+F8

P 4 Run & TODO
Run selected configuration

Terminal Bl Toggle Breakpoint Enabled =] Gradie Console
§: View Breakpoints... Ctri+Shift+Fg (2 Context> & §

11
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9. Execution Environment of the system.
9.1 This system is executed by the application on the Android devices and the
Web(PHP) + Database(MySQL) server constructed on the web site.

The connection between the application and web server uses HTTP connection.

9.2 Using e-mail address for the user identifications. E-mail address will be registered
on the set-up the applications and can be changed later on. And the user password

must be controlled together.

9.3 This system runs on the Android devices requires internet access (WiFi, LTE and

etc. ).

Application

Table 6.3) Server SPECs

OS CentOS ver6.5 (64bit)
IP addresses Global IP: 114.179.41.91
Bit Datacenter N Port No: 80, 22
Local IP: 192.168.200.150
System XAMPP for Linux ver 1.8.3
Database MySQL ver5.6.20
phpMyAdmin ver 4.2.7.1
Web Server Apache ver 2.4.10
Server side script PHP ver 5.5.15 & PEAR

12
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10. Create and use the client ID for Google Maps Android API v2
If you can open the Google map correctly on your AVD, you don’t need to do as
follows.
10.1 Access the Google Developer console web site and login.
(https‘//console.developers.google.com/)

+ User: mext2014001@gmail.com

® 0 e Sign in — Google Accounts o)

One account. All of Google.

Sign in with your Google Account

‘ mext2014001@gmail.com| |

Need help?

Create account

10.2 Input password as below.

+ Pass: Bit2014@mextproject

Sign in - Google Accounts

One account. All of Google.

Sign in with your Google Account

&

MEXT Project
mext2014001@gmail.com

v/ Stay signed in Forgot password?

-190-
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10.3 Click “APIs & auth” = ”"Credentials”.

m}) © https://console.developers.google... O ~ & & H O Home - My Project x | | {af 5.7 593
) Google Developers Console My Project ~ Signup for a free trial. ) 9o O ;
Home Project: My Project APls Google Cloud Platform status 7 A
Permissions
1D big-bliss-713 Requests [requests/sec) @  All services normal v
APIs & auth
S5 (#755654803736) ™
APls
1 News
Explore other services
Push 08
o 0 Push Google Cloud origin content
Monitoring APL  Enable Google APIs for your out to your users with CON
Source Code app 04 Interconnect
Deploy & Manage 0 Google Cloud Platform - 18 hr
N blog ago
Bl Deploy a prebuilt solution .
Compute Sep 10, 3:45 PMSep 10, 4:45 PM
Networking i Compute Engine Preemptible VMs
Storage “®: Deploy a Hello World app [/ Requests: 0 are now Generally Available
: Google Cloud Platform - 1 day
EigDatz {3F Take a VM quickstart blog ago
= Create a Cloud Storage Cloud Spin Part 1: 180-degree
bucket animations on Google Cloud

Platform

Google Cloud Platform - 2 days
blog ago v

10.4 Click “Add Credentials” and select “API key”.
(5 e = -

m})‘o https://console.developers.google... 0 ~ @& & H D Credentials - My Project % | | AN
Q Google Developers Console My Project + Signup for a free trial. ) 9o O ;

Home Credentials QAuth consent screen ~

Permissions

APIs & auth Add credentials ~

APls APl key
Credentials Identifies your project using a simple AP key to check quota and access.
Push For APIs like Google Translate

'us

OAuth 2.0 client ID

Monitoring Requests user consent so your app can access the user's data
Source Code For APls like Google Calendar.
Deploy & Manage Service account 313fhgiViZaQ-L3WIMMYI
Compute Enables server-to-server, app-level authentication using robot accounts.
For use with Google Cloud APls UUGVppxKySR-TALSZmICSe
Networking
Storage 'ty Jun 18, 2015 Browser AlzaSyB54bYUszu8QxdQIKHoeUVD1SW20ZNj_7U
BigD Browser
ig Data key 2
Android May 20, 2015 Android AlzaSyCCWck8FUrgwGwfJ0-pfOcénaY¥sQKP1ZHk
key 41
Android May 13, 2015 Android AlzaSyBbHQC2igVOEnI2icc90KT_jbuDYYXSFWg
key 40
Android  May 13,2015 Android AlzaSyBYEydYaERICFvC3TUiNgeySqLyL9mahk "
<« key 39

14
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10.5 And click “ Android key” button.

e\\l‘o https://console.developers.google... O ~ & & H { Credentials - My Project | |

(=8 Be =)

APls & auth

Monitoring
Source Code
Deploy & Manage
Compute
Networking
Storage

Big Data

Create a new key

You need an APl key to call certain Google APls. The API key identifies your
project. Alsa, it is used to enforce quotas and handle billing, so keep it safe.

Server key

Browser kefl | Android key

0S key

p e o

10.6 Start command prompt on your windows PC and type the below command

for creating the fingerprint of your PC’s certification.

cd "c:¥Program Files¥Java¥jdk1.8.0_60¥bin"
keytool -list -v -keystore ¢:¥Android_Work¥.android¥debug.keystore

**When the entering password screen is displayed, you just press enter

key.

-192-
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10.7 Copy the fingerprint that is next to “SHA1:” to the clipboard.

| C:¥Windows¥system32¥cmid.gxe L=

HERRS 50 Mo 01 9 JST 20144278 1

10.8 Paste the fingerprint on the field that on the Google web site and go on to

type “;com.example.MapApplication”. Then click “Create” button to make
an API KEY.

Package name com.example.MapApplication
SHA-1 certificate fingerprint Copied fingerprint in chapter 10.7
(E=5(E=R ==
a |O https://conscle.developers.google... 0 ~ @ G”OCreateAndruldAPI key ... ‘ | 9.5 io)
'-) Google Developers Console My Project Sign up for a free trial 1] QO - =
Home -
Permissions
APIs & auth Create Android AP key
APls Name

Android key 49

Push

Restrict usage to your Android apps
Monitoring

Source Code
Cloud Launcher

Deployments keytool -list -v -keystore mystore.keystore

Compute
IPackage name SHA-1 certificate fingerprint
Networking
com.example.MapApplicatiion 48:AA:45:D0:7B:72:15:51:00:69:82:85:22:86:32:80:E2:75:FB:C1
Storage
Big Data

Cancel

16
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10.9 Make a copy of API KEY.

e@|° hittps://console.developers.google... © ~ @& ¢ ” {Q Credentials - My Project %

APl key
Here is your APl key
I AlzaSyA2tfbql_QSaVngTfmb7EjfnyykvyjQvLe I

10.100pen “MapApplication/AndroidManifest.xml” on the Android Studio.
And replace the variable of “android:value” to your API KEY.

MapAplecatlon - [C:¥Android

File Edit View MNavigate Code Analyze Refactor

Build Run Tools VCS Window Help

ODHG ¢4 X000 QR & > 1(Fap- > ¥ ¥ L | Fm R E& ? Q
Ca MapAppIication..:':- I:'.'app..:':- (| srt._:':- B mal’n.._::- o ArdmidManifest.xml.._:'-

H e Lodoid '.u o . e o AndroidMamfest.xm.\ %

2 | Caapp

& [ manifests <uses-permission android:zneme="android.pernission. INTERKET" />

<uses-permission

android.permission. ACCESS_NETYORKE_STATE™ />
android.pernission. WRITE_EXTERNAL _STORAGE™ />

‘& AndroidManifest.xml

<uses-permission

spmaloud U2ABRK 3

w [ | ]ﬁ <uses-permnission con. goog le.android. providers. gsf.pernission. REA

-E Pares <{uses-permission android:name="android.permission. ACCESS_COARSE_LOCATION" />

2 B <uses-pernission android:name="android.permission. ACCESS_FINE_LOCATION" /> O]

[l & Gradle Scripts [}

.. =

o < build.gradle (Project: MapApplication) <uses-feature =
® build.gradle (Modula: app) android:glEsVersion="0x00020000

. android:required="true” />
 settings.gradle (Project Settings)

[4it local.properties (SDK Location) <application
android:al lowBackup="true”

i Captures =J

I’
@

android: icon="8drawablefic_launcher”
android: label="Hapéppl ication”
android: theme="8stylefippThene” >

<meta-data

“meta-data
android:name="con.goog le.android.gns. version”
android:value="7335000" />

& Build Variants

B | android o L
E ‘ Mo Connected Devices n | MNo Debuggable Applications
ol
* ifis logcat | ADB logs +°| il Memory +°| [ CPU -+|el: _ ‘ Show only selected application n
- 4:Run S TODO | 4 B Android Terminal |=| 0: Messages M1 Event Log [E] Gradle Console
[0 Gradle build finished in 2m 36s 869ms (55 minutes ago) 29:67 |CRLF: | UTF-8 |Context: <no co = w8

17
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Appendix1. How to set the GPS location data on the Android emulator.
1. Start MapAplication (Sample program) on Android Studio
2. Click “Menu” - “Tools” = Android Device Monitor

] Android Device Monitor
File Edit Run Window Help

Quick Access I =1 |

B Devices 52 = 8 || % Threa... @ Heap @ Alloca... = Netw...

2 Telephony Status
4 B emulator-5554 agy_ Voice: |home v Speed: |Ful v

com.android.systemui 1342 8601 Data: |home v Latency: None  w

com.goegle.andreid.inputmethoc 1376 8602

com.google.android.gms. persiste 1392 8603 TR MRS

android.process. media 1405 8604 Incoming number:

com.android.phone 1423 8605 ®) oice

com.android.launcher 1429 8606 SMs

com.google.process.gapps 1467 8607

android.process.acore 1476 8608

com.android.printspocler 1502 8609

com.android.externalstorage 1534 8610

com.google.android.gms.wearab 1629 8611

com.android.settings 1648 8612 Call | Hang Up

com.android.music 1673 8613

com.google.android.gms 1706 8614 3)Locat|0m Controls

com.android.dialer 1744 8615 Manual | GeX | kML

com.android.providers.calendar 1765 8616 .

com.android.mms 1791 8617 ® Decimal

com.android.calendar 1879 8618 () Sexagesimal

com.android.deskclock 1902 8619 Longitude | 137.096817

com.android.email 1919 8620

com.android.exchange 1939 8621 Latitude |36.725310

com.qoogle.android.gms.unstabl 2005 8622

< > v
0 LogCat 2 = 08
Saved Filters o Search for messages. Accepts Java regexes. Prefix with pid:, app:, tag: or text: to limit scope. verbose v H B
All messages (no filters X X o
L... Time PID TID Application Tag Text -

< < >

6sMof sazM [

1) Click and select your running device from the Device view.

2) Click “Emulator Control” tab.

3) Go to “Location Controls” and click “Manual” tab, then set the numbers to
Longitude and Latitude, and click “Send” button.

4) Send the GPS location to your running device.
i.e. The GPS location of Toyama college of Business and Information Technology

longitude : 137.096817
latitude : 36.72531

END

18
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Y—N\IREBEFIRE

1

e

APIEECHLE T LIV — REKIZIFR 1 OED ThD,

# 1 PAFERER
0S Windows7 (32bit or 64bit)
VR AN AZE Ny XAMPP 1.8.3 (PHP 5.5.15)
A A F—VAE C:'¥xampp¥

XAMPP D& 7> a— R, A A h—)b
2.1 TF#HOURL%Z7 7 vHChX, MEEST 59 —08 D XAMPP # ¥ w1

— K2,

https://www.apachefriends.org/jp/index.html

XAMPP

Apache + MySQL + PHP + Perl

XAMPP &2
XAMPP [IHZEAEDHS PHP FHRIREETY

XAMPP 13, 2| CE{ET MySQL. PHP. & 4T Perl #ZA. MEICAVRF—ILTES

75t XAMPP 50 H ?

« BYARDHS PHP dev )i —VTH
it

» Windows, Mac OS X & Linux & /i —t

Apache T4 AU 2 —3TH  XAMPP A —J2 U—2 1w =213 A2 —IbEF]

A RICHETEALIBTEINTOET,

o ARV EREDEE
s TEICER

2R Windows (&1} Q Linux[&17 XAMPP

XAMEE v1.8.3 (PHP 5.5.15)
v1.8.3 (PHP 5.5.15)

& OSsX[E XAMPP
v1.8.3 (PHP 5.5.15)

m
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22 U rm—RLET7ANVEFTL, A A =T DIRIE>TA A b
— V%479, Windows D6, EIT7 7 A NEhE27 ) v 7 L HEHEEHE L LT
FAT) THEITTH L,

REIXTROBEY LTI,

+ Select Components : £ CF = v 7 H (T 7+ 1)

- Installation folder : [C:¥xampp) (77 4/V 1)

- Bitnami for XAMPP : [Learn more about~| O = v 7 %49

Select Components

Select the components you want to install; clear the components you do not want to install.
Click Next when you are ready to continue.

Click on a component to get a detailed
description

FileZilla FTP Server
Mercury Mail Server
[¥] Tomeat

=] Program Languages
PHP
[V] Perl

- [@] Program Languages
phpMy Admin
Webalizer
[¥] Fake Sendmail

XAMPP Installer

[ < Back ][ Next > J[ Cancel ]

Installation folder

Please, choose a folder to install XAMPP
Select a folder G¥xampp|

XAMPP Thstaller -

[ <Back | [ Next> |[ oCancel
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Bitnami for XAMPP

Bitnami for XAMPP provides free installers that can
install Drupal, Joomla!, WordPress and many other
popular open source apps on top of your existing
KAMPP installation.

http://bitnamicom/xampp

“—r’
Q tx Learn more about Bitnami for XAMPP []
—

KAMPP Installer

<Back | [ MNext> | [ Gancal

2.3 AVAN=NANETTHEK23NERINDHDT, [Doyouwant to start
the Control Panel now?] (ZF =v 7 & AN F Finish 27 U v 735,

GCompleting the XAMPP Setup Wizard

Setup has finished installing XAMPP on your computer.
Do you want to start the Control Panel now?

{ Back | Cancel

X 2.3
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2.4 XAMPP Control Panel 23 L#E) 35 T, Module 7% [Apache] & TMySQL]J
LEIPNTWDED Start K& &7 V) v 7T 5, ERICGEETS &, 2.4
® X 912 Module £ DO S 03 k0272 5

XAMPP Control Panel v3.2.1 |
Modul
Serviu(:::S Module PID(s) Ports) Actions
: Apache ggﬁ 80, 443 [ Stop ] [ AdminJ [ Config ][ Logs ]

MysQL 3296 3306 [ Stop | [ Admin | [ Config | [ Logs | [ [Explorer |
U 2
FileZilla N [ stat ]| Admin | [ Config ][ Logs | [ = Senices |

Mercury _dmin | [ Config | [ Logs | [ @telp ||
Tomeat _ Admin_| [_Config | [ Logs ]

{11:41:58 [main] Checking for prerequisites

I [11:42:02 [main] All prerequisites found

i 11:42:02 [main] Initializing Modules
{11:42:02 [main] Starting Check-Timer
{11:42:02 [main] Control Panel Ready [l
{11:50:58 [Apache] Attempting to start Apache app... i
[11:50:59 [Apache] Status change detected: running 4
{11:51:01 [mysql] Attempting to start MySQL app... 3

{11:51:10 [mysql] Status change detected: running

1

2.4 Apache & MySQL 723 [E5 (2 fC#h L 724K HE

2.5 [http://localhost/| (27 7 AL, XAMPP OR—UNERKRINDHZ & 2 HE
BT 5,
2.6 MEIZLNUCHEALED X2V T 4] O

R
i
N

N
4l
N1
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3 Apache (Web ¥—/3) ORE
3.1 [C:¥xampp¥apache¥conf¥httpd.conf] %7 F A b7 ¢ ¥ THIL,
3.2 THXANDONEEZE3.2DEIERNIKEYT 5 2{TEBEEZ OB ITEIET 5,
# 3.2 httpd.conf DIEIENE
{EIERT - DocumentRoot "C:/xampp/htdocs"

<Directory "C:/xampp/htdocs">

EIE% - DocumentRoot "C:/xampp/htdocs/php"

<Directory "C:/xampp/htdocs/php">

3.3  [Cixampp/htdocs) (27 /v % [php) Z1ERK L. — 3227 U7 N &Z{ERL
L7=7 VA RNICEET 5,

4 MySQL (F—#~X—2R) ORFE
4.1 avr R a7 NeERBT 5,
42 AV TA LT MVICT = IN—ADOREZITIAZ VT M T 74 L
(SETUP_DB.sql) #®&Eh¥ 5,
4.3 WoOa~vr REFETT5H, FATRHIRAY — REERIN LD T, 2.6 THE
LT AY—=RE AT 5,
C¥xampp¥mysql¥bin¥mysql.exe -u root -p -f < SETUP_ DB.sql
BENRETDGAENH LD, BHEL TR,

Uk
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Instruction of the Test server environment on Windows OS

1 PC environment

Fig.1 Test server PC environment

(O}

Windows?7 (32bit or 64bit)

Software

XAMPP 1.8.3 (PHP 5.5.15)

Target directory

C:¥xampp¥

2 Download XAMPP software and installation
2.1 Download XAMPP software from the URL as follows:

https://www.apachefriends.org/index.html

| © O O [Z]xaMPP Installers and Dov x |

Fig. 2.1

&« C f [ hitps://www.apachefriends.org/index.html W A
| # 77y [l Google [ Y—nBEE [ ucMEIE [ Nework F)7LZ  § BREE<A

Add-ons Hosting Community About _ Search

Apache Friends Download

]|

XAMPP Apache + MySQL + PHP + Per

What is XAMPP?

Why use XAMPP?

XAMPP is the most popular PHP development environment * The most popular PHP dev package

XAMPP is a completely free, easy to install Apache distribution containing MySQL, PHP,
and Perl. The XAMPP open source package has been set up to be incredibly easy to

install and to use.

» For Windows, Mac OS X & Linux
+ Easy installation and configuration
« Completely free of charge

Download 28 XAMPP for Windows A XAMPP for Linux @& XAMPP for OS X
Click here for other versions v1.8.3 (PHP 5.5.15) v1.8.3 (PHP 5.5.15) v1.8.3 (PHP 5.5.15)

New XAMPP with
PHP 5.5.15 and
5.4.31 versions

Hi Apache Friends!
We are happy to announce a new release of XAMPP for all platforms. This release
updates the main components to the latest stable versions. You can download new

versions at http:...
Read more »
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2.2 Execute the downloaded file and start installation.

Fig. 2.2.1

@ . ‘, « vmware-host » Shared Folders » Work » Xampp v Search Xampp a Jo) ‘
Organize v Open New folder =~ [ @ i
3¢ Favorites Name Date modified Type U

‘ *% xampp-win32-1.8.3-5-VCl1-installer.exe 10/9/2014 4:50 PM  Application
w9 Libraries .

& Homegroup

1% Computer
&, Local Disk (C)
# Shared Folders (\\vmware-host) (Z:)

“! Network
18 GONSO-WIN7E

1% ymware-host

< T ] >

. ' &  xampp-win32-1.8.3-5-VCl11-installer.exe Date modified: 10/9/2014 4:50 PM Date created: 10/9/2014 4:50 PM

Application Size: 139 MB

Fig. 2.2.2
Question X

It seems you have an antivirus running. In some cases, this may slow down or
interfere the installation of the software. Please visit the following link to learn
more about this.

http://apachefriends.org/en/fag-xampp-windows.html#antivirus

Continue with installation?

LYl N |

Fig 2.2.3
Warning

) Important! Because an activated User Account Control (UAC) on your sytem

$ some functions of XAMPP are possibly restricted. With UAC please avoid to
install XAMPP to C:\Program Files (x86) (missing write permisssions). Or
deactivate UAC with msconfig after this setup.

OK &
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Fig. 2.2.4

Setup

() bitnami

Setup - XAMPP

m Welcome to the XAMPP Setup Wizard.

<Back | [ Next>() [ Cancel ]:J

. Select Components : Apache, MySQL and phpMyAdmin

Fig. 2.2.5

-
Setup

Select Components

Select the components you want to install; dear the components you do not want to install. Click

Next when you are ready to continue.

=] Server

Apache
MySQL
£ FileZilla FTP Server
- [[] Mercury Mail Server
“ [] Tomcat
=3 Program Languages
PHP
~ [ Perl
=- Program Languages
: phpMyAdmin
Webalizer
- [7] Fake Sendmail

XAMPP Installer

[ <eex ] [hexts [cm]:J
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Set Installation folder to “C:¥xampp” (Default).
Fig. 2.2.6

Installation folder

Please, choose a folder to install XAMPP
Select a folder  C:\xampp|

XAMPP Installer

Uncheck “Learn more about Bitnami for XAMPP”.
Fig. 2.2.7

Bitnami for XAMPP

Bitnami for XAMPP provides free installers that can install

Drupal, Joomla!, WordPress and many other popular open
source apps on top of your existing XAMPP installation.
[ |
ttp: //bi i.com/xampp
I h tnami.com/x: |
Q t Y Learn more about Bitnami for XAMPP (] !
I ’ 'x I
I
| N
|
I

XAMPP Installer

[ <mack | [ Nextz)[ concel |
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Fig. 2.2.8

Setup is now ready to begin installing XAMPP on your computer.

XAMPP Installer

|<Bad< ENext>© Camd|

Welcome to XAMPP!

Fig. 2.2.9

XAMPP is an easy to install Apache distribution
containing MySQL, PHP and Perl.

Installing

XAMPP Installer

< Back Next >© I Cancel ;

e e e s o e
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2.3 After installation, start the Control Panel.

Fig 2.3
Completing the XAMPP Setup Wizard
Setup has finished installing XAMPP on your computer.
Do you want to start the Control Panel now?
| |
| I
N
I I
I \
| [l
I

() bitnami

|L < Back _JE Fnsh@!_ Cancel 2

2.4 Start Apache and MySQL services.

Fig 2.4.1
o =) L X )
XAMPP Control Panel v3.2.1 * Confg
Modules (@) Netstat
Service Module  PID(s) Ports) Actions @ Nets
D Apache [ Start [ Admin ][ Config H Logs ] B Shell
(] mysa [ stat |[ Admin | [ Config | [ Logs | | [iExplorer
" | Filzila [ stat | [ Admin | [ Config | [ Logs ]
— - ( r Y |
| | Mercury [ stat |[ Admin | [ config |[ Logs | @ Help |||
[ ] Tomeat [ stat || Admin | [ Config |[ Logs | |
L]
5:19:46 P [main] XAMPP Installation Directory: “c¥xampp¥” “ M
5:19:46 PM [main] Checking for prerequisites
51953 P [main] All prerequisites found |
51953 PM - [main] Tnitializing Modules |
51953 PM [main] The FileZilla module is disabled |
5:1953 PM [main] The Mercury module is disabled fl
51953 PM [main] The Tomeat module is disabled = |
51953 PM [main] Starting Check-Timer
5:19:53 PM [main] Control Panel Ready
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Fig 2.4.2

XAMPP Control Panel v3.2.1

ot
& etstat
Service Module PID(s) Port(s) Actions ®
i = )
Apache S 80,443 [ Stop | [ Admin | [ Config | [ Logs | B Shell
MySQL | Admin Config Logs || Explorer
FileZjlla. o Adein | Confin Ll | & Senices
- @ Windows Security Alert [ =]
Merg le Help
J Tomi @ Windows Firewall has blocked some features of this program | 1 Quit |
[5:19:52 PM [main i -~
1953 P [mair | Windows Firewall has blocked some features of Apache HTTP Server on all public and private
19:53 PM [mair| [ networks.
1953 PM [mairy \ Name:
|5:119:53 PM [mainy Publisher: Apache Software Foundation |
51953 Pt [main Path: Cr¥xampp¥apache¥bin¥httpd.exe ‘
(5119553 PM  [mairy 2
|5:20:38 P [Apad | Allow Apache HTTP Server to communicate on these networks: Tl
5:20:38 P [Apag Private networks, such as my home or work network ‘

[] Public networks, such as those in airports and coffee shops (not recommended
because these networks often have litle or no security)

Fig 2.4.3

XAMPP Control Panel v3.2.1  contig
Modules (@ Netstat
Service Module PID(s) Port({s) Actions @

O = S [am
Apache 5372 80,443 [ Stop | [ Admin | [ Config | [ Logs |
MysQL Start Admin l Config ] l Logs I || Explorer
FileZilla Start Admin | [ Config Logs
Mercury Stat | [ Admin | [ Config | [ Logs © Help
Tomeat Stat | [ Admin | [ Config | [ Logs ‘
5:1953 PM [main] All prerequisites found . 1
51953 P [main] Tnitializing Modules
51953 P [main] The FileZilla module is disabled
5:1953 P [main] The Mercury module is disabled
1511953 P [main] The Tomecat module is disabled |
51953 P [main] Starting Check-Timer ]
51953 P [main] Control Panel Ready )
20:38 PM [Apache] Attempting to start Apache app... 5
15:20:38 PM [Apache] Btatus change detected: running |

Fig 2.4.4

XAMPP Control Panel v3.2.1

Shgorgi‘-:!:s Module PID(s) Port(s) Actions
[]  Apache %g% 80,443 [ Stop | [ Admin | [ Config | [ Logs |
MysQL 2972 3306 [ Stop ] [ Admin | [ Config | [ Logs | [ L Explorer |

FileZjlla tace | [ Adesin | [ Cosfia | [ lae ;x[@

@ Windows Security Alert 4

[ Merd | © Help
Tomy @ Windows Firewall has blocked some features of this program 2] Quit |

P [main -

51953 PM [mair | Windows Firewall has blocked some features of mysgld.exe on all public and private networks.

51953 P [mair

5:1953 Pt [main Name: fysaid. ool

51953 P [main Publisher: Unknown

5:20:38 PM [Apag Path: C:¥xampp¥mysql¥bin¥mysqld.exe

5:20:35 PM [Apad

5:21:13 PM [mysq | Allow mysgld.exe to communicate on these networks: 3

5:21:13 PM [mys [7] Private networks, such as my home or work network L

Public networks, such as those in airports and coffee shops (not recommended u
— because these networks often have little or no security)
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Fig 2.4.5

XAMPP Control Panel v3.2.1
Shﬁofgﬁ::s Module  PID(s) Port(s) Actions |
| Apache %:% 80,443 [ stop | [ | [ Config | [ Logs

| mysaL 272 3306 [ Stop | [ Admin | [ Config | [ Logs | [ Explorer |

|| Fiezila [ stat | [ Admin | [ Config |[ Logs |
[ Mereury [ start | [ Admin | [ config |[ Logs |

5:20:38 PM [Apache] Attempting to start Apache app... =3
15:20:38 PM [Apache] Status change detected: running
15:21:13 P [mysqll Attempting to start MySQL app...
15:21:13 PM [mysqll Status change detected: running

j Tomcat [ stat || Logs [ Quit
519558 P [main] The FileZilla module is disabled [
51953 P [main] The Mercury module is disabled
15:1853 P [main] The Tomeat module is disabled
151953 PM - [main] Starting Check-Timer
i5’19 53 PM [main] GControl Panel Ready

\

m

2.5 Access the URL “http://localhost/” using web browser.
Fig 2.5

"’(,— G| (& httpr//localhostixampp/splash.php

XAMPP

Engli\ﬁ-h / Deutsch / Francais / Nederlands / Polski / Italiano / Norwegian / Espafiol / 93¢ / Portuqués (Brasil) / HAZE

|| http://localhost/xampp/lang.phpZen |
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2.6

Open Security menu and solve all security issues.
Fig 2.6.1

XAMPP
[PHP: 5.5.15]
Security

Languages
Deutsch
English
Espa |
Francais
Italiano
Nederlands
Norsk
Polski

©2002-2014
...APACHE
FRIENDS...

- y
http://localhost/security/xamppsecurity.php | rjiazilla FTP und Mercury Mail, you must fix all security problems by

XAMPP SECURITY
(Requests allowed from localhost only)

This page gives you a quick overview about the security status of your XAMPP installation.
(Please continue reading after the table.)

These XAMPP pages are accessible by network for everyone
Every XAMPP demo page you are right now looking at is accessible for everyane over

netwiork. Everyone viha knows your IP address can see these pages.

The MySQL admin user root has NO password
Every local user on Windows box can access your MySQL database with administrator

rights. You should set a password.

PhpMyAdmin is free accessible by network

PhphtyAdmin is accessible by network without password. The configuration 'httpd’ or
‘cookie’ in the "config.inc.php” can help.

A FTP server is not running or is blocked by a firewall! | UNKNOWN

A FTP server is not running or is blocked by a fireveall!

The green marked points are secure; the red marked points are definitively unsecure and
the yellow marked points couldn’t be checked (for example because the sofware to check
isn’t running).

To fix the pi for mysal, phpmy

=> mm@mmw% <= [allowed only for localhost]

Some other important notes:

4

and the xampp directory simply use

ese test are made ONLY for host "localhost” (127.0.0.1).

Fig 2.6.2

[E http:/flocalhost/security/index.php O~ ¢ [Z] XAMPP for Windo...
[=] XAMPP for Windows

[PHP: 5.5.15]
Security

Languages
Deutsch
English
Espa |
Francais
Italiano
Nederlands
Norsk
Polski
Portugu’®
Slovenian
i

©2002-2014
...APACHE
FRIENDS...

XAMPP SECURITY
(Requests allowed from localhost only)

This page gives you a quick overview about the security status of your XAMPP installation.
(Please continue reading after the table.)

Subject Status

These XAMPP pages are no longer accessible by network for everyone EEELT
The MySQL admin user root has no longer no password
PhpMyAdmin password login is bled

A FTP server is not running or is blocked by a firewall!
A FTP server is not running or is blocked by a firewall!

The green marked points are secure; the red marked points are definitively unsecure and the
yellow marked points couldn't be checked (for example because the sofware to check isn’t h
running).

To fix the problems for mysagl, phpmyadmin and the xampp directory simply use
=> http://localhost/security/xamppsecurity.php <=

[allowed only for localhost]

Some other important notes:

All these test are made ONLY for host “localhost” (127.0.0.1).
For FileZilla FTP und Mercury Mail, you must fix all security problems by

yourself! Sorry.
« If your computer is not online or blocked by a firewall, your servers are SECURE against
outside attacks.
« If servers are not running, these servers are also SECURE!
Please consider this: With more XAMPP some will NOT error
free. If you use PHP in "safe mode” for example some functions of this security
d will not working Often even more ity means less fi ionality
at the same time. v
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Set up Apache configurations. (for Web server)
3.1 Open “C:¥xampp¥apache¥conf¥httpd.conf’ using notepad.exe.
3.2 Edit 2 lines of httpd.conf file as follows:

Original : | DocumentRoot "C:/xampp/htdocs"
<Directory "C:/xampp/htdocs">

Change : | DocumentRoot "C:/xampp/htdocs/php"

<Directory "C:/xampp/htdocs/php">

3.3 Create a new “php” folder under the “C:¥xampp¥htdocs¥”’ and put all php

server script files in the folder.

Set up MySQL configurations (for database)

4.1 Open command prompt.

4.2 Move to the folder that there is “SETUP_DB.sql” DDL script in.
4.3 Execute the command as follows:

C'¥xampp¥mysql¥bin¥mysql.exe -u root -p -f < SETUP DB.sql

Fig 4.3

C:\Windows\system32\cmd.exe I o= B S|

xe -u root -p -f < SETUP_DES

END.
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